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THIS CHRISTMAS WAS the first time I did all my shop-
ping online. Giving the finishing touches to this issue
and many trips out of town meant little or no time for
the luxury of doing the mall rounds. Add to it the
sheer convenience of online… I was through with my
purchases in all of 30 minutes. And this included
Googling for the best shopping sites, the best deals on
offer, choosing the gifts, and the credit card bit.

I happened to have been signed into Google—what
they call the “Personalized Home.” It hadn’t occurred
to me, though, in those 30 minutes I’d left digital foot-
prints all across the Web—right from my gift prefer-
ences to my choice of Web sites to even the amount
of time it took me to nail down the gifts. Now e-pay-
ments are more or less secure these days and robust
systems have lent a great deal of credibility to pay-
ments online, but what I’m concerned about is that
somewhere on Google’s servers are locked away little
titbits about me. Very personal things. Well, they do
call it “Personalized.”

The sheer dominance of a handful of search
engines is my concern here. Especially Google. It is
not me who determines whether I get to search all
existing sites; it depends on whether Google has
decided to index the site. In a very real way, Google
controls my Web experience and my online exposure.

Now what if Google were to make it mandatory to
sign in before you could use its search services?
They’re well within their rights to do it!

Every day we send millions of search queries to
Google and give away a daily log of our online pref-
erences. Imagine if Personalized were mandatory.
What might they do with all that data? Will they use
it to enhance our search experience, or will they limit
our search to the sites that pay them?

And then, one day, say Google decides to link
search with its other services such as Gmail, Orkut,
and Google Earth… they’ll end up knowing our
friends, our social interactions, our location. And
there’s more—wait till we get habituated to using
Google Docs and Spreadsheets! You, just a few giga-
bytes of data on Google’s servers, locked for posterity!

The scary thing here is that, like I said, there’s
nothing to stop them from making Personalized
mandatory. We’re so dependant on search, even if

they did, we’d all take it in our stride—and sign in
every time. Google is also offering an online payment
service (in the US right now), so, happily, they’ll also
have your credit card details. And possibly your
mother’s maiden name. And God knows what else.

In a way, it might seem justified: you’re getting so
much information without clicking a single ad, so
you’ve got to give something in return—right? No,
there’s something wrong here.

I do not want Them to know I spent six and a half
minutes choosing a yellow soft toy for my daughter on
the 22nd of December 2006. It might seem insignifi-
cant, but I’m just not comfortable.

editor@thinkdigit.com

Editorial

“In a very real way, Google
controls my Web experience”

Deepak Ajwani Executive Editor

Please Sign In. Or Else.
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TECH-COM 4 GB
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Enter

16
Former Miss
India Tanushree
Dutta and her
travails with
tech

16
Europe wants
Linux, but they
miss MS Office

18
e-Donkey—and
others of its
ilk—are dead,
thanks to the
prize Ass’es

22
An open-source
gaming device?

Digital Passion

Contents Magazine

Tomorrow
42 Battle For Tomorrow
A look at the changing face of warfare.
The future of information exchange
promises more precise and deadly battles

Take a Crack
50 Add “Restart In Safe Mode” To
Your Start Menu
You know you want to say goodbye to all
those “Whoops I forgot to hit F8” days!

Main Story
51 The More The Merrier
There are other reasons for you to have two
GPUs—like hooking up a bunch of extra
monitors to clear all that desktop clutter

Test Centre
94 POPping The Cork
With so many free e-mail providers giving you
POP3 access, isn’t it wise to use a mail client to
store and browse them on your PC? Here are the
ones you should try out

Digital Tools
Test Centre
72 Dinky Data Vaults
CD? DVD? Bah! The best way
to carry data is the USB Flash
drive, and now you can use
our opinions on 46 of them—
ranging from a slim 512 MB

to a ridiculous 8 GB!

35 The High-Definition Itch
The marketing seems to have worked—HD
this, HD that, go HD or die alone—but
what is HD and how do you not get
cheated by all this nonsense?

Agent 001
90 Agent 001 Wants It 
On Paper
Which is the best inkjet
printer of them all? The Agent
wants a copy of his memories,
and getting some work done
wouldn’t hurt either

Lead Feature
27 Going With The Flow
Tell the air in your cabinet
where to go, and
you’ll see
remarkable results!
Here’s how to plan
your rig’s innards
on a budget

Cover Story
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117 To Simpler Times
Fear not Excel’s PivotTable, for it is your friend.
Really. Say goodbye to complex code; making
simple, professional reports will never be the
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If terms like “efficient
resource management”
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The Asking
What are these
mesmeric things
called fractals?
Presenting a look
at mathematics
gone trippy
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133
Where would we
be without James
T Russell and his
CD-ROM?

134
We Indians suffer
from a rare
disease: it’s called
Mouse Rage
Syndrome. A little
fat in our pipes
wouldn’t hurt

128 Game On
Epic Adventures
Neverwinter Nights 2 has finally
released, and it was worth the wait!
Also featuring IL-2 Sturmovik 1946—
easily the best flight simulator you can
buy today

148 Tabloid Tech
We promised not to mention her again, but
She Who Must Not Be Named has topped
another of Yahoo!’s lists. Somehow people
can’t get enough!

Digital Leisure

Test Centre
106 Clutterless Connectivity! 
Nobody likes being tied down by a bunch of
network cables, especially laptop-toting
businessmen. We’ve tested a bunch of Wi-Fi
devices to keep you from tripping over all that
wired nonsense
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Heroes of Annihilated
Empires

This time it's not about units, it's about
armies with thousands of soldiers that
entrust their fate in your hands. It's
about responsibility taken by great
leaders and future of entire races.
Survival or extinction? It's all up to you
to decide

Microsoft Expression Web
Beta 1

It gives you all the tools you'll need to
produce high-quality, standards-based
Web sites the way you want them

VMware Workstation 5.5
This powerful desktop virtualization
software for software
developers /testers and
enterprise IT
professionals that runs
multiple operating
systems simultaneously
on a single PC

LINUX
■ Adobe Reader 7.0.8
■ Scribus
■ Gnumeric

■ Mp3Tools 1.5
■ Open Movie Editor 0.0.20061130
■ Quick Image Viewer 2.0
■ Squid version 2.6
■ Zimbra Collaboration Suite Open

Source Edition

DEV TOOLS
■ FileMaker Server 8
■ HomeSite 5.5
■ JDK 5.0 Update 10 with

NetBeans 5.5
■ Matrix Server Setup
■ Mobile Application

Development Toolkit
■ Automated Build Studio v. 2.25
■ TestComplete v.4.28
■ UltraEdit v12.20a

GAMES
■ NTE: Strike and Retrieve
■ Medieval II Total War

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Corel Painter IX.5 
This software features a
new set of advanced tools
and features to help you
create your digital
masterpieces

Trend Micro Internet Security
2007

This internet security tool
comprehensively safeguards your
computers, your home networks and
your personal identity

Canvas X
The single most cost-
effective, integrated
solution for the creation,
enhancement,
presentation, and
sharing of technical
illustrations and graphics

MULTIMEDIA
■ Photoshop Album Starter Edition 3.0
■ SnagIt
■ ACDSee 9
■ FotoSlate 4 

■ AV Voice Changer Software Diamond
Edition 4.0

■ AVS Video Tools ver. 5.4
■ DVD MovieFactory 5 Plus 

INTERNET

■ SurfControl E-mail Filter
■ DC++
■ FileZilla 2.2.2.9
■ Hylapex 2.0.9.1    
■ Messenger Archive Viewer 3.9
■ Pando
■ Peer2Mail 1.61 build 6

■ ISA Server 2006 Enterprise Edition 

SYSTEM
■ CDBurnerXP Pro 3.0.116
■ Partition Magic 8.0

■ IObit SmartDefrag
■ Update Rollup 2 for Windows XP

Media Center Edition 2005 RU2
■ Driver Genius Professional Edition 
■ DriveWasher
■ PC BackUp 7.3.1.3
■ Registry Repair
■ Spyware X-terminator 5.0.3.3

Contribute 4

Contribute 4 enables anyone to
quickly, easily, and safely update
existing websites and blogs

Fishbowl Inventory 4.5.1

Businesses need advanced inventory
control capabilities beyond ordinary
inventory software currently provides
and Fishbowl Inventory caters to those
needs

AnyTime Organizer Deluxe
10.0

This adds organization and enjoyment to
your daily life. Day Planner &
Calendar:Schedule all your
appointments, events, calls, and
meetings and organize your busy
schedule

TurboCASH Accounting
v3751

TurboCASH .7 is an open source
accounting package for small business

XAMPP Windows 1.5.5
XAMPP is an integrated server package
of Apache, mySQL, PHP and Perl that all
run from a removable drive

PRODUCTIVITY TOOLS 
■ Achievo
■ Aethera
■ GanttPV v0.6.1
■ Grisbi 0.5.8
■ Nomad PIM

MOBILE APPS
■ iPod AudioBook
■ FMA 2.1 Beta 3 
■ Mobile GMaps v1.27.00
■ JabpLite v1.17

■ TaskSpy v0.96
■ BlueEyes 1.21
■ JADMaker 1.15  

Battles of Britain

This is a flight similutation game that
recreates the historical Battle of Britian
in World War II. Fly as the Germans or
British in historically accurate planes

Travelogue 360: Paris

Locate items hidden in 3-Dimensional
views of the Eiffel Tower, down the
Champs Elysees, under the Arc
d'Triomphe, and others of Paris’ most
beloved landmarks

Crazy Nut Free Full Game

Ridiculous and funny game about
fascinating travel of a nut! Jump higher
and higher

Laxius Power II 

A great sequel to one of the best
freeware console-style RPGs, Laxius
Power II is even larger and more
polished than Laxius Power

SMALL GAMES
■ Babo Violent 2 v2.02
■ Mystery Case Files: Prime Suspects
■ Dominions 3

MOVIES
■ Toonerville Trolley - Trolley Ahoy
■ Popeye - A Haul in One 

■ The Pied Piper of Hamelin

For
LINUX

MOVIE
of the

MONTH
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Flash Lite 2.1
Flash Lite is the Flash
technology specifically
developed for mobile
phones and consumer
electronics devices. It
dramatically accelerates the delivery of
rich content and browsing, and
customized user interfaces

XML Notepad 2007

It provides a simple intuitive user
interface for browsing and editing XML
documents

Xtreme Toolkit
Professional Edition
10.3.1 
Xtreme ToolkitPro for
Visual C++ MFC provides
Windows developers with
a sophisticated set of
components to give
applications a
professional, modern appearance

AXIGEN Mail Server
Business Edition

It is a fast, reliable and secure mail
server on Linux, with an open
architecture. Providing ESMTP, IMAP,
POP3, WEBMail services and an
integrated List server

DEVELOPER TOOLS
■ Devel Package 1.5.5 - XAMPP
■ Microsoft Threat Analysis & Modeling 
■ NeoPhoto
■ Syn Text Editor 2.1.0.46
■ BlueTools
■ EditPro 1.57
■ TextPad 4.7.3

LINUX
■ Bluefish 1.0.6.

■ Zope
■ PageStream 5.0.3.4 beta 
■ Bochs 2.3
■ GNU Parted 1.8.1
■ GPhoto2 2.3.0
■ GQview 2.1.5
■ UPX 2.03
■ Webmin 1.310
■ BRU Desktop 17.0

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Contents Interactive

McAfee Internet Security
Suite 2007
New Internet Security
Suite automatically cleans
viruses, repels hackers
with a secure firewall,
blocks spyware when it
tries to load, detects spam
and credit-card phishing scams, warns
of dangerous Web sites

Rohos Welcome
This program adds the
convenience and additional
security level to the
standard Windows logon
procedure

MULTIMEDIA
■ Alcohol 120% 1.9.5.3823
■ The Blaze Media Pro
■ ThumbsPlus version 7 SP1
■ 1Click DVD to Divx xVid Avi
■ AVI TO MPEG Scout
■ AVS TV Box 1.3.5.52 beta
■ Fractal Forge v.2.8.2 
■ FractalVision
■ Fractint version 20.0
■ Movies Extractor Scout Lite 2.31
■ TieraZon2 
■ WinFract 18.21
■ Fractal eXtreme
■ PhotoAcute Studio
■ Ulead GIF Animator 
■ Ultra Fractal 4.03
■ HyperSnap-DX

INTERNET

■ Gigaget 1.0.0.21
■ hMailServer 4.2 Build 195
■ Traces Viewer 1.20
■ Voice E-Mail Pilot

■ BlackWidow 5.21
■ WS-FTP Pro 2007

■ Ez4file Personal Edition
■ SecurWall 0.98

SYSTEM

■ Registry Mechanic 6.0
■ Advanced WindowsCare Personal 

■ FileBox eXtender
■ Mz Ultimate Tweaker 3.2

■ Smart Data Recovery
■ Advanced Archive Password Recovery

■ Aurora Password Manager 1.6.10
■ Super Utilities 6.6

■ AutoPlay Express 4.2
■ Virtual CD v8

ESSENTIALS 
■ Avast Home Edition 4.7

■ Foxit Reader 2.0 Build 0930
■ Irfan View 3.99

■ K-Lite Mega Codec Pack 1.61
■ Spybot Search and

Destroy 1.4
■ Opera 9.02

■ VLC Media Player 0.8.5
■ Winamp 5.32
■ WinRAR 3.62

ConceptDraw MINDMAP
Professional

This is a mind-mapping and team
brainstorming tool with extended
drawing capabilities

PiggyBob
Premium 3
This powerful,Windows-
based application will
help you keep track of
daily, weekly and monthly events - with
an alarm clock and alert system included

copy2calendar

With a single keystroke you create
calendar entries in Microsoft Outlook,
Lotus Notes or Palm Desktop

Mind Pad

Mind or concept mapping is an
excellent method to represent your
opinion, ideas and projects

PRODUCTIVITY TOOLS 
■ WinGate Proxy Server  6.2.0
■ HindiWriter 1.4a
■ ABC Amber iCalendar Converter 1.03
■ Cover Commander
■ FindGraph 1.72
■ Home Bookkeeping
■ VIP Task Manager

(Client/Server) 1.01

■ MOBILE APPS
■ ClamWin Portable

■ PhotoAcute Mobile

■ Yahoo Go Mobile v1.0
■ 7-Zip Portable
■ Guardian 2.1
■ MMS Home Studio Version 1.1.283
■ Mobile Phone Monitor
■ SymTorrent v1.12
■ Theme Creator Pro Version 3.1
■ VLC Media Player Portable
■ Pstart Version 2.09

Believe In Santa

Just before Christmas, Sandy visits her
granny and learns that granny's bank
loan on her gift shop is due in 10 days!
How is she going to make $10,000 in
such a short time?

Mystery Case Files:
Huntsville

Crime spree baffles Huntsville police!
Do you have a keen eye for details? See
if you can locate enough hidden clues
to solve the crimes and become a
Master Detective! 

Sudoku Portable

Sudoku Portable is the entertaining and
addictive Sudoku puzzle game
packaged as a portable app, so you can
play on the go

SMALL GAMES
■ Halloween 2006 Free Full Game

■ Tobi On The Run 1.4
■ Railroad Tycoon Deluxe 
■ Sheepish
■ Park a Lot 2

VIDEOS

CD

DIGIT JANUARY 2007For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the subject.
If the subject is not mentioned, your mail might not reach the right person.
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You get to choose what goes on
Digit Interactive. This month,
you chose:

Update Rollup 2 for
Windows XP Media Center
Edition 2005 RU2 Free
Size: 29 MB

ACDSee 9 Trial 
Size: 23 MB

taste technology at www.thinkdigit.com

Total: 4317Last Month’s Question

This Month’s Question

To vote Log on to www.thinkdigit.com

What Optical Drive Do You Own?

Digit Reader Poll

MADNESS ON THE FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
We’ve dealt with some crazy stuff on the forum, but just watch how this thread starts out and goes
completely nuts.

What does DIGIT
do after testing

the products in their lab?

CD Writer or below   DVD-ROM Drive

DVD Combo Drive     DVD Writer

Are you satisfied with support for your
technology-related purchases—services,
software or hardware?

It could
be better

Yes,
I am

Never
needed

it

Subscribe
No more snail-mail! No
need to visit post offices!
All you have to do is log
on to www.thinkdigit.
com/subscribe and use
your Credit Card to make
sure you never miss
another issue of your
favourite magazine!

Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

And for 60 points get
Raaabo free....

blackpearl
In The Zone

As the title says it all. Many
companies send their

products for reviewing (both
hardware and software) ..
what do Digit guys do after

reviewing them
Do they return them to

companies or use them at
center or sold in sale..

I have an idea, give them in
patron points or post them in

bazaar section.
I want to purchase games

that Digit reviews at half the
rates. Is that possible??

Akhil Jain
Broken In

Buy the Digit company 
for 120 points

Tech Geek
Alpha Geek

In the new digit patron
programme Xbox 360 will be
available for 80 points and

PS3 for 100 points

vimal_mehrotra
Broken In

for 140 get Manmohan Singh
(shipped in four weeks)

vimal_mehrotra
Broken In

For the rest, go to http://www.thinkdigit.com/forum/showthread.php?t=44144

No, not at all 
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Tanushree Dutta 
Model and Actress

The now-well-known
actress got her first

glimpse of fame with the
Ponds Femina Miss India

Universe 2004 award.
She is best known

for her
performances in
Aashiq Banaya
Aapne and

Chocolate.

Technology… 
Helps one in day-to-day life.
People’s entire life revolves
around technology, and has
now become an integral part
of our lives.

What gadgets do you use?
I use a laptop, and of course,
a mobile—a Nokia N72 to be
precise. I also have a
handycam and an iPod. 

What would be your dream
gadget be?
Something that would read
people’s minds…

What do you mostly do
online?
I chat with my friends, e-
mail, and I go online if I
need to watch movie
trailers. I also listen to music
online and download MP3s. I
don’t watch movies online,
and would prefer to go to a
theatre—or watch them on
my DVD player.

An instance where
technology has really
helped you?
Technology has always
helped me. One instance I
can recall is when I was in
college: my vehicle broke
down at night on a lonely
road, and it was quite a
distance to walk. Thanks to
my mobile, I was able to call
my friends for help.

Into Cyberspace And Back
IBM will work with Circuit City to explore retail business
models in 3D virtual worlds. The companies hope to
discover how such environments can be utilised to
improve customer experiences with brands, and have
built a digital store on an IBM’s island in Second Life.

The Last Windows?
Research firm Gartner has predicted that Vista will be the
last major Windows release. “The era of monolithic
deployments of software releases is nearing an end,”
Gartner has said. The prediction went on, “Microsoft will
participate in the trend toward more flexible updates.”

L
ike many Asian
countries, European
governments want to
shift to Linux—in

some cases entirely—in a
bid to save money and
break free of the M$
hegemony. But not just for
these reasons.

There are several
interesting perspectives on
why it is that Europe wants
to take the lead in
moving to the OSS
business model,
much more so
than the United
States does, for
example.

Xavier Cazin,
a Chief Editor at
O’Reilly Editions
France, has an
interesting take: as
computers become a
daily necessity, the
French
philosophical
perspective has
led people to
revolt. “The more
the role of
something is
essential, the
less it should
cost. People hate
paying for
something that is
unavoidable. That’s why
French people didn’t feel
guilty in pirating Microsoft
software for years.”

But unfortunately, most
of the current talk is
rhetoric in nature, and it’s
a case of I-can’t-get-myself-
to-do-it. Or something like
“the spirit is willing but
the flesh is weak,” in
dramatic terms.

One official put it thus:
“If the technicians say ‘no’,
it’s not going to happen.”
And why, indeed, are the
technicians saying “no”? For
all the basic reasons:
compatibility issues,
conflicts with MS Exchange
Servers, and the problem of
educating governmental IT
departments about Linux,
OpenOffice and more.

The suspects and the
figures: elected officials
have, for some time now,
been making a fuss about
migrating to open source on
major scales. Migrations of
governmental computers in
France, Germany, Norway,
and Spain have been
planned at some point or
the other, but few
departments have actually

done the migrating.
According to market
research firm IDC, more
than 95 per cent of all PCs
used by government
workers in Europe still run
on Windows.

The most ambitious
open source initiative in
Europe thus far was a
project by the local
government in Spain’s

Extremadura region,
which has managed to
migrate some 75,000
PCs to Linux. Tellingly,
some of the computers
in the project’s
administrative office still
run Windows, an
employee told Wired

News. Under condition of
anonymity, of course.

The drive continues.
France, in particular, is
trying to hasten the
crossover, as we indicated
above. Over the next few
months, lawmakers in
France’s National
Assembly will start using
Linux, OpenOffice, and
Firefox on PCs. The
official reason stated goes

thus: the French
government’s push away
from Microsoft platforms is
driven in large part
concerns about security and
industrial espionage in the
economic war between
Europe and the US.

In the case of the French
Gendarmes—the police
department—the PCs used
by the 1,00,000-member
police force run almost
entirely on Windows. The
unit plans to make 5,000 of
its PCs run under Linux this

Enter
LINUX EVERYWHERE

Europe Wants It, Won’t Do It

Illustration Harsho Mohan Chattoraj



year under a pilot project,
and the plan is to migrate
fully by 2010. Where Linux
goes, OpenOffice can’t be
far behind: the police unit
has also shifted its users to
OpenOffice and Firefox.

The bottomline? A
Gendarme, speaking on
condition of anonymity,
said that while he was
optimistic about Linux, he
was not too happy with
OpenOffice. He said he
“missed” MS Office.
“OpenOffice is complicated.
It is atrocious,” he said.
(Something must have been
lost in translation, we’re
sure. Unless he was
speaking less-than-perfect
English.) “We save money
but the advantages of its use
are not terribly clear.” A
mixed statement if ever
there was one, but we get
the general idea.

LANDMARK ACHIEVEMENT

Fujitsu Joins
The Race

Seagate won the race with
perpendicular recording

of hard disks, of which
you’ve doubtless heard.
They produced the first 750
GB disk using that
technology. Now, we
mentioned in our December
2006 issue that they’re
already talking about HAMR
to increase areal densities.
Fujitsu recently achieved a
landmark in this field 
of research.

HAMR (Heat-Assisted
Magnetic Recording), as it is
called by Seagate, or TAR

(Thermally Assisted
Recording), as it is called by
Hitachi GST and others,
uses a two-fold principle to
record at higher densities.
The first idea is that bits
cannot be packed closer
together because when this
is done, they tend to lose
their proper magnetic
orientation. If the material
used were of higher
coercivity—meaning that it
is harder to demagnetise—
then the bits can be
cramped together more
closely without fear of them
changing magnetisation.

The second idea is that if
a material has higher
coercivity, it’s also harder to
write on to, and that’s where
the heat comes in—when the
spot of data to be recorded
on is heated by a laser, it
becomes easier to record on.

Now for recording onto
heated spots, areal densities
(how closely-cramped the
bits can be) would be high
enough only if the spot were
small enough. As you can
see, making a smaller spot is
plainly key to the process. 

Now Fujitsu has
demonstrated what it
claims is the world’s first
optical element capable of
producing a beam less than
100 nm across. The company
says TAR will be key to the
next generation of hard
disks in terms of capacity.

The company says the
optical element will be able
to achieve a spot size of 88
nm by 60 nm, eventually
enabling recording at a
density of 1 terabit per
square inch or higher. This
is more than double the
current record—421 gigabits

per square inch—set by
Seagate earlier this year.

Other companies such
as Hitachi GST (Global
Storage Technologies) are
also working on TAR (or
HAMR). They say they can
get the grain, or spot, size
down to 2 nm, where
conventional recording
could only manage 8.

The bottomline: Fujitsu
has said that in conjunction
with perpendicular
recording, HAMR (or TAR)
will enable drives with
capacities ten times higher
than what is possible now.

As for “when,” the
timeline for TAR is about
2010. Another race, one
we’re keenly looking
forward to—and one that’s
spoken about much less
than the gigahertz races or
the core wars. For some

HAMR
Heat-Assisted
Magnetic
Recording, or TAR
(Thermally Assisted
Recording). The

hottest thing happening in
storage research labs. IBM has
a working prototype. Expect all
disk storage news in 2007 to be
about HAMR!

Perpendicular
Recording
Sorry, but we
measure time in
weeks and days,
not years. We don’t
expect anything
groundbreaking to happen
on this front—just produce
more disks and get it done
with, don’t talk about the
technology any more!

DIGIT JANUARY 2007

Security Watch

IM With Caution
The Problem
A vulnerability has been
reported in Yahoo! Messenger.
This can potentially be
exploited to compromise a
user’s system. The
vulnerability is reported in
versions obtained prior to 2
Nov 2006. It is caused due to
an error in an ActiveX control,
and can be exploited to cause
a buffer overflow.

The Solution
Upgrade to the latest version,
available at http://messenger.
yahoo.com.

Firefox Vulnerable
The Problem
Security firm Secunia has given
its “highly critical” rating to
multiple vulnerabilities that
have been reported in Mozilla
Firefox. These can be exploited
to gain knowledge of certain
information and potentially
compromise a user's system.
The vulnerabilities are reported
in all Firefox 1.x versions, as
well as in Firefox 2.

The Solution
Mozilla released Firefox
version 2.0.0.1 pretty soon
after the vulnerabilities were
reported. Just “check for
updates” from the Help menu
in Firefox—it’s a small
download. If that doesn’t
work—if it says “update
failed”—then head to
www.getfirefox.com and
download the latest version.

If for some arcane reason
you don’t like Firefox 2, you
should upgrade your other
version to 1.5.0.9.

17

Pradnya GuravMayur Gangar
“It’s like the sky.”“Bigger than the ocean.”

Amit Babar
“It stret

ches from the north to the 

south pole!”

Sudipta Satpathy

“As endless as the universe!” “As big as my brain…”
Prashant Sonpal

“How Big Is The Internet?”One Silly Question
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Enter

A source for facts, a conversion tool, and a how-to

www.refdesk.com
“The Single Best Source For Facts,” this is
one site where much of the information
clutter on the Internet is organised in an
easily-accessible manner. Browse through
dictionaries and encyclopaedias. Conduct
Business Searches, People Searches and
Fact Searches. Check weather forecasts.
Keep in touch with the latest news. Read
about the significance of this day in
history. Just head to the site!

www.zamzar.com
Zamzar lets you convert image, document,
music, and video files up to 100 MB in size
to different formats. Image files can be
converted between BMP, GIF, etc.,
document files to CSV, DOC, HTML, etc.
music files between AAC, AC3, OGG, etc.,
video files to and from 3GP, AVI, MPEG,
OGG… there’s a caveat, though: read the
terms of service, but beware of spam.

www.ehow.com
How do you tie a tie? How do you
install a GPS receiver or strip the paint
from your car? How do you open a
stuck jar lid? eHow has answers to all
the above: 20,000 articles! From the
everyday to the exotic, from the
simple to the complex—find out how to
do it all right here. 

Zamzar Beta 

eHow

refdesk.com

reason, silicon valley has
hogged the limelight for
good, and “iron oxide
valley”—possibly the more
important one—will always
remain in the shadow.

THEY’VE MADE A DENT

Of Asses And
Donkeys

The M. P. Ass. of A. and
the R. I. Ass. of A.
aren’t doing the silly

thing anymore—going
behind 12-year-old
schoolboys and 89-year-old
grannies demanding money
for filched songs. They’re
hitting P2P where it hurts.

eDonkey is dead: a New
York court ruled that the
P2P site did enable users to
illegally share copyrighted
material. The owners have
another P2P network—
Overnet—which, too, the
court has declared illegal.

The ruling is a major
victory for the record labels.
Their RIAA has, by now,
managed to dent all the
major file-sharing networks
with the exceptions of

LimeWire and The Pirate
Bay. The developers behind
LimeWire will soon be
hauled to court, too: in
November, the RIAA filed
suit against LimeWire, and
RIAA CEO Mitch Bainwol
has gone on to pronounce:
“Our settlement with
eDonkey will make
operations such as
LimeWire that continue to
break the law... all the
more conspicuous.” As
precedents go, it’s a bleak
outlook for LimeWire.

In very related news,
the MPAA has declared it
will launch a legal attack
on BitTorrent server
operators. This could
ultimately prove to be the
sock in the b***s for the
BitTorrent community, at
least the 99 per cent or so
of it that comprises illegal-
file sharers.

eDonkey.com and
Overnet.com now bring up
ominous-looking
messages: “The
eDonkey2000 Network is
no longer available. If you
steal music or movies, you
are breaking the law. Your
IP address is xxx.xxx.
xxx.xxx and is being

A Round-up Of Technology News From Across The GlobeThe Digital World

Three Incredibly Useful Sites

CHINA
A full-fledged campaign against piracy will
be launched after the success of a 100-day
initial campaign for video, software, and
publication piracy. Targeted groups of
pirated video, software, and printed
publication vendors, if found guilty, will be
severely punished.

SOUTH KOREA
Legislators will ban online trading of
virtual currencies used by gamers.
Reportedly, this step is being taken to
control “virtual social ills” such as
identity theft, bribery, gambling
addiction, and more.

GERMANY
The government will bring in new laws
by which anyone found guilty of
shooting, chain-sawing, or hitting with
hammers a human-looking, computer-
generated character could face a fine
or a year in prison. Apparently, cyber-
characters have rights too!

GREECE
The education ministry has banned
the use of mobile phones by children
at schools, the reason being that the
rape of a teen was video-ed by a few
other students.

SOUTH AFRICA
Intel has donated a supercomputer to
the country. It will be dedicated to
research on fatal diseases such as AIDS,
malaria, and tuberculosis. The
supercomputer, costing $1 million, will
be free of charge for local scientists. It
has a speed of 1 TeraFLOPS
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Enter

Photograph Gaurav Gogia

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

CCNA INTRO
by tODD lAMMLE

Published by
Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

“Umm... it does have
Notepad, though”

logged.” ThePirateBay.org,
however, looks fresh as ever.

People will doubtless
continue to share music and
movies, regardless of what
happens to the P2P
operators. There are simply
too many people who will
lend their servers to the
“Darknet” for the whole
thing to be wiped out.

But what’s happening
here is that it’s not going to
be for Joe Average any
more—it’s going to become
more of a geek thing. Like it
once was a geek thing to
connect to another
computer using a modem.
This, if the Ass.es have their
way—and they just might.

BEYOND ILLEGAL P2P

BitTorrent To
Deliver
Movies?

BitTorrent CEO Bram
Cohen now seems all
set to pitch P2P as the

most efficient way of
delivering HD content. It’s

timed just right: cable
companies are just about
beginning to strain under
increased costs of HD
delivery, as more and more
people get the idea that HD
is the way video was meant
to be. And with demand
naturally poised to increase
over the next couple of
years, will P2P come to the
rescue?

BitTorrent’s pitch could
have something to it, though
there are detractors aplenty.
The technology could need
some work, but it does seem
to hold promise. It’s all
about bandwidth
efficiency—and one only
needs to put out the
mindset that one is
“sharing” something while
watching a movie
downloaded via P2P, or that
one is somehow doing
something shady. Such
misconceptions were once
prevalent: Cohen, in an
interview, said there were
instances of “companies
having a policy of not using
any P2P technology at all,
but some sysadmin would
surreptitiously use
BitTorrent for internal

distribution when it was
warranted.”

After BitTorrent’s
acquisition of µTorrent,
Cohen and µTorrent creator
Ludvig Strigeus said in a
joint statement, “Bringing
together µTorrent’s efficient
implementation with
BitTorrent’s expertise in
networking protocols will
significantly benefit the
community.” And: “We will
continue to develop
µTorrent, and will be using
the code base in other
applications, such as
embedded systems on TVs,
cell phones...” Meaning,
effectively, that P2P is the
way to go.

It’s been a while since
Cohen’s company signed
deals with major Hollywood
studios including 20th
Century Fox and MTV
Networks. BitTorrent is
forming distribution
partnerships with film and
TV studios including 20th
Century Fox, MTV Networks,
and Paramount Pictures.
One of the goals, of course,
is to be able to deliver—via
P2P—content directly to
users’ set-top boxes. And,

“We’re working on making
BitTorrent come preinstalled
on many embedded devices,
as one of the basic services
they support—in the same
class as Web browsers,”
Cohen said in a recent
interview.

Asked by Wired News
about where he sees file-
sharing going, Cohen had
just this to say: “We’re going
to see everything... become
more Web-based, and the
special status of high-quality
video files... as somehow
different will go away. The
current limitations on
distributing them will cease
to exist.”

On the other side of the
story, HDNet (an HDTV cable
network in the US) chairman
Mark Cuban, billionaire
investor and dot-com
veteran, has dismissed the
notion of P2P as a content
delivery platform as, well,
nonsense: “I think P2P is
great for corporate and
controlled apps, but not for
open distribution. P2P has
content-distribution
capabilities, but mass
distribution of content isn’t
one of them.”

Last Month’s Winner!
D Sunil Kumar
Dabolim, Goa
“Mobile Shop = Mobile Phone!”
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Cuban had said in
September, “Only a moron
would buy YouTube.” So
what does that tell us? We
aren’t clear either.

COP-OUT

Time Goes
Ga-Ga About
Web 2.0 

They probably expected
such sneers, and they
probably didn’t care.

Time Magazine has gone on to
name participants in the
inexplicable experiment

called Web 2.0—including
“you”—as the People of the
Year. This is a cop-out of a
major order.

Lev Grossman of Time
waxes eloquent: “It’s a story
about community and
collaboration on a scale
never seen before. It’s about
the cosmic compendium of
knowledge Wikipedia and
the million-channel people’s
network YouTube and the
online metropolis MySpace.”
Wikipedia is an event of the
year? Seriously, we’re all avid
users of Wikipedia, but
when it comes to naming
something of global
importance we must point
out, we’ve had

Encyclopaedia Britannica for
centuries. As for YouTube,
you can comment on it
being a groundbreaking
event as easily as we can.

MySpace users,
incidentally, are 55 per cent
American. “You can learn
more about how Americans
live just by looking at the
backgrounds of YouTube
videos than you could from
1,000 hours of network
television.” Mr Grossman, we
beg to remind you that the
world is not American.

Are blogs revolutionising
the world? Some people
seem to think they’re doing
something revolutionary
when they’re creating
something the world can
see, but the problem is, it’s a
cacophony of voices (in
which each possibly has
merit). Whichever way, what
does Web 2.0 have to do with
it?

The whole thing smacks
of wasted eloquence: “We
also worked like crazy. We
reviewed books at Amazon
and recorded podcasts. We
blogged about our
candidates losing and wrote
songs about getting dumped.
We camcordered bombing
runs and built open-source
software.” In much of the
above, what’s to do with
Web 2.0? And in any case,
would you read a blog about
someone getting dumped—
something that, in
Grossman’s opinion, is
revolutionising things? Is it
“changing the way the world
changes”? Are the book
reviews at Amazon.com
more credible than those
you can read in The New York
Times? Seriously, again, does
Web 2.0 have the will to
change the world, is our
question.

Grossman excuses
himself with “Web 2.0
harnesses the stupidity of
crowds as well as its
wisdom,” going on to say,
“That’s what makes all this
interesting.” We are
therefore to gather that
something interesting—
rather than something or
somebody edifying—is to
hold our collective attention.

But yes, Web 2.0 is
interesting. However, that’s
where it should end. At least
when you’re talking on a
global scale.

SOCIALISM, ANYONE?

First Splogs,
Now Phony
Stories

Marketers are in line
to boost their
companies’ profiles

at the expense of Digg. This
rather interesting news story
doesn’t, at first look, seem to
hold much: it starts off,
“Digg continues to crack
down on users who plant
phony stories on behalf of
marketers.” The story goes
like this: Digg recently
deleted a user who posted a
story about a company that
offered to pay him. Karim
Yergaliyev is one of Digg’s
top-rated users. Yergaliyev
was booted  for violating the
company’s terms of service,
but was reinstated after he
acknowledged the
infraction, apologised nicely,
and promised never to do
it again.

“I receive two or three
offers from marketers a
week to promote some
product or service,”

The hottest tech talk on the Internet now is, of
course, about cores. AMD has officially announced its
Quad FX Platform, in which a pair of AMD Athlon 64
FX series dual-core processors can be used together
on a supporting motherboard. This dual-socket
platform enables use of four cores for megatasking—
use of multiple displays or running multithreaded
applications such as games, while running other
processes like disc burning and so on.

Power consumption is much higher than an
equivalent Intel system, though. Some forums are
talking about an upgrade possibility—using eight
cores on the platform after the release of AMD’s
quad-core chips. Some experts believe there isn’t
any potential in hooking up more than two cores,
and that there will not be any performance boosts
with new titles. In any case, the battle of the
multiple cores continues…

AMD Quad FX

Ali Vs. Asmita

Use Photoshop filters to
give an image a funny look

She took a cursory look at the filters, but Asmita seemed
to like the colours better. She spent quite a bit of time
painting the image red and sometimes brown, toggling
between the two. Her favourite colours perhaps. She

wasn’t, however, doing what
she was supposed to—try to
change the image. Once she’d
been reminded, she had a
good look at the filters again
and decided to use the
“Liquefy > Bloat” tool to give the image a
bulged-eye look. The hair underwent some
changes. Asmita just wouldn’t give up on the
colours—there had to be the red on the lips
before she stopped!

“Ali started off well—he
seemed to know his
Photoshop. He was directly on
to the filters and rapidly went
through them, choosing,
applying, and then undoing
effects. In a few minutes he
had changed some colours,
blurred the image, and
crystallised it quite a number
of times. He obviously didn’t
know which filter would do what. We gave him a
pointer: that the “Liquefy” filter might be useful. Ali
was quickly on to it, and using the “forward warp,” he

managed to pull the cheeks and the ears out. After looking at his work for a
couple of minutes, he decided he had done enough.

GENDER 

BENDERS
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Yergaliyev, 19, said in an
interview with CNET
News.com. “I never do it, but
(this time)...”

So what’s of interest
here? Note that Yergaliyev is
one of Digg’s top-rated users,
and you’ll get a hint. We’re
referring to Time’s Lev
Grossman talking about this
year going down in history
as the time when “the
many wresting power from
the few.”

Sounds rosily socialistic—
socialistic in a positive sense,
as in actually working—
but it seems to us far from
the truth.

Technorati.com has a
drop-down menu that lets
you search for blogs “by
authority.” So where’s the
many who are wresting
power from the few who
have the “authority” on
Technorati? Would you read
something by Robert Scoble
of Scobleizer fame, or
something by someone with
a name like geeky_butterfly?
And why do we need the
Web to teach us this—
ever heard of a “journalist
of repute”? 

Similarly, Amazon.com
has a rating system for its
reviewers. Naturally, and
correctly, you’ll read the
reviews of a high-rated
reviewer with more
credulousness. The many
are down there; the few
are right up there in
the rankings.

This isn’t a space for a
political discussion; our
point is that there will
always be the few and the
many, and the latter will
never “wrest power.” Web 2.0
creates its structures and
hierarchies very well
indeed—it’s as good a
watchdog as any of the
old-world status quo. 

A FRESH ATTEMPT

Will EVD
Make It?

Yet another format, but
one we’ve spoken
about earlier. EVD—

Enhanced Versatile Disc, or
Enhanced Video Disc,

depending on whom you
ask—is like a Phoenix rising
from the ashes! It will
revolutionise HD delivery!
That’s what China would
have you believe!

Exclamation marks
aside, Chinese
manufacturers are sick of
paying intellectual property
royalties for most of the
DVD players they
manufacture, which is a
lot—80 per cent of the
world’s total. Now EVD—
China’s home-grown
format—was being pushed
before as an alternative to
HD-DVD and Blu-ray, and
interest somehow fizzled
out; it’s back now, not with
a bang but with what
sounds to us like a whine.
(“Please buy our dirt-cheap
discs and players!”)

Technically, EVD is not a
blue-laser technology like
HD-DVD or Blu-ray; it’s red-
laser, like DVD, and is touted
to be its successor. China
plans to

phase out DVD altogether by
2008. EVD is essentially DVD
that uses a more efficient
compression system. But
EVD’s developers have said
in the past they would try
and merge the format with
London-based New Medium
Enterprises’ VMD (Versatile
Multi-Layer Disc), a red-laser
system offering 50 GB on ten
5 GB data layers. Analysts,

though, say more than two
layers will be difficult.

This whole thing holds
some import for us for three
reasons. First, it’s already
out: 6 December, several of
the players were on display
at a Beijing art gallery.
(Several titles have been
released too, most of them
Chinese.) Second, the players
are cheap—lower than the
$100 price point. And third,
they will in all probability
be targeted at Indian
audiences—and which
Indian doesn’t like the ring
of the word “cheap”?

Now China has
attempted peddling its stuff
to the world before. Cases in
point are S-VCD, its
telecommunications
standard TD-SCDMA, and
WAPI (WLAN
Authentication and Privacy
Infrastructure), a Chinese
national standard for
Wireless LAN. None of these
made it big worldwide, and

didn’t make too much of a
dent even in Chinese
markets.

Of course, we shouldn’t
be extrapolating, and this
time round, EVD might
just cut it. But most ana-
lysts are saying “no,” and
state media have reported
that the EVD players have
fared poorly in tests. Hedge
your bets now! 

Enter

GP2X
What is it?
The GP2X is a video game
console and media player. It
is hand-held and Linux-
based. Using the GP2X, you
can view photos, read 
e-books, watch videos, listen
to music, play games, import
games from other systems,
and use games developed on
your own. It runs on two 200
MHz CPUs, 64 MB of RAM,
and 64 MB of Flash memory.
It has a 320 x 240 backlit LCD
with custom graphics
hardware and a TV-out. 

When was it released?
The initial release was the
GP32, in 2001. Later—in 2005
to be precise—it was
reincarnated as the GP2X.

Who will use it?
Game lovers—both gamers as
well as developers—are the
target users.

Why is it special?
The GP2X can connect to a TV,
enabling games to be played
on a big screen. The scaling
chip allows movies to be
resized and played without re-
encoding. Being Linux-driven,
there are a lot of software
(games, emulators, PDA
applications, multimedia
players) and tools freely
available, which enable the
development of new games
and applications. The
emulators allow one to run a
host of software from other
systems. And, it just needs two
AA-sized batteries.

How easy is  it to develop
games for GP2X?
The SDK is included with the
system. The GP2X source is
available for Windows and
Linux developers at the GP2X
site. More libraries with their
source are provided at the
GP2X developer’s forum and
elsewhere on the Net. 

Where is it being sold?
30,000 units have been sold
worldwide. Right now it
seems to be very popular in
the UK and Europe. The UK
price is £124.99 (Rs 11,000)!



Robert Sovereign-Smith and
Nimish Chandiramani

It all started when a colleague wanted to
show off his latest geek-venture. Working for
Digit, it’s tradition to show off the latest

gizmos and gadgets. This particular colleague
hadn’t bought anything new—he’d just added a
lot of fans to his cabinet, and was now claiming
to have the coolest cabinet in town. We counted

12 fans in all—overkill for sure! However, what
he didn’t know was that his 12 fans were not
helping much… 

All About Airflow
Keeping a cabinet cool isn’t as simple as just
adding an obscene number of fans on the top,
back, front and side. What you need to focus
on, when improving cooling is how the air
flows, and how you can make sure that cool air
hits the components that get hot. Now some
case-modders have done crazy things, like inte-
grating table fans into their cabinets, so pow-
erful that you see IDE cables flapping in the
breeze, or there are those that use liquid
cooling… however, most of us are tech-crazy,
not stark raving mad! Our colleague had some
intake fans right next to exhausts, which was
defeating his purpose.

Since we were planning on starting a series
of DIY articles, we figured we might as well
start with cabinet cooling and airflow.

Thinking about this article, the very first
problem that cropped up was, how do we show
airflow? Now we could go out and get expen-
sive smoke machines to fill the cabinet with

PC cabinets are just boxes that hold our components, and keeping it
cool is only a matter of adding fans, right? Wrong!

Imaging Pradip Ingale
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smoke and see where the air went, but how
would that help you? A DIY needs to be simple,
and needs to lend itself to easily replication at
the average home.

Also, we often get carried away and tend to
use the best hardware for everything, but in
order to stay in touch with real-world sce-
narios, we were forced to curb our enthusi-
asms, and work with an everyday,
run-of-the-mill PC setup. 

Another restriction we set upon ourselves
was the money we were allowed to spend on
this little project. A budget of Rs 1,000 was allo-
cated, because we figured there’s no way the
average Digit reader would be willing to spend
more than that on just cooling his or her reg-
ular cabinet.

With these things in mind, we set off to our
neck of the computer component woods called
Lamington Road. We bought three cabinet
fans, Rs 50 each; a hard disk cooler, Rs 350; one
round IDE cable for a slightly steep Rs 400
(thankfully, they come bundled with most new

motherboards), and then overshot our budget
even more, splurging on a little tube of Arctic
Silver thermal paste, Rs 400! The Arctic Silver is
completely unnecessary for most of you, espe-
cially if you’re not overclocking your CPUs or
GPUs, so forgive us our little indulgence. We
also bought a little hand blower for Rs 15 to get
rid of accumulated dust.

Smoke Screens
The 12-fan-colleague, mentioned earlier, was
shown the folly of his ways using cigarette
smoke; however, it’s not like Digit wants to
encourage its readers to take up a bad habit like
smoking just to solve airflow problems—we get
enough mails from angry parents as it is! So we
decided to use incense, the type that most of
India uses in prayers and rituals. It’s called
dhoop here, but anything that gives off a lot of
smoke will do. Just make sure it doesn’t give off
too much heat, or you’ll end up scorching your
eyebrows, or worse still, your cabinet or
SATA/IDE cables!

Stock without cleaning

Stock

Stock + Acrylic sheet

Reversing the rear fan

Adding the front fan

With front fan without GPU

Hard disk cooler + front fan

33.8

32.1

31.8

33.1

29.1

28.3

28

34.2

32.5

32.1

33.4

29.3

28

27.8

37.9

36.2

35.7

36

33.3

32.2

32

Configuration Temperatures (degrees C) - Maximum

Idling at
Bios

Idling At
Windows

Running 3D
Mark 05

Temperature Readings

We think this paints a pretty descriptive picture about the
cooling components we added, and will help you decide on how

to go about optimising your airflow

Here’s what we noticed in terms of cabinet ambient
temperatures while doing this workshop
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Note: You should know that we did leave black
charred marks in our white cabinet, and at least one
person burnt his fingers, so be careful.

The PC
We used a regular-looking cabinet, and tried to
recreate an average PC configuration to gen-
erate the type of heat that most of you should
have within your cabinet.

The configuration was:
■ AMD Athlon 64 3200+
■ 2 x 512 MB Transcend DDR 400 RAM (without

heatsinks)
■ 80 GB Seagate hard drive (SATA)
■ 120 GB Maxtor hard drive (SATA)
■ MSI RS 480 motherboard
■ ATI Radeon X1300 graphics card
■ 380 W PowerSafe SMPS
■ 1 stock rear cabinet fan
■ Plextor DVD-Writer (for the IDE cable)

This configuration generated 34 degrees cel-
sius of ambient cabinet temperature, which we
measured using a temperature sensor that we
got from a Zebronics cabinet we had. This tem-
perature was measured at the Windows
desktop, after leaving the PC on, idling, for
about half an hour.

In order to be able to show you the smoke /
airflow, we also went out and bought a clear
acrylic sheet for Rs 80. You can do this yourself
as well, to keep the innards of your cabinet vis-
ible at all times.

Getting Ready
First things first—we decided to get rid of all
the dust in the cabinet. Using our little orange
hand blower, we realized that keeping the
insides of the cabinet clean was quite a task.
We took apart the whole system, and coughed
and sneezed our way through blowing away all
the dust. Even in our temperature-controlled
office with sealed windows, we found quite a
lot of it, so if you haven’t opened your cabinet
for over a year, wear a surgeon’s mask!

The only thing we
didn’t open in search
for dust was the SMPS,
which was still within
the warranty period.
You should also avoid
breaking any seals
that can void your
warranty. If all war-
ranties have expired,
don’t be afraid to open
out the SMPS cover as
well (after discon-
necting it from the
mains, obviously) to
get at that cake of dust
that forms within all
power supplies.

Now that we had a
nice, gleaming PC, we
went a little off track
and Arctic Silver-ed
the CPU, after

It isn’t as descriptive as it seeing it live, but the smoke from the incense sticks is fairly indicative as to how air flows in the top section of the cabinet.
What you can’t see here is the smoke being blown out the sides of the processor heatsink and then sucked and expunged by the power supply

Tip
Round IDE Cable
A round IDE cable will help you push it to one side, and not
obstruct airflow the way the flat cables do. If you have mainly
IDE drives, make sure you get yourself a few round IDE cables
to help air flow inside your cabinet. Unless they came bundled
with your motherboard, the costs can be a little daunting, at
around Rs 400. You could, however, gingerly pry out individual
wires, or even pairs, from your flat IDE cable and bunch the lot
together to make your own round IDE cable, as we have done
here. Note that we take no responsibility if you botch up.
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cleaning the old thermal paste away, and
cleaning the heatsink using a cloth and some
brushes between the fins. We then proceeded
to connect everything back, and used the
round IDE cable instead of the flat one we had
earlier. We also connected the RAM strips in
the slots furthest away from the CPU—you may
not be allowed to do this on all motherboards—
and made sure there was enough space above
and below each hard drive.

We now measured the temperature again,
and found that it hovered between 31 and 32
degrees celsius. That’s 2 or 3 degrees cooler
just because of a sound cleaning! We also
found that the CPU idling temperature from
the BIOS screen had dipped from 42 degrees to
38 degrees Celsius—vive le Arctic Silver!

Now our cabinet also came with a side
panel with a conical appendage on the inside
that’s meant to help bring cool air directly to
the CPU heatsink. We wanted to check whether
this helped the CPU cool any better than when
we attached the simple acrylic sheet. It did, but
very marginally; with the stock cabinet side
panel, with the conical appendage, we found
that CPU temperatures stayed at 37 or 38
degrees; however, we suspect that airflow was
obstructed by this cone, because cabinet tem-
peratures were raised a degree.

For those of you wondering why a degree
matters, you should remember that these are
just idling temperatures, and also during the
winter, in an air-conditioned office. At home,
with cramped spaces within your computer
table, or under a desk, while running a game
or video-rendering software or something
equally taxing, the temperatures of your 
CPU and cabinet will soar—even more so in 
our Indian summers, for those without 
air conditioning!

We decided to discard the stock side panel
and stick to the acrylic sheet. Not only did it
seem cooler inside the cabinet, we also needed
to conduct our airflow experiments now, and
needed the transparency of the acrylic.

Coughing Fits
Now it was time for the smoke. We made the
mistake of trying to conduct the experiment in
a closed room—bad idea. Five minutes into the
whole thing, we all ran out coughing up some-
thing terrible, and found that everything,
including water, seemed to taste of incense. We
strongly advise that if you do this, do it in a very
well-ventilated area.

Red-eyed and with weakened lungs, we
bravely ventured back into the room and
opened the windows, and brought along a
couple of fans. 

We then proceeded to fill our cabinet with
smoke, and try and see how the smoke flowed.
We put a few burning incense sticks (safely
contained inside a ceramic plate, after one of
us burnt his fingers!) into the cabinet, put the
acrylic sheet on, and then waited awhile for
the cabinet to fill up with smoke. We then
turned the PC on and watched where the
smoke went. The hardest part was trying to get

still photographs to tell the story, but to the
naked eye, the way the air flowed was obvious. 

Now the fan-happy colleague we mentioned
earlier had inadvertently reversed his cabinet’s
rear fan, causing it to draw air in instead of
throwing it out! We did the same to our test cab-
inet, and noticed that this was bad for airflow,
because everything was being forced out from
the power supply exhaust. This left smoke in the
lower regions of the cabinet for a few seconds
longer. It was also opposing the way the CPU fan
was trying to blow air out, causing our smoke to
be dispersed wildly, instead of forming a nice
neat channel of airflow. All of you should make
sure that your cabinet’s rear fan does indeed
blow air out, because if it’s acting as an input
instead of an output, it could cause your cab-
inet to be hotter than it should be. The smoke
also cleared a few other things up:

The hard disk cooler sucks in air from below and is supposed to blow it out both
open sides, but for some reason, it would do so out of only one side. Go figure.

This X1300 graphics card blew air into the most inconvenient place possible—when
buying, please make sure that your card’s heatsink blows out of your cabinet!
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We found that the ATI Radeon X1300XL
graphics card we used had active cooling, but
due to its design, sent its exhaust (hot air)
towards the centre of the cabinet. When we
compared it to the newer design of the
X1900XT, which occupies two slots but sends
its exhaust directly out the back of the cabinet,
we found that older graphics cards really leave
a lot to be desired in terms of airflow! 

We also noticed that there was hardly any
air flowing over or under the hard drives or the
DVD-Writer. Now a DVD-Writer may not need
cooling, but hard drives certainly do!

Fanning The Front
We found that most cabinets have a space to
attach a front cabinet fan. However, the front
is blocked by the Power and Restart buttons,
along with the hard drive and power
LEDs. Front USB ports also block the front of
most cabinets. 

There are big gaps in the front and along
the sides of cabinets, which were made obvious
by the smoke billowing out of these gaps when
the PC was switched off. We decided that
adding a front fan was the next step, and these
gaps should allow the fan to draw enough air
in. The first hurdle was the fact that the loca-
tion of the front fan was obstructing the hard
drive placement. We couldn’t push the hard
drives all the way in, and settled for them
sticking out a little towards the motherboard
in favour of the additional fan.

It worked! Soon after the cabinet was filled
with smoke, we found that switching it on
made the smoke accumulated around the hard
drive disappear almost instantly and flow
towards the rear cabinet fan. If anything, the
flow of air from the X1300XL was the only
obstruction to smooth airflow. When we
removed the X1300XL and used the onboard
graphics, we found that air flowed much
better! We also saw that smoke from outside
the front of the cabinet was being drawn in
through the gaps in the front, so despite being
covered, the front fan was working well.

Cooler Disks
The next step was to cool the hard drives. We
attached the hard drive coolers we’d bought,
and immediately found that they refused to sit
comfortably in their bays. The problem was
that even if we managed to muscle them in,
because of the extra height the hard drives

Tip
Buying A Cabinet
When buying a cabinet, try not to choose a small form factor
cabinet, especially if you want powerful hardware. The
space savings are not worth running your components hot.
Also, a lot of cabinets come with top fans already attached.
Some even come with front fans. If you don’t want to have
to fiddle about inside the cabinet, make sure you get your-
self a cabinet with at least one top and one front fan, in
addition to a large rear fan.

The entire setup. Don’t get awed by the low temperature, though—this shot was taken without the acrylic sheet
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gained due to the cooler, we couldn’t screw the
drives in because the holes on the disks refused
to line up with the holes on the cabinets. Our
solution, although requiring considerable
finger-acrobatics, was to screw the hard drives
into their bays, sans coolers, and then attach
the cooler from below. Basically, we attached
the coolers from under the notches that the
hard drives rest on! The pain was worth it,
because we’d rather not risk our data on a hard
drive that’s clattering about inside a cabinet.

Placing the hard drive above or in front of
the cabinet’s front intake fan seemed to help.
When we filled our cabinet with smoke again,
we saw that the smoke around the disks dis-
appeared even faster than before, and was all
thrown out from the rear intake fan. We also
noticed that after running a few games, the
hard drives seemed a lot cooler than before,
especially the Maxtor, which used to get so hot
that you couldn’t touch it without discomfort.
After the hard drive cooler was added, though,
it always seemed to stay cool!

Cabinet temperatures were not affected at
all, though, by adding the hard drive fan. How-
ever, if you use your computer in a way that has
a lot of hard drive usage, such as rendering, or
even leaving it on all night downloading from
P2P networks, a hard disk cooler is probably a
good investment, and should help prolong the
drive’s life.

For The Adventurous
If you’re not satisfied with just adding on
another fan and a hard disk cooler, you can go
out and get yourself some cutting equipment,
and cut a hole into the top of your cabinet as
well. We suggest that you do it above the RAM
strips, or basically towards the end of your
motherboard.

Make sure the fan is placed as an exhaust,
and make sure that there is at least 6 inches of
space between the top of the cabinet and your
desk. This will help hot air that accumulates
around the power supply—and the top of the
cabinet in general—flow out easily. Besides, hot
air rises, so the exhaust on top will make sure
it rises out of the cabinet!

If you’re one of the crazy people who want to
attach a rather huge fan to the side of your cab-
inet, make sure all other fans are set as exhausts,
including the front fan. This is because the
smaller front fan will be no match for a huge
fan, so it might as well help it send air out
instead of opposing it by trying to send air in.

Do It Yourself
All this said, it’s not enough for you to just read
this article and nod in agreement with what
we’re saying (or in disagreement either). We’d

rather you discover the joys of tinkering with
your PC. Remember, when playing with fire (or
smoke), play it safe. And let us know if you
come up with some ingenious ideas for
improving the airflow / cooling of your PC.

Remember, we’ve shown you how to
improve airflow using standard components.
However, if you have powerful heat-generating
components, like an overclocked CPU, a pow-
erful graphics card, and a 500+ W power
supply, the heat generated increases dramati-
cally, and you will see greater differences after
optimising airflow. 

Also, watch this space for more such arti-
cles, and we promise you, they’re about to
get geekier! 

robert_smith@thinkdigit.com 
nimish_chandiramani@thinkdigit.com

If you disconnect all the other fans and stick the incense close to the processor, you
can watch the airflow around the area better—including how that air is sucked up by
the power supply as well

It’s advisable not to forget your smouldering incense in the cabinet while you go stuff
your face

Tip
Cable Organising
Inside your cabinet, or outside, organising your cables prop-
erly is essential. You can use plastic wire binders, or even
rubber-bands, but make sure your cables are all arranged
along the sides and the bottom. This prevents them from
getting in the way of the airflow, and thus helps keep your
cabinet cooler.
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There is no clear path to HD land. The idea
of high-definition television is a beehive
of activity with new tech replacing the

old, faster than a speeding bullet. With no
clear winner, choices are numerous, with
many pros and cons to weigh. Things are not
very clear on the content either: HD content
producers are ambiguous on their DRM (Digital
Rights Management) policies—will they, won’t
they, and when (because they will)? What reso-
lution will be widely adopted, to what extent
will DRM shackle our media? To make matters
worse, the content sources are anaemic in
India (neither over-the-air nor broadcast HD
channels available); the only HD content
currently on offer being games. Nor is there
any clarity on the next-generation of HD
media—will Blu-Ray best HD-DVD or vice-versa?

But walk into an electronics shop and your
jaw drops—pretty HDTVs all in
a row and none of the
above matters, lust
overtakes logic; and
while some practi-
cal corner of your
brain pleads to

look before you leap into the HD stream, you
can’t help but scratch that big-screen itch. 

So, hearts filled with joyful consumerism,
let’s take a walk through the HD swamp—learn
a bit about what makes an HDTV, and take a look
at some of the numerous technologies available,
with a strong emphasis on the pros and cons of
each. Which technology to pick? There is no clear
answer. Consider this an interesting journey
without a destination.

What Makes An HDTV?
All televisions display images as a grid of
coloured dots or pixels. The more the dots a TV
can display, the higher its resolution. The TV sets
that most of us currently use is called SDTV; it
has the lowest resolution possible. An enhanced
version of this type of TV—called EDTV—is also
available, but even that type does not differ much
over the SD variety. The drawback of a low reso-
lution is that as the screen size of a television set
increases, the TV has to fit the same number of
pixels to a larger screen area. This results in poor
image quality; it’s similar to watching a video
recorded by a cell phone on a PC in full-screen
mode. Larger displays offer a more cinematic
experience. This is where HDTV steps in. 

TVs generally come in two screen ratios—a
4:3 screen and a 16:9 screen; some sets also sport

You might not be
able to afford
one. There is
nothing to watch
on one. But you
still want one. We
help you scratch
that HDTV itch

The High-
Definition Itch

Illustration Chaitanya Surpur
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a 16:10 screen. The number denotes the ratio of
the horizontal size of a TV screen to its vertical
size. Thus a 4:3 PAL SDTV (the most common vari-
ety) uses a fixed pixel grid of 768 × 576 or 720 x
540. Most movies, however, are shot in 16:9
format, also known as widescreen (as seen in
movie theatres); some SDTV sets and almost all
HDTV sets come in a 16:9 widescreen format. A
small thing to note: if you are in the market for
a new PC monitor, you’d do well to pick up a
widescreen variety, as most forms of entertain-
ment now come in 16:9.

Now what happens if your TV is not 16:9? The
16:9 format movie on a 4:3 TV set will be scaled
down to fit the lesser width. This leads to empty
areas at the top and the bottom of the TV screen,
which are filled with black bars. This is known as
letterboxing. Some sets might attempt to stretch
and scale the image and make it fit the 4:3 area,
leading to a distorted video. Others might zoom
into the video instead; this hides a portion of the
video content. A 4:3 format video on a 16:9
display will fill the screen from top to bottom
but not from the sides, and so you will see
borders on either side of the screen.

As a general rule of thumb, all HDTV sets are
likely to be widescreen, but all widescreen TV sets
need not be HDTV. Thus what essentially distin-
guishes an HDTV from an SDTV is its screen reso-
lution. An SDTV is 480i, an EDTV is 480p, and
HDTV can be either of three resolutions: 720p,
1080i, 1080p. What do these specifications mean?
The number denotes the number of horizontal
lines of dots that are present in the TV. Thus a
480i has 480 lines forming its screen. An HDTV
resolution is 720 and above—720p, 1080i, and
1080p—since an HDTV is widescreen and 16:9,
these numbers correspond to 1280 x 720 and
1920 x 1080 pixels. The “i” stands for “Interlaced,”
the “p” for “Progressive.” This is a way to denote
how a picture is painted on a TV screen. 

Interlaced TV sets, which most of our TV sets
are, divide a video image into odd and even lines
of dots. Each divided image forms a field, and
when the odd field and the even field are
combined, they form a complete frame. An inter-
laced TV draws each field every 1/60 of a second
to form an illusion of running 30 frames every
second. The illusion, however, isn’t perfect, and

almost everyone can perceive flicker on our stan-
dard TV sets. A progressive scan TV set takes both
the fields and combines them before displaying
on screen. It thus displays a complete frame
every 1/60 of a second—painting a complete
picture at once, to eliminate the flicker. Progres-
sive is almost always superior to interlaced.

Beware: some TV sets offer SDTV/EDTV reso-
lutions along with 1080i—these are not HD sets;
make sure your HDTV offers at least a 720p reso-
lution.

Almost all HD sets available in the market
today are 720p/1080i; 1080p sets are a newer
breed and are much costlier than a 720p set.
Generally, a 720p set can also do (or is advertised)
as 1080i as well.

So which one should you buy? For all practi-
cal purposes, a 720p set is good enough. All HD
content—movies, over-the-air TV content, or
games—is enjoyable on a 720p set. More is, of
course, better, but a 1080p set is not only signif-
icantly costlier, there is little HD content avail-
able in 1080p to best utilise the set. Subjectively,
for lower screen sizes or larger sitting distances
from the TV screen, it becomes very difficult to
qualitatively differentiate content on a 720p set
from that on a 1080p. Unless you are buying a
set larger than 50 inches, you need not concern
yourself with the lack of 1080p resolution.

Our usual cables need not apply to the new HD era: S-video,
SCART and composite cables are not suited for HDTV view-

ing. They simply do not have the required bandwidth, nor do
they offer the required digital fidelity. When you move on to
HDTV, you will have to deal with component, DVI and HDMI
cables. The latter two are digital in nature and are the ideal
course to take. A component cable will carry unprotected HD
content. Most of the high-definition content will be protected,
and to view this as intended, you will need HDMI ports on both
the source of content (unless it’s over-the-air) and on the TV
set. HDMI (High-Definition Multimedia Interface) is a pure digi-
tal cable that carries audio and video and is backward-compati-
ble with DVI-D—a DVI-D source can drive an HDMI unit through
a converter, but the audio will not be available. As for the
content protection: HDCP (High-Bandwidth Digital Content
Protection) is a form of DRM (digital rights management) that

controls content travelling along DVI-D and HDMI. High-defini-
tion video content is downgraded to DVD quality on non-HDCP
compliant TV sets, when requested by the source. DVD-Audio
content is restricted to DAT quality on non-HDCP digital audio
outputs (analogue audio outputs have no quality limits). Thus
you will need an HDTV with an HDMI port, a video source with
HDMI output, and an HDMI cable to experience real HD content.

HD-DVD and Blu-ray Disc players allow movie studios to set
an Image Constraint Token (ICT) flag that will only output full-
resolution HD content through HDCP. If such a player is
connected to a non-HDCP-enabled HDTV, and the content is
flagged, the player will output a 480p signal. The good news is
that most of the movies studios seem to have informally agreed
to not use this flag for the near future; additionally, none of the
HD games currently have any restrictions—they can be enjoyed
over both component and HDMI without niggles.

HDMI Demystified

HDTV: Looks good, feels great



37DIGIT JANUARY 2007

Digital Passion l Insight

Now that we’re clear on the basics of TV and
HDTV, let’s move on to the specifics of what
makes a High-Definition television.

One Big Family
The majority of HDTV sets, be they LCD,
plasma, rear-projection microdisplays, DLP, or
LCoS technology, are so-called fixed-pixel
displays. Such a display uses pixels to form

images. Non-fixed-pixel displays are direct-
view and rear-projection CRTs, and

they don’t use discrete pixels to
display images. Fixed-pixel HD

displays operate at a
“native” resolution, say
720p. They are also all
inherently progressive-
scan—even a 1080i “inter-
laced” HDTV set runs at a
720p “progressive” resolu-
tion. Since an HDTV only

talks in native resolution,
there is some scaling

involved with content: no
matter what the source of the

content, a fixed-pixel HDTV
will always scale it to fit to its

native resolution.
If the incoming signal has more pixels than

the TV can handle, you will lose some detail
and sharpness. If in turn the signal has fewer
pixels, the TV will scale it to fit its screen but
you won’t get any extra detail and sharpness
(this is called upscaling or upconverting). How
well the TV does at scaling is a critical point to
consider while purchasing an HDTV. 

Before making a purchase, we recommend
that you play various content on your desired
set—TV, DVD, HD video games, and if available,
HD movies.

What Flavour HDTV?
Wouldn’t it be great if you could just walk into
a store and pick up an HDTV, any HDTV, without
worrying about black levels, contrast ratio,
refresh rates, viewing angles, colour saturation,
colour accuracy and so on… of course it would,
but if you’re in the market for an HDTV, you
need to understand the pros and cons of each
HDTV technology.

Broadly speaking, there are two major cate-
gories of HDTV—you have your Flat Panel TV sets,
which are your thin plasmas and LCD panels.
Then you have your rear-projection sets which
can be LCD, DLP (Digital light Processing), CRT, or
LCoS (Liquid crystal on silicon). Apart from these,
you can also purchase an HD-resolution projec-
tor, or an old-fashioned CRT TV set. Let us run
through the major technologies first, and then
take a look at the table Which HDTV Should I Buy?

Flat Panel Displays
There is little to differentiate between a plasma
and an LCD display today—each one’s pro is
generally replicated well by the other. A plasma
screen is no longer as liable to suffer from burn-
in as it used to, while an LCD TV’s viewing angle
is much improved today than it was a year ago.
And so on. Generally speaking, a plasma televi-
sion is still a better choice if you are looking to
set up a home-theatre: these are large screens
with great image quality, high brightness, and
good contrast ratio. The only negative is screen
brightness: a plasma TV will gradually dim over
its life. Present plasmas are typically 60,000 hrs
of half-life—long enough to last five to six years,
but something to keep in mind while picking
one up. For gaming, both technologies have their
cons: an LCD screen is liable to “ghost” or blur
when the action gets fast (due to slower response
time); a game’s HUD (Head-up Display) is liable to

Which HDTV Should I Buy?

HDTV technology What’s great about it What sucks

Tube televisions (non-fixed-pixel
displays)

Inexpensive, wide viewing angle, great picture
quality (especially black levels)

Huge, extremely heavy, limited screen size,
lower resolution

Plasma television

LCD television

CRT

DLP (Digital Light
Processing)
LCD

LCoS

DLP

LCD
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Thin, wide viewing angle, image quality ideal for a
home theatre setup, faster response time than LCD,
brighter than LCD
Widest range of sizes available, no danger of burn-in,
higher resolution than comparably-sized plasmas,
generally cheaper than plasma 

Inexpensive, good black levels, good colour satura-
tion, sharp picture

Good pixel fill and uniformity; deep blacks in better
models
No rainbow effect, good colour reproduction, light-
weight, perfect sharpness at native resolution, excel-
lent longevity

No rainbow effect, true 1080p resolution (not wobu-
lated), excellent black levels, great interpixel fill
Better black level than LCD, good uniformity, good
brightness
Usually cheaper and more feature-packed than DLP
of same resolution

Slight potential for burn-in, more expensive
than LCD, display gradually dims over time
(loses brightness)
Image quality generally not as good as plasma
(poor blacks); relatively narrow viewing angle,
might show ghosting while displaying fast-
moving images like in games
Need professional calibration for ideal setup,
deep cabinets, not suited for bright rooms

Rainbow effect might be visible in some sets, low-
level noise, wobulated resolution on some TVs
1080p currently unavailable, black level lacking,
uniformity issues, not as bright as DLP, currently
no 1080p chips, poor contrast ratios, weak and
stuck pixels are common
Some uniformity issues

Rainbow effect, more expensive than LCD

Not as bright as DLP, might show screen-door
effect

HDMI to DVI-D adapter
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be burned-in to a plasma screen. Both these
display types are widely available in the market,
and unless you are a videophile, picking up
either of these technologies is a safe choice.

Rear-Projection TV
Microdisplays make up most rear-projection
units. A microdisplay is driven by one or more
microchips, which contain millions of pixels.
Based on the nature of the chip, a microdisplay
can be further classified as DLP, LCD, and LCoS.
Each such unit displays by either bouncing light
on to and off these chips (DLP and LCoS) or
streaming light through them (LCD). The light
source, being a lamp, must be replaced every
5,000 to 10,000 hours depending upon the tech-
nology and model (ask your local dealer for
details); the lamps might also require a few
seconds to warm up and cool down. Due to the
nature of the technology, all such TVs are excel-
lent for viewing in bright rooms. Let’s quickly
run through two of the most promising
microdisplay technologies:

DLP: The microchip is actually an array of
mirrors sitting on silicon, the number of
mirrors correspond to the resolution of the set.
These mirrors are rapidly repositioned to give
various shades of grey by varying the intensity
of light through a lens; black and white levels
are achieved by switching the mirror off and
on respectively. Colours are added by use of
either a colour wheel, or by employing Red,
Green, and Blue LEDs. A common complaint
about DLP sets is that of the “rainbow effect”—
this artefact is generally visible as a multi-
colour shimmer when changing focus from
one part of the projector screen to another,
generally at a viewer’s periphery when shifting
focus from a high contrast area or bright
object. The rainbow effect is mostly seen in
single-chip DLP projectors. Make sure you
check for this before buying a DLP set—people
are not equally sensitive to the effect.

Some DLP sets use a technique called “wobu-
lation” to double the actual resolution of a TV—
a 1080p chip might have 960x1080 physical
pixels. A mirror or lens is then made to move
rapidly to form a complete picture, from the two
halves of 960 pixels to give the 1920 x 1080
(1080p) finished picture. A wobulated image
might appear soft; results vary from set to set.

LCoS: This is a technology similar to DLP, but
uses liquid crystals instead of mirrors to reflect
light. LCoS is the technology to watch—it has the
potential to realise big-screen HDTVs with very
high picture quality and at a low cost compared

to the others. Pixels on LCOS panels can be made
smaller than is possible with other microdisplay
technologies, without compromising on picture
quality or manufacturability. LCoS displays can
be scaled to 1080p resolution and beyond, with-
out increasing the size and cost of the panel and
other optical components in the light engine.
Commercially, Sony’s SXRD is the most visible
and viable implementation of this technology in
the market.

Summing It Up
For most of us, the fog of uncertainty surround-
ing HDTV lifts when we consider price as a
factor. These big screens, sexy as they may be, are
priced beyond EMIs for the rest of us. And when
you look at HDTV through this lens of practical-
ity, the choice becomes clear—whatever is the
most affordable amongst this array of tech, and
the most ubiquitous. Right now, that choice is a
toss between Plasma and LCD sets. Too many
companies have invested too much money for LCD
to not have a slightly upper hand. LCD tech has
overcome most of its inherent disabilities, and TV
sets based on them are the cheapest money can
buy today. Plasmas do not fall far outside an LCD’s
price bracket, and generally do make for a better
home-theatre experience. But as far as the market
is concerned, LCD is ascendant—you are bound to
find a wide variety of prices and offers when shop-
ping for an LCD-based HDTV. 

Moreover, while some of the newer tech might
or might not last tomorrow’s dawn, LCD displays
are here to stay. We’d recommend you wait a
while before picking up an HD set—prices are
bound to fall further, and 1080p displays should
soon become more practical. By some major mira-
cle, we might even see some HD content in India.
But if you intend to walk that HD path this year,
let LCD be your guiding light. 

readersletters@jasubhai.com

Some HDTVs might not have an inbuilt tuner to
view over-the-air or broadcast HD content; these
are generally labelled as “HDTV-ready TV” and
must be connected to a separate HDTV set-top
box to view them. Note that they will have the
usual PAL/NTSC SDTV tuners.

What Is An “HDTV-Ready” TV?

Ideal Viewing Distance From An HDTV set
Screen size (inches)
30
34
42
50
56
62
70

Viewing distance (feet)
3.75 to 6.25
4.25 to 7
5.25 to 8.75
6.25 to 10.5
7 to 11.75
7.75 to 13
8.75 to 14.75

HDMI Cables



Digital Passion l Tomorrow

Vishal Kansagra

War is a sad reality: has been teh same
in the past and will continue to
remain so in future. It is anybody’s

conjecture what war will be like, say, five
decades from now. It will not involve the loss of
lives in direct combat: we would have passed
well beyond that stage. But what can it be
about? Will it be about the destruction of phys-
ical targets via what the Internet will be at that
time? Or will it be entirely cyber-warfare…
attacks solely on information systems?

Whatever the case, the fact is that technol-
ogy has decisively entered the battlefield, just
as it has entered the sports arena. It makes it
less fun and more serious business, but war is
fun only when you’re watching a movie!

Here, then, are some things that have
happened in recent years, which point to the
inexorable rush of technology into combat of
all sorts. We focus on the communications and
networking aspect, because that’s where it’s
happening most. We have good reason to
believe that what’s happening today is indica-
tive of what will be tomorrow.

The Networked Soldier
In the US Army’s vision called the Future
Combat System, networks will acquire the
capability of being set up on the fly to adapt to
the progress of a battle.

Peter Marcotullio, director of development

at SRI International, the research centre work-
ing with the DoD (the US Department of
Defense) on ad hoc network development, says,
“Each person is a network with routing capa-
bility to everyone else. Think of cascading
networks, all IP-based, that are dynamic and
self-configured as the troops advance.”

Sensors, commanders and soldiers will all
be linked to a dynamic network that will adapt
to the situation and satisfy the information
demands of the battlefield. This vision is not
far from being realised. By the end of this
decade, major armed forces across the globe
will have sensors and communication gear that
will make such connectivity possible.

In addition to conventional weapons, the
soldier of the future will have the necessary
equipment to make him a network-enabled
“smart warrior.” Using his helmet-mounted
drop-down eyepiece, he will see a virtual, GPS-
linked display showing his current location and
that of friendly and hostile units in the area.
He will be able to switch the display to watch
live video feeds from UAVs (Unmanned Aerial
Vehicles) coming via a secure data link. His
rifle-mounted TWS (Thermal Weapon Sight)
will not only help him identify enemy positions
in the dark, but also pass on the same infor-
mation to allied units on the network.

A soldier is just a part of a platoon or
company of similarly-equipped soldiers. The
soldier utilises data fed in by sensors like UAVs,
aircraft, satellites, and other sensors to iden-
tify important targets and detect potential

Technology is
enabling the
movement of
warfare from a
blood-drenched
killing affair to
something more
precisely-
targeted and yet
more powerful

Battle For Tomorrow

Imaging Pradip Ingale
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traps or hostile units. He won’t fire unless
absolutely necessary, rather relying on combat
robots or UCAVs (Unmanned Combat Aerial
Vehicles) to do the job. Once the target has
been identified, the soldier will deploy robots
or UCAVs to destroy it.

The individual soldier thus becomes a
powerful component of a huge grid, much
more powerful than the soldier of today, but
also with his safety ensured.

Network-Centric Warfare
August 17, 2016: A pilot flying a fighter jet on
a routine patrol spots a group of intruders
trying to sneak in through the border. He
immediately updates their coordinates on a
digital map on his aircraft computer. That
done, the information is updated in real-time
to army units in the vicinity.

Moving in to intercept the intruders, they
get a constant video feed from the aircraft,
so they have all they need to know—how
many of them there are, what are they
currently doing, which way they’re going.
Using this information, the unit chooses the
best spot to ambush the trouble-makers.
Ambush and capture them they do, without a
single casualty.

The scenario above is a classic one, where
the ability to conduct Network-Centric Warfare
(NCW) not only increases the efficiency of a
unit, it also minimises the loss of men and
materiel (equipment).

The term “Network-Centric Warfare” is the
latest buzzword in military circles; it is the
transition of military forces from the industrial
age—where better equipment was the key to
success—to the information age, where having
the latest information is the key. The idea is to
provide real-time, accurate information avail-
able to all friendly forces so as to make fast,
effective, better-informed decisions.

The All-Important Network
We live in a networked world, be it the cell
phone network or the Internet. It was only
a matter of time before the network entered
the battlefield.

Visualise a huge network of computers with
three key components:

Sensors: These include objects that gener-
ate useful information (such as pictures or
radar images). The objects can include satellites
that provide images of a particular area,
Unmanned Aerial Vehicles (UAVs) that generate
real-time images of an area, and so forth.

Commanders: Military commanders get a
broad view of what’s going on by collating the
information sent by the sensors. They make
decisions depending on the situation.

Shooters: Troops on the battlefront that do
the actual shooting. It could be a squad of
soldiers, robots, tanks, aircraft, or even a single
ship. These are guided by the commanders to
perform set actions.

These components are analogous to hubs on
the network, and the computers are like the
nodes. All the computers can access the infor-
mation flowing around the network. This
network relies on a high-bandwidth link using
optical fibre or satellite links.

Such networks have to be much more secure
than your regular SSL-encrypted connections,
due to the highly sensitive nature of the infor-
mation being transmitted. As a standard proce-
dure, the networks have multiple redundant
links, so in the eventuality of war, even if one
link is damaged, the network can rely on the
others without affecting operations.

In Conventional Warfare
In a more conventional setup, communication
happens via radio. Radio communication can
not only be intercepted by the enemy, it is also

Network-Centric
Warfare not only
increases the
efficiency of a
unit, it also
minimises the
loss of men and
equipment
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dependant on ambient geography. Moreover, a
commander receiving information from vari-
ous sources has to collate that information and
make a mental picture of the situation. There
may sometimes be conflicting information.
Many a time, it so happens that a commander
doesn’t have the precise location of friendly or
enemy troops. Ambiguous states such as these
can hamper decision-making. In such situa-
tions, a commander has to rely on experience
and gut-feeling. It’s sometimes a bit like
gambling. With lives.

Taking an example of air combat, radars are
a must for any fighter aircraft. But there are
drawbacks associated with the use of radar.
First, fighter aircrafts have a very small radar
range compared to ground-based radars.
Second, switching on your radar gives away
your position to the enemy. So during most air
combat scenarios, fighters keep their radars
off, being guided by ground-based radars or
AWACS (Airborne Warning and Control
Systems): these are aircraft with huge radars of
extremely long ranges mounted on them. In
addition to pilots, AWACS have controllers who
have the details about all
aircraft within their radar
cover. These controllers
can inform friendly pilots
about enemy movement
and help them plan their
tactics.

Now, in this conven-
tional scenario, a radar
operator or an AWACS
controller uses radio to
communicate with the
pilots. The pilots have to
create a mental picture of
their position relative to
the enemy aircraft and
plan their approach. Air
combat is highly dynamic
due to the high speeds
involved, and it takes time
for a pilot to create a
mental picture. If, during
this time, the enemy
aircraft make a sudden
change in their path, the
radar operator will need to
update the pilots about it.
The pilot will need to scrap
his earlier idea and start from scratch. 

In NCW, secure data links on the aircraft
and ground station would be installed, and
they would be linked via satellite. In this case,
the radar operator can share visuals in real-
time. Instead of creating a mental picture,
pilots will have an exact idea of enemy loca-
tions, and can plan their approach quicker to
gain the upper hand.

Iridium
Remember Iridium? The satellite phone serv-
ice? It boasted of global coverage provided by a
“constellation” of 77 satellites, with only 66
having been commissioned. During the recent
Iraq conflict, US and UK forces made good use

of Iridium not only to increase combat effi-
ciency but also to boost morale. The US forces
transmitted voice and data for tactical
purposes using the service, while the British
military let soldiers talk to their families. Both
militaries also used commercial GSM networks
during the conflict—and are still using it. They
use the Sectéra Secure Wireless Phone, which
includes a clip-in security module that uses
cryptographic algorithms to ensure secure
communication.

These are just two instances of commercial
setups being used in warfare—and we’re likely
to see more of this. Like the use of RFID tags to
track men and materials. Like the use of smart
cards, using which a soldier would have access
to his assigned weapons, and by which an
injured soldier’s medical records would be
instantly accessible.

Talking To Each Other
Operation Red Dawn to capture Saddam
Hussein saw an integration of lots of new tech-
nologies. Thanks to the integrated system, intel-
ligence reports were analysed and forces

prepared within a few
hours. Looking at how
tense and time-bound this
decision was, an
extremely short time
from tip-off to capture
was no small matter.

Each component
involved in this integrated
system was not exemplary
on its own, and had
existed for quite some
time. US forces have been
using UAVs and satellites
to gather information for
quite some time now. But
this time, all the data was
communicated in real
time. It was sent to the
US, front line units, and
to the commanders who
made the decisions.

Says John Hillen,
senior Vice President and
Director of the defense
and intelligence group at
American Management
Systems (AMS), an IT

consultancy in Virginia, “There were a lot of
new technologies out there, but none of them
was particularly dramatic. It was the stitching
together of all of these things in real-time and
their integration into the operation.”

As recently as in the first Gulf War, air
commanders had to print hundreds of pages of
“air tasking orders” to be sent out to various air
units. These printouts would then be sent to
airbases or aircraft carriers, where they were
further sorted out to be given to pilots to
inform them about their tasks.  In the second
Gulf war, IT had already “invaded” the battle-
field. A single Humvee became a mobile data
centre. Intelligence updates provided by vari-
ous sensors were fed into a Unix-based work-

In the Future
Combat System,
each person is a
network with rout-
ing capability to
everyone else”
Peter Marcotullio
Director of Development
SRI International

Communication Grids
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station at the back of the Humvee. As many as
20 different interfaces were made available to
enter data generated by various sensors and
systems, like radar from JSTARS (Joint Surveil-
lance Target Attack Radar System) reconnais-
sance aircraft and video from UAVs.

The system automatically collated all the
data on a single electronic map to give
commanders a bigger, more accurate and near-
real-time picture of the entire battlefield. In its
latest avatar, this system uses a Web service
architecture to provide near-real information
on demand to decision makers in the US,
Europe, and the Middle East. This service uses
the US military’s restricted network called SIPR-
NET (Secret Internet Protocol Router Network).

A communications system that speaks for
the power of “simple” commercial technology
is a wearable computer/radio called the TM-7.

It uses an 800 MHz Transmeta Crusoe
processor and 256 MB of RAM. Weighing just 5
kg, the device provides mapping, GPS, and
communications. With the help of a USB
joystick and a helmet-mounted VGA display,
soldiers can use TM-7s to control robots—send-
ing them into buildings and caves, avoiding
risk to human lives.

Bots And Nanobots
Talking about robots in combat, such a bot—
the PackBot—was actually deployed in Iraq and
Afghanistan. It entered caves, scouting around
and reporting to human operators using wear-
able computers. In the future, its role could
accommodate combat duties: such robots
could be loaded with explosives to blow up
locations not accessible to soldiers.

Thanks to its 802.11b connection, the Pack-
Bot can also be operated over the Internet,
allowing for remote operations.

Another DARPA (Defense Advanced Research
Projects Agency) funded project, dubbed the
High Mobility Tactical Microrobot (HMTM), is in
the works. Weighing just 5 pounds, it is being
designed for surveillance and reconnaissance.
The HMTM has a camera on top of a periscope
to look around corners, in addition to an
inbuilt homing device that will work even if its
802.11b connection breaks.

We’ve spoken of Smart Dust earlier in this
space; how can it help reduce casualties, which
was a primary goal during the Iraq war? The
central idea, of course, was to replace people
with machines that could gather intelligence.
In Iraq, the US military used smart robots and
small UAVs to reduce danger to personnel.
Another DARPA-supported technology, called
Smart Dust, could possibly reduce casualties
and gather information even more effectively.

Smart Dust is an “autonomous sensing and
communications device in a cubic millimetre”
package. A millimetre has not yet been
achieved, but the goal is to package a light
sensor, power supply and circuitry, a commu-
nication device, and a programmable processor
into a small space.

Assuming we have it, imagine a plane
“spraying” Smart Dust over a conflict area. The
specks would be light enough to stay afloat and

monitor the movement of enemy troops, or
perhaps the presence of biological or chemical
weapons. It’s not all that futuristic: in a recent
test, a Smart Dust researcher controlled a drone
about 8 inches long. It flew at 100 kmph for 18
minutes, carrying a camera that sent live feeds
back to headquarters!

In Conclusion
Advanced though the above scenarios and tech-
nologies may sound, we think they’re baby
steps into the future of something that will not
be called warfare any more. “Warfare” assumes
that one is not omniscient; that, like in a game
of chess, one needs to outwit the opponent.
What happens when sensors and tracking capa-
bilities and number crunching becomes so
advanced that everything is known? Surrender
and victory would both be immediate—
removed only a short span of time from the
declaration of the conflict. All the activity
happens in preparation.

It’s analogous to a grandmaster resigning
twenty moves into the game once he knows he’s
made a wrong move—while amateur chess play-
ers, like the forces of today, knowing little
about the broad picture, take the game into the
hundredth move and more. It’s about getting
smarter—and technology is enabling that. As it
is everything else. 

vishal_kansagra@thinkdigit.com
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Day 1
The MPL 1003 is compact, with a surprising amount offunctionality accessible through just the six buttonsadorning it. One observation—except for the menu button,the others are super-hard to press. 

Day 2
I notice what seems to be a dead pixel on the left corner ofthe screen. Funny—a few hours later it wasn’t there. Thoughthe LCD is small, it’s surprisingly crisp. It did take sometime to copy a few MP3s and photos to the player—20 to 30per cent slower than a Flash drive the same size. The factthat the player stores all files, movies, still, or music in thesame root folder is convenient, though browsing through thefolder can be a pain.

Day 3
Mitashi states in the manual that the player can onlybrowse JPEG files. This statement had me stumped—because the player not only displays BMP images as well,the treatment of both (JPEG and non-JPEG) images is thesame. I took the time to read through the entire usermanual at last. Lots of ambiguity, and certain parts werereally hard to follow. 

Day 8
Copied some more MP3s to the MPL 1003 and actuallyplayed them this time! Sound quality is decent, butthe player seems to have some inherentbackground noise that’s noticeable ifyou listen carefully,

particularly at the
higher

volumes. Incidentally, dB levels are more than satisfactorywith the bundled headphones. I viewed a couple of dozenphotos—respectable, but this is no photo iPod! 
Day 15
Finally got down to using the inbuilt voice recorder. It workswell, and the 1 GB of inbuilt memory provides amplerecording space. Playback quality of the recorded content isgood, but once again, it’s not to be compared with adedicated recorder.  

Day 21
Upgraded the firmware. It’s easily accomplished, really. Theinterface is very easy to work with, unlike so many othermultimedia players around. This is an important and oft-missed feature. Battery life isn’t too good… around fivehours under regular use. The bundled 2-pin power adapterto USB accessory is useful if you need to charge the playerwithout a USB port handy. 

Day 25
A few friends come over. The ladies went “oh…how cute, it’sso small,” the guys went “YOU went in for a portableplayer? What’s up with that?” They played around with thedevice. Reactions ranged from “video quality isn’t good”and “MP3s are decent,” to “look, it’s got FM and a voicerecorder too” and “slim… looks hot actually!”

Day 30
Well that was that. I dutifully returned the player to myeditor. He threw an enquiring look at me. I shook myhead. A decent product simply for the great value itbrings via the features integrated, but ultimately, it’s ajack-of-all-trades thing. I’ll look elsewhere for my acoustickicks, thank you very much!   

michael_browne@thinkdigit.com

Michael Browne
Now I’m a bloke who loves his music. Admittedly, I haven’t been a big fan of portable music, simply because I don’t think any player can

substitute for the aural experience a set of Sennheisers will provide. Well, my editor decided to cure me of my scepticism, getting me into

what he calls the “portable entertainment” experience. Needless to say, it was up to the MPL 1003 to mend my ways…

Mitashi MPL 1003

Imaging Sivalal S 
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Flybook VM
he innovative design of the Flybook VM is a far
cry from the monotony of “regular” ones. It has
a tilting screen you can pull towards you while

working, and push away to enjoy a movie. Because the
screen can lift up, you won’t need to strain your neck
when working with the laptop at a table—you can adopt
a more natural posture.

The screen is a wide 12.1-inch, and the device sports
a reasonably good configuration for its size: powered
by Intel’s energy-efficient Core Duo processor, it allows
up to 2 GB of RAM. Price? A little more than Rs 2 lakh.
It’s all about design and ergonomics!
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his GPS receiver is not from the Ferrari stables,
but Ferrari does endorse it. To give you that
Ferrari feel, the pop-up that’s displayed at

startup is an exact reproduction of a Ferrari F430’s
tachometer. The device, which doubles up as an
MP3/WMA player, has a 4-inch touch-screen with anti
glare coating. Powered by a fast 400 MHz processor, it
supports 2 GB of memory on an SD card. There’s a USB
port for PC connectivity. The menu features spoken
instructions, and it can even be operated by voice! 

Becker Traffic Assist Pro Ferrari

Drool Maal

T
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eitz has outdone everything in its class with its mind-
numbing 160-megapixel 6x17 digital camera. (Sorry, we
got that wrong: there’s nothing else in its class!) You got

that right—one hundred and sixty
MP. Couple that with 48-bit colour
depth, and you get images of defi-
nitions we can’t speak about. 
At the maximum resolution, an
image is 900 MB, and you can’t
use Flash to store several such—
so the 6x17 uses a Mac Mini as 
its storage device. You can control
the camera remotely using a PDA.
Go ahead, prove you’re a real
photography enthusiast: sell 
your house and buy the 6x17 for
Rs 27 lakh!

Seitz 6x17

Hela Glider Mouse
he Hela Glider Mouse looks and works like an
air hockey board. As you can see from the
picture alongside, the Glider Mouse sits between

you and the keyboard, and the actual mouse is at the
centre, giving you good control. And how much comfort
can you not expect from an extended gel-filled wrist-
pad? With shiny things you see are customisable
buttons. Pair those with the scroll wheel, and you have
the ultimate in navigation comfort—without having to
take your hands off the keyboard and reach out every
time you need to use the mouse.

Alienware Aurora mALX
his beast packs in everything a gamer can hope for
—for now. It bequeaths upon you immense brag-
ging rights over lesser mortals. Just going through

the specs is enough to make most hardware freaks bow in
reverence.

Powered by nothing less than an AMD Turion 64 @ 2.4
GHz, this monster is loaded with 2 GB of RAM and 400 GB
of storage space. For a totally immersive experience, you
get HD, surround audio. The coolest thing here is two
GeForce Go 7900 GTX  with 512 MB RAM each in SLI for that
top-of-the-world gaming experience on a 19-inch screen.
Rs 5 lakh - too much? You decide…

T

T

S
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Take a Crack 
and win

Google Analytics
by Mary E. Tyler and
Jerri L. Ledford

Published by 

Rules and Regulations
Readers are requested to

send in their answers by the 15th

of the month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

Last month’s solution
Our challenge last month was to create a
Windows XP installation CD that requires
no driver installation.

1. Download and install Windows
Unattended CD Creator from
www.windows-unattended.de, or
install it from the Digit December
2006 Utilities CD.

2. Launch the program and insert your
Windows XP CD into the drive.

3. Copy all the contents of the CD. Eject
the CD after copying the files.

4. In the program’s first tab—”Source CD”—
click Select, and select the folder to
which you copied the CD’s contents.

5. Select “Work in source directory”
under the “Target directory for new
CD” column.

6. Bypass all other options and head to
the Driver tab.

7. Insert the driver CD that came with
your motherboard.

8. Give a name to the driver group in
the General Drivers text box, for
example, “Gigabyte”. Click Add.

9. Wait until all the drivers get copied. It
should look something like the
screenshot below. (The name you gave
will appear along with its attributes).

10. Head straight to the Done tab,
making no changes.

11. Click Save and then on “Create ISO-
image”. Enter the path of where the
image should be written to.

12. After completion, burn the ISO
image to a CD using a disc burning
tool such as Nero. You’re done! 

THIS MONTH’S CHALLENGE

LAST MONTH’S CHALLENGE

Win!

Santhosh S 
Nagasandra Post

Bangalore

LAST MONTH’S WINNER

How would you reboot
your computer into Safe
Mode from the Start
Menu?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Create an XP CD that requires no driver installation!

DIGIT JANUARY 2007

Add “Reboot Into
Safe Mode” To Your
Start Menu

The source CD tab in Windows Unattended CD Creator

Finalise the CD compilation

Select the drivers you want



Robert Sovereign Smith

Remember the days when using a computer
meant just having one browser window,
one mail client and maybe an office appli-

cation? I know a lot of us found just those three
windows intimidating at times. Today, however,
whether it’s at work or at home, we’ve got so
many things happening at once that it’s hard to
keep track of everything that’s open on your
Desktop. No, don’t worry, we’re not going to be
preaching about silly taskbar applications or
telling you how to [Alt] + [Tab] better… instead,
we wonder why the majority of the computer
users in the world stick to just one screen!

Why?
In the heyday of the good old CRT, where the
average monitor was a 15-inch monstrosity that

weighed as much as you and occupied most of
your desk space, this question would seem stupid.
However, the LCDs rule the roost today, and with
the amount of multi-tasking expected from all of
us, the whole “lack of desk space” argument falls
flat—pardon the pun! Televisions aren’t cool
unless they’re LCD/Plasma gizmos, and a com-
puter monitor also just has to be an LCD today. So
why buy one when you can get two? Sure… that
is, if your daddy has a multi-crore business and
loves splurging on your whims! For the rest of us
unfortunate souls, when we think two monitors,
it’s usually our spanking new LCD and the
antique CRT that’s now collecting dust. Regard-
less, if you have more than one monitor, you
should be using them all!

There are quite a few ways in which you can
put multiple (two or more) monitors to good
use, but before we get to where this can be
useful, let’s look at…

Why waste your time minimizing windows and searching through all those apps on your taskbar?
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How?
Laptops! Everyone seems to be buying one, or
being given one by the company. Well, most newer
models have support for an external monitor as
well as its own LCD screen. Just look for a VGA-out
on your laptop. If it’s got one, you can just hook up
another monitor (CRT or otherwise) and start
using multiple desktops. This is usually provided
for people who need to give presentations, so that
they can hook up to a projector, and is a standard
feature on any business laptop.

What if you are a desktop user? Well, a few
of us have dual graphics cards, for gaming. Most
of them will either be NVIDIA or ATI solutions,
and these will allow you to hook up at least a
monitor to each card. Those with just one
graphics card will need to look for two DVI or
VGA outputs on the card to know whether the
card supports two monitors. 

If your card has only one monitor output, but
your motherboard has onboard graphics, you
may still be able to use two monitors. The rule is
generally that the onboard and GPU chipset
manufacturer should be the same. So an
onboard ATI solution will work with an ATI
graphics card; ditto for NVIDIA.

For those whose hardware does not meet the
above hardware criteria, the only option is to use
one of the many hardware or software solutions
we have listed a little later.

Apart from this, you obviously need two or
more monitors. Though the ideal setup is to
have two identical monitors—so that you never
have to deal with colour or brightness changes
when looking from one to the other—any two
monitors can be used.

A good way to find out whether your display
adapter supports more than one monitor is to go
to the Display Properties (right-click on the
Desktop and select Properties). Here, under the
Settings tab, if you see icons for two monitors, or
can see more than one monitor in the Display
dropdown, you already have a dual-monitor
capable display adapter. Just plug both monitors
in and the display adapter should recognize them
both. You can also connect your TV up to your
computer if the adapter has an RF output. Though
standard TVs are terrible for displaying things
such as office applications, Web pages, or basi-
cally anything involving text, they’re perfectly
capable of displaying video.

Whatever the case, just make sure you
select the “Extend my Windows desktop onto
this monitor” checkbox so that you can use
both monitors together.

What Good Is This?
Whether you’re using two monitors or one TV and
one monitor, chances are you can relate to one of
the usage scenarios below:

For those who need to work with MS Excel, and
have to keep referring back and forth between
two or more spreadsheets.
When using Explorer to search through
drives and find and move files from one
drive to another.
Using any two related applications, such as an
HTML editor and a browser, to make changes
and check the changes you’ve made.
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Viewing video while working on an applica-
tion—when a single computer has to cater to
multiple users, one can watch a movie while
the other works.
The last one is especially useful when the kids

want to watch that cartoon Digit provided in the
DVD, while you need to work on that project that
the boss wants first thing in the morning!

Other Options
For those of you who wouldn’t mind spending
a little money to get the most out of your
multi-monitor setup, there are quite a few
hardware and software options that can enrich
your multi-monitor experience. Let’s take a
look at a few examples:

Ultramon (www.realtimesoft.com/ultramon)
This is a utility that will help you use your multi-
monitor setup better. It features support for
more than 10 monitors, adds a “move to
desktop” icon to all windows, extends the
Taskbar to all monitors, so that only the appli-
cations displayed on a particular monitor show
up in the Taskbar of that monitor… etc. It will
even break your windows wallpaper over the dis-
plays, allows you to mirror the display instead of
extending the desktop (ideal for presentations),
and even run different screensavers on each
monitor. At $39.95 (Rs 1,800), it’s not very expen-
sive for professionals or serious home users. 

MaxiVista (www.maxivista.com)
This is a software solution that is best suited for
those with a desktop and a laptop. It adds a vir-
tual display adapter that sends display informa-
tion over the LAN to another computer to display
the first’s desktop. Basically, you can display your
desktop’s display on the laptop over the LAN, or
even extend the desktop so that only certain win-
dows get displayed on the laptop. Whether it’s
wireless or wired LAN, you won’t notice the dif-
ference because MaxiVista monitors the LAN
speeds and adjusts the optimal colour depth of
the second desktop.

MouseJail (www.dr-hoiby.com/MouseJail) 
When you have a multi-monitor setup, the most
common problem happens when gaming. Some
games just don’t lock the mouse to the screen
that the game is displayed on. So what happens
is that you move your mouse during the game
and it ends up on your extended desktop,
pausing or exiting the game. You can start games
that have this problem using MouseJail—your
mouse will be locked to the screen that contains
the game. It’s freeware, so enjoy!

Monitors
For those of us with a bank balance, settling
for old monitors might not be the perfect
answer to our troubles. There are quite a few
display solutions available out there, and we’ll
list out a few to help you get started finding
the perfect one.

9X Media (www.9xmedia.com): Take a look at
their X-Top series with anywhere from two to 30
LCDs placed together.
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WORKSHOP

Digital Tigers (www.digitaltigers.com): These
guys boast of clients such as NASA, Microsoft,
and Dell, and offer “affordable prices” for their
screens. A triple display 21-inch will set you back
by a mere $2499 (Rs 1,13,000)!

Custom Trading Computers (www.custom-
tradingcomputers.com): Their ClearView
series are designed for stock traders, so that they
can view multiple feeds at once.

As you’ve seen in the workshop above, setting
it all up is really easy. Now you can sit back and
enjoy the extra desktop space, but a word of cau-

tion: we learnt the hard way that it’s very hard
to get back to using just a single monitor… this
writer found himself looking to the right (where
the extended desktop was) into a blank space,
and moving the mouse pointlessly to the right
every time he sat on another computer! It’s
addictive, and once you get the hang of using
multiple monitors (which is about an hour at
most), you will find your productivity soar.

So if you’re used to working on several appli-
cations simultaneously, you just have to give this a
try! Let us know how it goes! 

robert_smith@thinkdigit.com

First, connect the monitors to the VGA/DVI outputs. In our case we
had an ATI onboard working with a ATI Radeon 1900XT

For ATI graphics, you need to enable their SurroundView option from
the BIOS. The procedure is similar for NVIDIA solutions

The BIOS and Startup screens are displayed on the two monitors
connected to the GPU. The onboard is enabled after Windows starts

Here’s how you will be able to work on Adobe Photoshop on one screen,
have the toolbars on another and leave the third for other activities

Flash designers will find this setup a gift from god! You can move the
timeline to one monitor, design in one and code in another

For better control, you can use Ultramon. This will give you their
Smart Taskbar, which gives you better control over your monitors 
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NVIDIA’s holiday-season
gift to Intel’s latest

breed of processors, the 680i
sports small (meaning better)
chipset-cooling heatsinks
which share a single
heatpipe. The inclusion of a
hex POST debugger is
appreciated, as is the huge
gap between the two x16 PCI-
Express slots (no more issues
with dual-slot coolers).

The 680i sports a new
BIOS aimed at the hardcore
enthusiast. Voltages from
CPU to memory to even the
Northbridge and
Southbridge can be
tweaked, ensuring minimal

bottlenecks while
overclocking. 

LinkBoost—an NVIDIA
trademark—automatically
overclocks the individual
PCI-Express lanes when you
SLI with any of the 8 series
cards or 7900GTX cards. 

There’s a couple of
Gigabit LAN ports sporting
something called DualNet
technology. These ports can
actually be clubbed together
for twice the theoretical
throughput, while the
TCP/IP acceleration engine
aboard each LAN controller
reduces CPU utilisation. 

nTune has also been
reworked, and now allows
changing most BIOS options
from Windows itself. This
can be a huge advantage for
overclockers who are in an
all-fired hurry, though the
hardcore will still want to

fine-tune the neatly laid-out
BIOS.

We managed to get our
QX 6700 (Core 2 Quad, 2.66
GHz default) to 3.45 GHz at a
multiplier of 13 (default 10),
without any tweaking…
simply awesome! Super Pi
1M calculations took 14
seconds at this speed, and 18
seconds at stock. 

For the enthusiast who
wants performance at stock
and stability under
overclocking, the 680i makes
for a very a potent package.
It’s future-proof, and a rock-
solid overclocker as well. If
you want the best platform
for your new Core 2 Duo or

Core 2 Quad processor, you
can’t go wrong here.

Specifications
Intel Socket 775; 1333 MHz FSB;
2x16 SLi; third PCIe Graphics
Expansion Slot; supports DDR2
800 MHz (SLI-Ready memory
with EPP: 1200 MHz); 46 PCIe
lanes and 9 links; 6xSATA II;
2xPATA; RAID: 0,1,0+1,5; Dual
Gigabit Ethernet; 10xUSB 2.0;
5xPCI; HAD (Azalia) audio           

We test the latest hardware 
and software products available 
in the market

Performance  
Features
Build Quality
Overall 

RATINGS

Contact: NVIDIA Corporation
Web site: www.nvidia.com

BazaarBazaar

Weighing just 1.3
kg and with its

small dimensions,
this notebook puts the
“ultra” in “portable”!
The performance may
not be jaw-dropping,
but good enough for
most users. Connectivity
options include Wi-Fi and
Bluetooth apart from the
usual LAN (10/100 Mbps) and
modem ports. There’s also a
fingerprint identification
sensor. The battery will last a
cool seven hours under
normal use.

At the price, however,
we’d suggest you wait for a

version that
sports the
Intel Core 2
processor.

Specifications
Intel Pentium M 753

(1.2 GHz); 915 GMS with 128 MB
shared onboard; 10.6-inch
widescreen; 512 MB; 60 GB
(4200 rpm); DVD ±R/RW; Wi-Fi;
Bluetooth v1.2; 3 USB ports;
FireWire; SPDIF, VGA, TV-out;
RJ-45 and RJ-11

The Canon LBP-3500 laser
printer is meant for

medium- to large-sized
workgroups. It supports a
range of paper sizes—A3,
Legal, A4, and more. It
connects via USB, and
there’s also an Ethernet
port to connect to a
network. The maximum
resolution is 1200 x 600
dpi, it can hold 350 sheets
of paper, and build quality
is rugged.

The warm-up times of
laser printers are
progressively decreasing,
but the LBP-3500’s warm-up
time of just 10 seconds is 

quite commendable. A text
document at the Draft
setting was printed in 2.8
seconds. The print quality is
good even at the Draft
setting. Overall a very good
printer suited for really
heavy printing, but the
price tag of Rs 64,000 seems
a bit too steep.

Specifications
Paper support up to A3 size,
network support, 1200 x 600
dpi maximum resolution

Canon LBP-3500  
A Reliable Workhorse

Performance
Features
Build quality
Value for money
Overall

RATINGS

Contact: Fujitsu India Ltd
Phone: 011-65475887
E-mail: rakshit.thussu@fujitsu-
india.com
Web site: www.fujitsu.com
Price: Rs 1,16,000 + taxes

Performance
Features
Build quality
Value for money
Overall

RATINGS

Contact: Canon India Ltd
Phone: 0124-4160000
E-mail: info@canon.co.in
Web site: www.canon.co.in
Price: Rs 64,995

NVIDIA nForce 680i 
The Hyper-Performance Platform!

Fujitsu LifeBook P7120  
A True Ultra-Portable



The 900 HMV are full
ear-cup USB-based

headphones that use
the C-Media CMI108
chipset. Yes, that’s
right—you don’t need
a sound card or even
onboard sound to use
these headphones!
And best of all, they’re
plug-n-play, though you’ll
need drivers to configure the
inbuilt 5.1 surround sound
capabilities.

Though these cans look
heavy, they’re pretty light
without sacrificing on
build quality. 

It was a pleasant surprise
to note that sound quality is
really good: well-produced,
deep bass, and the vocals
crisp and distinguished—just
the way we like our music!
The extreme highs are
slightly weak, but you will
rarely feel the loss under
most usage scenarios.

Sadly, the headphones
are rather uncomfortable
for long music sessions,
and after around three

hours of use, we found our
ears complaining. Though
the vibration feature is
little more than a
gimmick—enabling it gives
an impression of bass boost
via vibrations—it isn’t
uncomfortable to have a
ear massage while
listening to music, but this
does get irritating after a

while. The only scenario
where the vibration could
add to the immersive
experience is while
gaming. The Xear3D
surround engine has been

incorporated for this
very purpose.

Volume levels are
really high, and

you’ll rarely
need to go

anywhere
beyond 50 per

cent of what these
cans are capable
of belting out.
Just as well, since
you’ll encounter

distortion beyond
85 per cent of the max
volume level—this is rather
normal for most
headphones.

Specifications
USB Interface, integrated C-
Media CMI108 chipset, 5.1
Xear3D surround sound,
vibration mode.
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The newest Seagate
Pushbutton Backup class

of drives boasts a gigantic
750 GB capacity.
Construction is rugged, and
it comes with a stand to
keep it in the upright
position. When stacked
horizontally one above the
other, each drive locks with
the one above and below it.
In addition to the USB 2.0
port, the drive has two
FireWire ports, so you can
connect multiple drives in a
daisy-chain.

The drive disappoints
somewhat on the
performance front: read
speed is as expected, but
the write speed was a bit
slow. The bundled software

includes data backup
software, in conjunction
with which the drive’s
push-button conve-niently
backs up data. The bundled
DiscWizard adequately
performs drive
maintenance functions.

The drive is priced too
steep right now—if you need
an external backup solution,
you’d be well-advised to wait
a couple of months.

Specifications
750 GB; 7200 rpm; 16 MB
buffer;  dimen-sions: 180 x 165
x 58 mm; weight: 1.27 kg; USB
2.0, FireWire400

Contact: Seagate Technologies
Phone: 044-42243353

E-mail: ramprasad.md@ 
redington.co.in
Web site: www.seagate.com
Price: Rs 25,500

Seagate Pushbutton Backup 750 GB 
The Backup Behemoth

Contact: Top Notch Infotronix (I)
Pvt Ltd
Phone: 044-26616202
E-mail: zebronics@zebronics.com
Web site: www.zebronics.com
Price: Rs 1,800

RATINGS

RATINGS

Performance
Features
Ease of use
Value for money
Overall 

Zebronics ZEB-9000 HMV   
Vibrating cans!

Performance
Features
Build Quality
Value for money
Overall 

“Sleek, elegant, and
executive” is what comes

to mind when one first looks
at the new Nokia E50. The
phone has a nice, sturdy feel to
it. The display is stunningly
clear. The keypad has slightly
bevelled keys, but feel
cramped. The joystick provides
good feedback.

Oriented towards business
users, the E50 comes with

support for most mail
protocols, and setting up an
account is simple. PIM
functions are also available,
and synchronise with MS
Outlook. There’s a 1.3 MP
camera, a decent MP3 player,
and 70 MB of onboard memory,
with support for a microSD
memory card (not included).

At a street price of Rs
13,000, the E50 is a great buy if
you are looking for an elegant,
executive-class phone.

Specifications
Weight: 104 gm; screen: 262K
colour, 320 x 240 TFT

Nokia E50

Contact: Nokia
Phone: 0124-5199000
Web site: www.nokia.com
Price: Rs 15,539

Performance
Features
Build Quality
Value for money
Overall 

RATINGS



56

Digital Tools l Bazaar

The new iPod throws in
an ultra-roomy 80 GB

hard disk. Apple hasn’t
changed the look of the
new model, but the display
is slightly brighter, making
it more legible outdoors.
The bundle includes a USB
connector-and-charger, a
slick suede protective case,
and tiny, comfortable ear-
bud type phones.

Sound quality is good,
but the bundled ear-buds
lack punch—other
headphones gave better
results. The new iPod also
makes for a great photo
viewer, but the lack of
zoom, pan, and rotate
abilities is sorely missed.
Video playback is quite
smooth, and movies look
great as always.

Battery life is excellent—
we got 18 hours of MP3
playback on a full charge.
Video playback drains the
juice quicker, and you’ll be
cut down in a little less
than six hours.

Specifications
Fifth-generation; 80 GB; 2.5 inch
display (320 x 240); multiple
audio and picture format

Contact: Apple Computer
International
Phone: 09886039424
E-mail: avinash_ramchandra@
asia.apple.com
Web site: www.asia.apple.com
Price: Rs 23,900

Performance  
Features
Build Quality
Value for money
Overall 

RATINGS

The ECS PX1 Extreme is
one of the earlier Intel

P965 chipset based mother-
boards that support ATI’s
CrossFire by means of two
PCI-E x16 slots. The board
has a spacious layout: the
area around the CPU
socket allows for easy
installation of a
larger heat
sink

and
all
the
slots and
connectors
are neatly
laid-out.

Up to 8 GB of DDR2
RAM @ 800 MHz is sup-
ported. Its ICH8DH
Southbridge is compatible
with Intel Viiv, and there’s
8-channel HD audio.

This board’s
performance is

good, if not
great. It

returned
decent scores

in all our bench-
marks: 149.7 fps in

DOOM 3 with a 7800 GTX,
and it encoded a 100 MB

VOB file in 76 seconds with
a Core 2 Duo X6800. The
motherboard is certainly
good for those who want to
build an entertainment PC,

but not for hard-core
gamers or enthusiasts.

Specifications
Intel P965 chipset; support for a
Core 2 Duo CPU; dual-Gigabit
LAN; E-SATA port; 8-channel
audio; upto 10 USB 2.0 and 2
IEEE 1394a; 7 SATA; ICH8DH
Southbridge; 2 PCI-E x16 slots

DIGIT JANUARY 2007

Performance
Features
Ease of use
Value for money
Overall 

RATINGS Contact: Mediatech India
Distribution Pvt Ltd
Phone: 022-2636111
E-mail: ghanshyam@
mediatechindia.com
Web site: www.ecs.com.tw
Price: Rs 7,935

Samsung NV10  
Brilliant!

iPod 80 GB 
We’re Seeing Bigger
Apples!

The NV10 defines
Samsung’s grand re-

entry into the digital
camera business with
class. Gone are the old
plastic body, dash of
chrome, and the cheap-
camera feel; the NV10
exudes reverberating style. 

Ergonomics are near-
perfect—the placement of
the buttons, mode dial, and
lens is spot on. The shallow
grip means a perfect and
secure fit in one’s palm.
The large 2.5-inch LCD
adorns the back, with a
host of touch-sensitive
button lined on the sides.
The screen is large enough
to be used in direct
sunlight. With the NV10
comes a completely
different menu interface
that’s superb and intuitive
once you get the hang of it.
The interface is driven by
the touch sensitive buttons.

The NV10 cramps a 10-
megapixel sensor into that
sleek black body. The lens
is a standard 3X optical
assortment from
Schneider-Kreuznach. The
flash is neatly tucked away,
and pops up automatically
when required. In our
tests, the NV10 delivered
good photographs; outdoor
performance using the
Auto setting is brilliant.
However, the colour
rendition is
overwhelming—there’s too
much saturation, though
this can be fixed in
Photoshop. Apart from
Auto, there are a lot of

modes to choose from; one
such is ASR for image
stabilisation. There’s also a
manual mode, of course. 

At Rs 24,990, the NV10
is priced on the higher
side. But price aside, we
really appreciate the new
user interface, and the
only problem we have is
the over-saturation.
Considering that the NV10
is the third camera in the
series, we expect to see
even better models. 

Specifications
10 megapixel; 3X optical
zoom; 19 MB internal
memory; SD/MMC card;
Image stabilisation mode; 2.5-
inch screen; six White Balance
presets; 11 Scene Modes;
three Metering Modes;
rechargeable battery

Contact: Samsung Electronics
India Ltd
Phone: 011-4151 1234
E-mail: rajiv.k@samsung.com
Price: Rs 24,990

Performance  
Features
Ease of use
Value for money
Overall 

RATINGSECS PX1 Extreme 
Not Really Extreme…
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With Xara3D 6.0, you
can add that extra

zing to your Web pages
with animated 3D
headings, logos, and
buttons. It lets you create
stunningly beautiful 3D
graphics from TrueType
fonts as well as imported
2D shapes.

This new version has a
better interface than the
previous one. Similarly,
there are newer styles such
as new Bevel types, boards,
boards with holes, and
borders. You can change

the
lighting,
texture,
colour,
depth, font
size, etc.,
but the
controls
are not
very easy
to use,
especially for a novice. But
once you get used to the
interface, things get going
pretty well.

Creating a variety of
animations such as multi-

page sequences and even
animated 3D screensavers
is very easy. The anti-
aliased graphics provide
you the best possible
visual quality, and it can

also be optimised for use
in Web pages. Xara3D can
import from WMF/EMF,
CorelXARA, and Webster,
and can export to a variety
of formats such as GIF,
Flash, JPEG, PNG, AVI, and
BMP. You can get yourself a
15-day trial at
www.xara.com. 

Xara3D 6.0 
A Dash Of Style

McAfee Internet
Security Suite 2007

bundles SpamKiller,
VirusScan, Privacy
Service, and Personal
Firewall Plus. You
initially set up a
password to access the
Security Center.

The main screen shows
bar charts of various data
in the form of indices—
such as Security, AntiVirus,
AntiHacker, AntiAbuse,
and AntiSpam. The status
of various services such as
Personal Firewall Plus,
SpamKiller, and others, are
also visible here.

WormStopper and
ScriptStopper block
suspicious behaviour in e-
mail and scripts
respectively. The
SpamKiller module filters
any POP3 account. The new
gaming-suspend mode
suspends confirmation
pop-ups during full-screen
gaming sessions. There is a
File Shredder utility, as
well as a rescue disk
option—which allows you
to create an emergency
disk that can be used when
your computer can’t boot
as a result of an infection.

McAfee Internet
Security Suite 2007 is quite

taxing on system
resources, and the average
scan time is slow.
Nevertheless, you get a
complete security solution,
and if you have a good
configuration, you should
give it a try—a trial version
is included on this
month’s CD.

McAfee Internet Security Suite 2007
A complete security solution

Altiris Software Virtualization
Solution 2 SP1
In A Shell Of Your Own

Performance
Features
Ease of use
Value for money
Overall

RATINGS

Performance
Features
Ease of Use
Value for money
Overall

RATINGS

Contact: McAfee Inc
Ph: 9820154506
E-mail:terrence_gomes@mcafee.com 
Web site: www.mcafee.com 
Price:$79 (Rs 3,500)

Contact: Xara
Web site: www.xara.com
Price: $44.99 (Rs 2,250)

Altiris Software
Virtualization Solution

(SVS) lets you place
applications and data into
managed units known as
Virtual Software Packages.
Small modules known as
Virtual Software Packages
(VSPs) are created for each
software, which can contain
the installations, and which
remain essentially
disconnected from the OS.
This only means that no
Registry modifications are
made to Windows and your
system stays clean, while
transparency means you
won’t be able to tell this is a
layered module. In case an
application malfunctions,
the problem is limited and
isolated to its particular
module, and your OS
remains unaffected.

SVS monitors software
installations, and grabs
Registry changes—in
addition to the addition
and deletion of files—and
transfers these to a layer.
Any file and Registry call is
thereafter forwarded to this
layer rather than to
Windows.

The application is great
if you wish to try out certain
applications without the

risk of problems for your OS.
It also supports transferring
installations to other
computers with SVS
installed. Best of all, it is
completely free for personal
use on up to 10 computers—
worth a try!

Performance
Features
Ease of use
Value for money
Overall

RATINGS

Contact: Altiris
E-mail: www.support@altiris.com
Web site: www.altiris.com
Price: Free
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Internal SATA Hard Drive
Seagate ST3750840AS

Huge 750 GB storage capacity
Expensive 

Contact eSys Distribution Pvt Ltd
Phone 011-41811694
E-mail msinghal@esysmail.com
Price Rs 23,500

2.1 Speakers
Altec Lansing MX-5021

Great sound and build quality
Slightly expensive 

Contact Rashi Peripherals
Phone 022- 55090909
E-mail divya@rptechindia.com 
Price Rs 7,900

Processors
Intel QX6700 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Corporation
Phone 080-25075000
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Sharp XR-10S

Brilliant quality and 
performance
Bulky

Contact Sharp Business
Systems Ltd
Phone 011-26431313
E-mail anilsodhani@

sharp-oa.com
Price Rs 71,000

Digital Cameras
(High- End)
Sony Cybershot W50

Excellent image quality,
vibrant colours
Trouble focusing in low light
Contact Macro Photo
Phone 022-22618639
E-mail macro.photo@gmail.com
Price Rs 15,000

Digital Cameras
(Mid-range )
Sony Cybershot DSC L1

Great image quality
Only 4 MP CCD
Contact Macro Photo
Phone 022-22618639
E-mail macro.photo@gmail.com
Price Rs 9,000

Wi-Fi Access Points
Linksys WAP54G

Great performance
None in particular

Contact Ingram Micro India Pvt Ltd
Phone 9323112279
E-mail sunil.z@ingrammicro.co.in
Price Rs 3,816

Wi-Fi Routers
ASUS WL-530G

Very fast; well-priced
None

Contact ASUSTeK Computer Inc
Phone 022-40058923
E-mail mamta_bhatia@asus.com
Price Rs 4,400

Hard drive-based MP3
Players
Apple iPod 80 GB

Large capacity; great
fidelity
Expensive

Contact Apple Computer
International Pvt Ltd

Phone 09886039424
E-mail   avinash_ramchandra@

asia.apple.com
Price Rs 23,900

LCD Monitors (17-inch)
Samsung SyncMaster 740N

Crisp images and vibrant
colours
None in particular

Contact Samsung India
Electronics Ltd

Phone 011-41511234
E-mail subrotah.b

@samsung.com
Price Rs 11,500

Linux
SSuuSSEE  LLiinnuuxx  EEnntteerrpprriissee
DDeesskkttoopp  1100..11  

Good software bundle
A little resource-heavy

Contact Novell India
Phone 022-28342244
E-mail apanjwani@novell.com 
Price Rs 2,650

Internal DVD-Writers
Sony DRU-830A

Good performance
None in particular

ContactRashi Peripherals
Pvt Ltd

Phone 022-67090909
E-mail navinderc@

rptechindia.com
Price Rs 2,300

Graphics Cards (High-End) 
NVIDIA GeForce 8800 GTX

Blistering-fast
Runs slightly hot
CCoonnttaacctt Rashi Peripherals Pvt Ltd
PPhhoonnee 022-67090810
EE--mmaaiill navinderc

@rptechindia.com
PPrriiccee Rs 41,000 + taxes

Graphics Cards (Mid-Range) 
XFX PV-T73G-UDL7
(NVIDIA 7600GT)

Great bundle and performance
None in particular
CCoonnttaacctt Rashi Peripherals Pvt Ltd
PPhhoonnee 022-67090810
EE--mmaaiill navinderc

@rptechindia.com
PPrriiccee Rs 10,500

External Portable Hard
Drives
Lacie Design by F.A. Porsche
40 GB

Inexpensive, good 
performance
Looks bland

Contact Neoteric Infomatique

Pvt Ltd 
Phone 022-39828600
E-mail sales@neoteric.co.in
Price Rs 5,250

Internal PATA Hard Drive
Hitachi Deskstar
HDS725050KLAT80

Speedy performance
Expensive

Contact Cyberstar Infocom Ltd 
Phone 9341057327 
E-mail lalit.sudrik@

cyberstarindia.com
Price Rs 4,950

The best products tested so far in different 
hardware and software categoriesThe A-List

DIGIT JANUARY 2007
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Feature-rich Cell Phones
Nokia N80

Brilliant screen; extremely
feature-rich
Slightly bulky
Contact Nokia
Phone 0124-5199000
Website www.nokia.com
Price Rs 21,000 

Budget Cell Phones
Nokia 6070

Great value for money
Poor-quality camera

Contact Nokia
Phone 0124-5199000
Website www.nokia.com
Price Rs 5,500

Intel High-end Motherboards
Foxconn 975X7AB-8EKRS2H

Inexpensive, good performer
None in particular

Contact Mediatech India 
Distribution Pvt Ltd

Phone 022-26361111
E-mail info@mediatechindia.com
Price Rs 10,750

Intel Mid-range Motherboards
Gigabyte GA-965P-DQ6

Good build quality and 
performance
Expensive 

Contact GIGABYTE Technology 
India Ltd

Phone 022-26526696
E-mail sales@gigabyte.in  
Price Rs 16,000

Motherboards
AMD AM2 Motherboards
ASUS Crosshair AM2

Great bundle and performance,
accessories for the enthusiast
None  

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 15,400

AMD 939 Motherboards
ASUS A8R MVP

Good performance
Skimpy bundle 

Contact ASUSTeK Computer Inc
Phone 022-40058888 
E-mail media_india@asus.com
Price Rs 8,700

Home Inkjet MFDs
HP Officejet 4355 All-in-One

Fax with handset, compact
Only sheetfed scanner  

Contact HP India Sales Pvt Ltd
Phone 0124-2566111
E-mail ashwini-k.aggarwal@hp.com
Price Rs 6,499

Office Inkjet MFDs
HP Officejet 5610 All-in-One

Good performance
Expensive, No memory card
support

Contact HP India Sales Pvt Ltd
Phone 0124-2566111
E-mail ashwini-k.aggarwal@hp.com
Price Rs 9,999

Keyboard-Mouse Combos
Logitech MX-3200 Laser

Extremely feature-rich
Slightly expensive

Contact Logitech Electronics
India Pvt Ltd

Phone 022-26571160
E-mail response@logitech.com
Price Rs 6,995

Mono Laser Printers
Brother HL-5170DN

Good build quality, network
support
Expensive

Contact Lipi Data Systems Ltd 
Phone 022-22882960
E-mail sharatk@lipidata.com  
Price Rs 21,900

Thin And Light Laptops
Dell Inspiron 6400

Amazing performance
Looks gaudy

Contact Dell India Pvt. Ltd.
Phone 080-25068026
E-mail belgundi_indrajit@dell.com
Price Rs 64,000

Performance Laptops
Sony VAIO AR18GP

Mind boggling performance 
Very expensive

Contact Sony India
Phone 022-28231558
E-mail sonyindia.care

@ap.sony.com
Price Rs 1,99,900

61

Flash Drives
Transcend JetFlash 150 1 GB

Fast
Poor package bundle

Contact Mediaman Infotech Pvt
Ltd.

Phone 022-23828100 
E-mail santosh@

mediamangroup.com  
Price Rs 1,500

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone 022-26571160
E-mail response@logitech.com
Price Rs 8,000

Mono Laser MFDs
Samsung SCX-4521F

Good performance and
quality
Low input tray capacity 

Contact Samsung India
Electronics Pvt Ltd 

Phone 011-26431313
E-mail vikram.negi@

samsung.com
Price Rs 21,990

PC Webcams
Tech-Com SSD-641-MP

Good image quality, 
inexpensive
No software bundle, 
bad build quality

Contact Shree Sagarmatha Dist 
India Pvt Ltd

Phone 011-26428541
E-mail contact@

techcomin-india.com
Price Rs 549
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Prakash Ballakoor

devX.com

This Web site is heaven for pro-
fessional programmers and
development teams. It’s bound

to go over the heads of beginners,
though—and that’s a word of warning!
The site deals for the most part with
application development—program-
ming languages such as .NET, Java,
and C++, as well as domains such as
Web development, architecture, data-
bases, security, and many more are
discussed and dissected.

The site provides “just in time”
e-learning to help development
teams move ahead with project bot-
tlenecks. The site aims to broaden
the knowledge and hone the skills of
developers through Webcasts, tuto-
rials, and tools under partnership
with IBM, Microsoft, and more. The
Webcasts are dedicated to streaming
online IT education and business
events, though the content sites
might need free or paid registration.

Sub-sections under “Zones” are
based on language and domain, and
the topics covered in these sections
are based on real-world experiences.

For example, if you’re a team leader
and need to choose an AJAX library
type—server-based or pure
JavaScript—you’ll find something at
this site to help you out.

The home page features general
programming articles as well as
some on implementations of new
technologies. Programming and
enterprise trends are also talked
about in these articles. Then there’s
the incredibly useful “Tip Bank,”
which contains more than 10,000

tips: workarounds and pieces of code
that are oh-so-just-what-you-were-
looking-for. For example, how do you
create a favicon? How do you call a
Java method from XQuery or animate
form icons? Then, “Sourcebank”
gives links to source code and scripts
posted from around the world.

“10-Minute solutions” is a library
of questions and answers and how-
to articles that can be accomplished
under 10 minutes: how do you
encrypt sensitive configuration data
with Java? How do you programmat-
ically apply XSLT in a dynamic Java
application? (See—we told you the
site isn’t for beginners.)

“APIFinder” redirects you to a
sister site. Here, again, are articles,
news, and so on, and most impor-
tantly, “the majority of APIs (here)
are Web Services—a.k.a. Web 2.0—
APIs, but the site is designed to
include APIs of absolutely any type.”

We suppose you’ve gotten the
idea by now. Newbies, stay out; inter-
mediates and experts, explore, con-
tribute, learn, use, code!

EchoEcho.com

If you’re a beginner to intermediate-
level Web programmer, you’ll prob-

ably find EchoEcho.com
indispensable. The site is categorised
into eight broad categories.

At the first category, User
Forums, you’ll find opinions about
various Web sites and how they
could have been done better. A
forum on Page Development has

www.devX.com And www.EchoEcho.com

discussions on scripting languages
and Web site user interfaces; dis-
cussions on server-side coding and
operating systems can also be
found here. 

D-Zine, another category, talks
about design aspects beyond HTML
and JavaScript. You’ll see important
topics like site colours, graphic stan-
dards, and design perception that
determines the pulling power of a
Web site. Search engine types as well
as off-beat ways of pushing your
page up the search rankings are also
explained. Then there are the tech-
niques for fast loading of pages using
CCS and JavaScript. Tables and
XHTML are explained in detail.

The Tutorials section is sub-
divided into Page Building, Compo-
nent Building, and Server
Programming. Though only HTML,
JavaScript, Flash and Java applets
are explained in detail, there are links
to various external sites. 

“Online tools” has some cool pre-
coding to enhance Web site presen-
tation. One just needs to enter the
type of look and the links required,
and the online tools return code that
can be pasted to your site!

In the Free Resources section,
you can find links to host your site for
free, and also graphics like back-
grounds, buttons, and bullets. Pro-
grams such as image editors, GIF
animators, and HTML editors can be
downloaded from here—as well as
applets like a weather updater,
fading text, image peeling, and pop-
up menus.

There’s one anomaly, though:
we’re wondering why EchoEcho
hasn’t implemented some of the
“best practices” it preaches! 

prakash_ballakoor@thinkdigit.com

Developers in the making can’t afford to miss these two happy helpers!

The DevX main page

Digital Tools l Net Gain

The 10-minute solutions section gets
you your answers in, well, 10 minutes!

EchoEcho’s Online Tools section
shouldn’t be missed
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recreate it by creating a file called
“Show Desktop.scf”. Open Notepad, and
type in the following:
[Shell]
Command=2
IconFile=explorer.exe,3
[Taskbar]
Command=ToggleDesktop

Save this file as “Show Desktop.scf”
by selecting the “Save as” type as All
Files—to prevent the file being saved as
“Show Desktop.scf.txt”.  

Now all you have to do is drag this
file to the Quick Launch toolbar and
your Show Desktop icon is restored. 

Another way is to use the Regsvr32
command. Go to Start > Run and type in
“regsvr32 /n /i:U shell32.dll”. This should
restore the Show Desktop icon.

Save Disk Space
Windows XP, after Service Pack 1,

keeps uninstall information for all
updates in the C:\Windows folder. These
appear as $NTUninstall…

Depending on how many updates
you’ve installed, you might have
anywhere from a couple to a couple of
dozen of these folders. In order to save
some disk space, you can delete these
folders. Doing this does not uninstall the
updates, but will make sure that you
cannot uninstall them later—though
why someone would want to uninstall
security fixes is something we can’t
understand at all anyway. 

In case you do want to know exactly
what uninstaller you’re deleting, you
can go to http://support.microsoft.com
/?kbid=<###>, where <###> is the
number listed in the name of the folder
you are deleting—remember, don’t add
the text “$NTUninstallKB”, just the
number after the prefix.

Once you’re satisfied, just select the
folder(s) and press [Shift] + [Delete].

Now, there are two ways in which to
remove their references from the
Add/Remove Programs list.

Open the Registry Editor and

WINDOWS

TIPS
WIndows XP 63
WIndows Games 65
Internet Explorer 69
Firefox 2 70

30 MINUTES EXPERT
Play Anything 66

SECRETS THAT KEEP YOU AHEAD IN THE RACE

Wherever the Registry Editor is
mentioned in the following,
you will need to go to Start >

Run, type in “regedit” and press [Enter].
You also need to remember that editing
the Windows Registry can be dangerous,
and if not done right, might require you
to format and re-install Windows to get
your system working again. Ideally, you
should back up your Registry before
making any changes to it.

Open Without?
When you right-click on a file, one

of the options you see is “Open With”.
These usually contain what Windows
thinks are valid programs to open
particular file types. Now, sometimes,
when you have bad installers or

uninstallers, some programs leave their
mark on this context menu. Basically, if
you want to clean out this long list of
junk that accumulates here, you have to
edit the Registry.

Open the Registry Editor and
navigate to HKEY_CURRENT_USER\
Software\Microsoft\Windows\CurrentV
ersion\Explorer\FileExts

Now, for example, if you have to
remove programs from the Open With
menu for AVI files, find the extension on
the left that corresponds to AVI files and
click on the “+” sign to expand it and
find the “OpenWithList” key. In the right
pane you should see a list of programs,
such as “wmplayer.exe”, “notepad.exe”,
“mspaint.exe”, etc. Select the ones you
don’t want and delete them.

Next, navigate to HKEY_CLASSES_
ROOT and find the same extension.
Again, navigate to “OpenWithList” and
delete the unwanted programs. This
key is where Windows reads from when
using the All Users profile. Now you
will only see the programs that you
want in the Open With list... well, most
of the time; the problem is that
Windows also reads the Open With list
from another registry key:
HKEY_CLASSES_ROOT\SystemFile
Associations\

Here’s where it reads the default
Open With list from, but we strongly
advise you against changing it because
it might affect multiple file types.

Show Desktop Not Showing
Sometimes, we accidently delete

the Show Desktop icon in the Quick
Launch menu. You can manually

Illustrations Harsho Mohan Chattoraj

Here’s the perfect example of wasted space:
272 MB of update uninstallers!
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navigate to HKEY_LOCAL_MACHINE\
Software\ Microsoft\Windows\
CurrentVersion\Uninstall

Now, select the key that corresponds
to the Update uninstall information that
you want to delete, and delete it.

Another way to do this would be to
select the update in the Add/Remove
Programs list and clicking Remove. 

Since you have already deleted the
Uninstall information, it’s obvious that
you will get an error message that tells
you that the update cannot be
uninstalled, and you’ll get the option to
remove the entry from the Add/Remove
Programs list. Just click OK and the
entry will be removed. 

Remember to check the Show updates
box so you can see the installed updates
in Add/Remove Programs.

New “File > New”
In Explorer, when using the File >

New option, or when right-clicking and
selecting New, you get a list of files that
you can create, including text
documents, folders, images, sounds,
Excel spreadsheets, etc. If you want to be
able to make new items, such as HTML
files or RTF documents, you will have to
edit the Registry.

Open the Registry Editor and
navigate to HKEY_CLASSES_ROOT. Here,
find the extension of the file type you
want to be able to create, such as .htm
or .rtf, and then find the key called
ShellNew. If the file type does not have a
ShellNew key, create one.

Now, in the right-pane of the
Registry Editor, create a new String value
called NullFile. Now you need to close
the Registry Editor and restart Windows. 

The next time you right-click, you
will be able to create a new file (.htm in
our example) by selecting File > New. A
zero byte file will be created, which you
can then edit.

Get Rid Of The Arrow
Shortcuts have an arrow, and it’s

irritating to a few people. If you want to
remove the arrows, open the Registry
Editor, navigate to
HKEY_LOCAL_MACHINE\SOFTWARE\Mi
crosoft\Windows\CurrentVersion\Expl
orer\Shell Icons. If this key does not
exist, create it.

Now, create a new String value
inside this key and name it “29”. Set
the value of this String value to
“C:\Windows\System32\
shell32.dll,52”, which is basically an
empty icon. Now close the Registry
Editor and restart your computer to see
the arrows disappear. 

If you’re doing something important,
and don’t want to restart just yet, you
can force Windows to redraw all the
icons by doing the following:

Right-click on the Desktop, select
Properties. Now click on the
Appearance tab and click Advanced.

From the drop-down list, choose icon,
and change the value (the default is
32). Click OK and then Apply. Now go
back and restore the value to 32 and
click OK, Apply, and then OK. This
will bring you back to your desktop,
and you will find all those pesky
arrows gone. 

You can also replace the arrows with
something else. Just change the path
provided in the Registry hack mentioned
earlier (“C:\Windows\System32\
shell32.dll,50”) to the path of the icon
you want to use.

Prioritise
Have you ever been busy burning a

dual-layer DVD master and had
something stupid like a scheduled anti-
virus scan create a very expensive
coaster? No? Well, it’s happened to
us quite often, and it’s probably
happened to others who burn a lot of
CDs or DVDs.

Of course, this isn’t the only
problem that occurs when Windows
gets its priorities all wrong, but it is the
most common.

Basically, every process (task) has
its priority, according to which
Windows chooses which process
requires maximum love from the CPU.
In order to make sure that some task
that you feel is critical, which
Windows may consider a low level
task, gets the ideal CPU usage time,
you will have to manually give it some
importance.

Press [Ctrl] + [Shift] + [Esc] to open
the Windows Task Manager. Now click
on Processes to see the list of running
processes. In order to change the
priority of a running process, just
right-click on the process, go to Set
Priority, and select a level. The choices
you have areRealtime, High,
AboveNormal, Normal, BelowNormal
and Low. These are pretty self-
explanatory.

If you have a CD/DVD burning
software that you want to give the
highest importance to, set the burning
software’s process to have a High or
Realtime priority. Now, hopefully,
you should see your burner stop
producing coasters.

Recycle The Recycle Bin
Some people are paranoid about

how clean their desktops look, and
would rather not have icons like My
Computer, My Documents, etc. on it.
Now removing these is easy—just right-
click on the Desktop, select Properties
> Desktop > Customize Desktop, and
then uncheck all the boxes
corresponding to the icons you don’t
want. But what about the Recycle Bin?
This one’s a tougher nut to crack.

Go to the Registry Editor, navigate
to HKEY_LOCAL_MACHINE\SOFTWARE\
Microsoft\Windows\CurrentVersion\Ex
plorer\Desktop\NameSpace\. Look for
the key {645FF040-5081-101B-9F08-
00AA002F954E} and delete it. 

Of course, you may want to just
rename the Recycle Bin instead of

deleting it
altogether. In this
case, you should
navigate to
HKEY_CURRENT
_USER\Software\
Microsoft\
Windows\
ShellNoRoam\
MUICache and
change the value
of @C:\WINDOWS\
system32\
SHELL32.dll,-8964
to whatever you
want.

Look ma, No Recycle
Bin!

Desktop icons: before, on the left, and after
removing the arrows, on the right

You can add various file types to the context
menu in Explorer
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Basics
When you click on a square and see

a number, the number signifies how
many of the eight squares that touch the
open square are mines—so a “3” means
that three of the eight surrounding
squares are mines. Using logic and
arithmetic, you have to try and identify
which squares are mines, and which are
safe to be opened.

Openings
Left-click randomly, and fast, in a

circular motion trying to get a nice, big
opening so that you can start sweeping
with some options. This will beat getting a
small opening and then trying to figure
your way out of a corner. Also, the
techniques of the best sweepers in the
world suggest that starting at the corners,
and making a circular sweeping motion
towards the centre for an opening works
best. There’s no hard and fast rule, but it
is a lot easier if you start off with a nice
big opening.

Use Both Clicks
If you spend all your time left-

clicking to open and right-clicking to mark
mines, you will never get anywhere in
terms of breaking time records. And yes,
Minesweeper is all about timing. Let’s say
you have a “1” on the grid, and you’ve
already marked the one bomb that touches
that square. Now, that same “1” has four
more squares touching it that are yet to be
opened. If you left-click to open each of the
four squares, you waste time. Instead, hover
the mouse over the square with the “1” in
it and press the left and right mouse
buttons together. All the touching squares
will be opened. Remember, this is not
magic, so if you marked the wrong square,
you will explode a mine by opening all
touching squares using the left-right click.
Also, when stuck in a corner, and not all
mines touching a square have been
marked, you can use the left-right click to
see which squares are unmarked and
touching the number you’re hovering over.
This is great to visually finding out
common squares between adjacent
numbers—like a visual aid for your
thinking. Just get an opening, don’t mark
any mines, and left-right click on numbers
to better understand what this tip is trying
to teach you.

Pattern Recognition
If you waste time solving the

position of every mine, you’re never going
to get past your own record. Instead, use
pattern recognition to quickly calculate
which squares are mines and which
aren’t. The most common examples are
shown below. These mostly involve what
are called wall patterns. (A wall pattern is
shown in the screenshot, to help illustrate

Alot of us are addicted to games,
especially the simple ones that
Windows bundles. Here’s a look at

some tips, tricks, and cheats for Spider
Solitaire and Minesweeper—two of the most
difficult Windows games to master.

MINESWEEPER
Most people just play Minesweeper by
guessing and randomly clicking, hoping
to open out the empty squares. Most
people also end up never finishing even
the Beginner level of Minesweeper! The tips
provided here guarantee to shave at least
30 per cent off your best time in all
levels—unless you’re already an expert!

Before we start, you should:
Turn off Marks (?). Go to Game >

Marks(?). This will get rid of the “?” mark
that appears when you mark and then try
to unmark a mine. Often we mark mines
incorrectly by mistake, and then waste
precious seconds right-clicking twice to
get rid of that pesky “?”.

Position yourself in such a way that
your left index finger is resting on the
[F2] button. This will help you quickly
start a new game when you click on a
mine and die. 

If you’re using a ball mouse, clean
the ball. Position your mouse in such a
way that you can be comfortable using it
for hours.

Go to Start > Run and type in
“control mouse”. Click on the Pointer
Options tab and reduce the pointer
speed. How slow depends on the
quality of the mouse and the precision
you require. Only playing Minesweeper
regularly and experimenting with
these settings can help you find that
perfect pointer speed where you have
precision control. 

what we mean.) Once you learn these
patterns, you will no longer need to think
about solving them, and will be able to
blindly mark them, solve them and move
on to more complex problems.

Don’t Mark Them All
You don’t have to mark every mine

in the field. The objective of the game is
to uncover every empty square, and
once you’ve done that, the game
automatically stops the clock and marks
all the mines you didn’t bother
marking. So when you get an opening,
and off to one side are squares that are
obviously all mines, ignore them—get on
to solving and opening all squares that
aren’t mines instead. This can shave as
much as 10 seconds off your time in the
Intermediate and Expert levels.

Don’t Hesitate To Guess
No, we don’t mean to tell you to

guess you way through this game,
because you will never succeed.
Sometimes, you’re just left stuck with a
position where either of two squares is
a mine, and it has to be a complete
fluke to mark the right one. In such
cases, delaying the inevitable is
pointless—just make a guess and get it
over with. There’s nothing more
frustrating than finding yourself way
below your best time and only one mine
to sweep, only to make the wrong guess.

WINDOWS GAMES

Look for patterns in the clues. Red highlights
are the patterns and yellow highllights are
where the mines will always be
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Lessons to familiarise yourselves with the most versatile media player

Jayesh Limaye

The VideoLAN or VLC media player
is one of the most versatile players

in the world, able to play virtually
every major (and minor) format of
audio and video. You don’t need to
install any codecs to be able to play a
certain file format—VLC emulates
them to play the files. The name isn’t
a misnomer either—you can even use
it stream multimedia content over a
LAN! VLC is highly portable and can
be carried anywhere even on your
thumb drive. You can find this open
source media player on every Digit CD,
and you’ll find some handy VLC tips
in Digit, December 2006.

Note: To execute any of the command-
line commands here, go to Start >
Run > “cmd” and navigate to your
VLC installation directory at the com-
mand prompt.

Basic Stuff: Managing Playlists
Any media player needs a playlist to
manage the order of media items to
play. The VLC playlist can be accessed
from View > Playlist or by pressing
[Ctrl]+[P]. You can also bring up the

playlist by simply clicking on the
Playlist icon (the icon to the left of the
Volume Control). Click on Manage to
add files, directories or even URLs to
the Playlist. You can also sort the
Playlist by Title, Artist, or Album.
Items can also be dragged-and-
dropped to the Playlist, and you can
drag an item in the Playlist to decide
its order of playback. Common func-
tions such as Shuffle, Repeat, and
Search are also supported.

More Basic Stuff: Skins
VLC comes with a default simple look
or “skin”, but like most other media

players, VLC, too, supports skinning.
Go to Settings > Switch interface >

Skins 2 to view the alternative
skinned VLC. You can also download
and use one of the many skins from
www.videolan.org/vlc/skins.php. Just
place the skin in the Skins subfolder
of the VLC installation (C:\Program
Files\VideoLAN\VLC\Skins in most
cases) and VLC will automatically
detect the skin. Launch VLC and use
the above method to load the skin. A
little-known fact is that VLC also
recognises and can use all the skins
meant for Winamp2 and XMMS
(.wsz files)!

The Streaming And Transcoding
Wizard
While you can stream media over a
LAN using the command-line inter-
face, the easiest way to go about is by
using the included Streaming and
Transcoding Wizard. This Wizard is a
step-by-step guide to streaming your
media on a network or saving a

stream to your hard drive. To launch
this wizard, go to File > Wizard or
simply press [Ctrl] + [W]. Choose
“Stream to network” if you wish to
stream media on a network, or choose
“Transcode/Save to file” if you wish to
change a file’s audio codec and/or
video codec, its bitrate, and/or encap-
sulation method.

Now choose an input by selecting
“Select a stream” (a stream can be a
file, a network stream, a capture
device or a hard drive), and clicking
on Choose, or select an existing item
in the playlist by choosing “Existing
playlist item”.

If you chose “Stream to network”,
you can specify a streaming method.
The available methods include UDP
Unicast, where you can stream to a
single computer whose IP you need to
specify. UDP Multicast allows you to
stream to multiple computers by spec-
ifying multiple IP addresses, and
HTTP lets you use the HTTP protocol
to stream media. Check the box next
to “SAP Announce” and enter the
name for your stream if you wish to
advertise it on the network using
the UDP method. This option is
unavailable if you chose the HTTP
streaming method.

Setting Up A Video Streaming Server
A video file or a video capture device
is all you need to start broadcasting
videos over a network. 

Start the Streaming and Transcod-
ing wizard, and with the “Stream to
Network” radio button checked,
click Next.
You will now be prompted to choose
an existing stream or choose a new
one. Click on “Choose” to create a
new stream.
Select a video file of your choice in
the Open dialog box and click OK,
then click Next.
Select the HTTP radio button, leave
the Destination dialog box blank,
and click Next.
Leave the Encapsulation format at
the default (ASF) and click Next.
Enter “1” in the TTL dialog box and
click Finish.
The Windows XP firewall will warn
you about VLC—just choose Unblock
in the dialog box. 

Your video server is now up and
streaming across the network. Now toThe Streaming/Transcoding Wizard

Using VLC’s Playlist feature

Skinning VLC!



67DIGIT JANUARY 2007

Digital Tools l Tips & Tricks

check whether your video is really
streaming, open another instance of
VLC. Click on the File menu, select
“Open Network Stream”, select the
“HTTP/HTTPS/..” radio button on the
Network tab, and enter “local-
host:8080” in the URL dialog box.
Click OK.

If all is well, you should now be
able to see the video you’re broad-
casting, in this new instance of VLC. If
you pause the video in the server, the
video will pause playing in the second
VLC instance. To access the video on
another computer in the network, just
replace “localhost” with the IP address
of the server PC.

You can even adapt this to stream
live video such as from a TV-Tuner or a
webcam across the network. To do this,
open the Wizard, and with the “Stream
to Network” radio button checked, click
Next. Then click Choose. Click on the
DirectShow tab and choose the device to
use for video and audio capture using
the “Video device name” and “Audio
device name” selectors. Click on the
Configure button to access the settings
of your selected device.

Playing A DVD
VLC is fully capable of playing DVDs as
well; it even lets you easily navigate a
DVD using its menu structure. Go to
File > Open Disc or press [Ctrl]+[D]. In
the window that opens, select the

DVD (menus) radio button and enter
the DVD drive letter followed by a
colon, such as “I:” as the Device Name.
Alternatively, you can enter the MRL
(Media Resource Locator) as “dvd://E:”
in the Customize dialog box
(assuming E is your DVD drive letter).
Click OK. You can choose the Audio
format, Subtitle, Language, etc. by
clicking on the appropriate menus.

Working With Capture Devices
You can even play and stream the con-
tent from a capture device, be it a
webcam, video capture card, or a TV-
Tuner, using VLC. The only prerequisite
is that you need to install the WDM
drivers for the capture device. Click on
File > Open Capture Device or simply
press [Ctrl] + [A]. Choose the device to

use for video and audio capture using
the “Video device name” and “Audio
device name” selectors. You can access
the settings of your selected device
through the Configure button. 

The Extended GUI
Go to Settings > Extended GUI for the
Extended GUI, which gives you access
to a load of settings that let you tweak
your video. Under the Video tab, check
the box next to Enable, and you will
be able to adjust the Hue, Contrast,
Brightness, Saturation, and Gamma to
suit your viewing needs. VLC also fea-
tures additional video effects such as

Image Clone, Distortion, Image inver-
sion and Blurring, Transformation,
and Magnify.

Like any other media player, VLC,
too, has a 10-band graphic equaliser.
Click on the Equalizer tab to access it.
Check the box next to “2 Pass” to
apply the equaliser twice for sharper

effects. Moving the Smooth slider to
the right will control the blending of
the equalizer bands. The more
towards the right it is, the more corre-
lated the movements of adjoining
equalisers will be. The equaliser has
preset modes as well, but to access
them, you need to enter the
Preferences section in VLC.

VLC features two audio filters—a
volume normaliser and Headphone

virtualisation. The Volume Normaliser
is nothing but a limiter that caps the
maximum volume of the player.
Headphone virtualisation is a filter
that provides sound spatialisation
when using headphones.
Spatialisation of sound is an enhanced
reproduction of sound that mimics
multiple speakers even when only two
speakers (in this case, headphones) are
being used, thereby adding the
immersive touch.

Additional Preferences
You can further tweak the various set-
tings of VLC by entering the
Preferences. Go to Settings >
Preferences; here, you can adjust var-

ious audio settings such as Filters,
Output modules, and even
Visualisations.

There’s a whole lot more to
explore, and you should now be in a
position to experiment with the
player on your own. VLC media player
is certainly the jack of all codecs and
the master of most! 

jayesh_limaye@thinkdigit.com

Adjusting image quality

More audio tuning

You can play DVDs using VLC

Adjusting the Preferences

Displaying video from capture devices

The 10-band graphic equaliser
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Cut your losses and get on to the
next game.

Cheats
In older versions of Minesweeper

(before Windows XP), you could stop the
clock by keeping the left and right mouse
buttons pressed and pressing [Esc]. This
doesn’t work with Windows XP’s version
of Minesweeper, but you can always
download the Windows 98 version and
overwrite winmine.exe in the
C:\Windows\System32\ folder.

Another interesting cheat is to start
Minesweeper, then type [X] + [Y] + [Z] + [Z] +
[Y] + [Shift] + [Enter] + [Enter] (that’s xyzzy
+ Shift + Enter twice) on your keyboard.
This will display a single pixel on the top
left of your desktop that glows white
when you hover an empty space and black
when you hover over a mine—this
obviously only works to your advantage
when you have a black desktop
background, so that you can see the pixel
glow white when you are over a square
that doesn’t contain a mine. It also will
not help your time much, especially if you
depend on this pixel to solve your game.
However, this can help a lot when you’re
stuck with an unsolvable pattern (where
guesswork is needed).  

Alternatives
There are many clones for

Minesweeper, including those that use
hexagons instead of squares, making the
sweeping more complicated. There is also
the official Minesweeper Clone, which has
an inbuilt recording facility and is cheat-
proof. If you find yourself getting good
enough to challenge the masters of
Minesweeper, you will need Minesweeper
Clone. Records are only acknowledged if
you send in a recording of it, and
Minesweeper Clone will let you play back the
records of the masters, in case you want to
see how they play. Just visit www.planet-
minesweeper.com to delve into the
wonderful world of minesweeping.

We should mention that, currently,
the world records for the three levels are:
Beginner : 1 second
Intermediate : 10 seconds
Expert : 38 Seconds

You can only get into the hall of fame
if your combined time (Beginner +
Intermediate + Expert) is 99 seconds or
less! Happy sweeping!

SPIDER SOLITAIRE
The aim of this game is to empty out 10
stacks of cards by building each suit from
King to Ace. It involves two decks of cards,
and you can choose between just a single
suit (easy) to all four suits (highest
difficulty). 

It’s All In The Suit
If you want to have any kind of

success in Spider Solitaire, always try to
build according to suit. This is the most
basic point of the game, because only
when you have King through Ace of the
same suit (all 13 cards) does it get taken
off the playing board. Also, if you have,
say, Jack of Clubs through Six of Clubs,
you can move that whole build of cards
to another slot, together. So building in-
suit allows you to reveal more of the
covered cards.

Exposé
This holds true for any form of

Solitaire: try your best to expose the
covered cards. The only way you can win
at this game is if you focus more on
opening all the covered cards rather than
building a single sequence and losing
focus on the rest. Besides, covered cards
are of no use to anyone, so the faster you
uncover them the better your chances of
building multiple sequences. 

Kings High
Kings are your friends, unless there

are no Queens to be found, that is. Focus
on building on top of higher-ranked cards.
An Ace on a covered pile is just useless
unless there’s a two around; a Jack, on the
other hand, is a nice option for a Ten of
any suit. So make sure to try and keep all
playable cards as high as possible.

Don’t Mix
Although in Spider Solitaire you are

allowed to place, say, a Six of any suit on a
Seven of any other suit. This is just going
to get you stuck. Obviously, sometimes
you might want to mix and match to try
and open out more covered cards in the
hope that you get the cards that you’re
looking for; but as far as possible, don’t
ruin a built sequence by adding a card of
another suit. Whenever possible, always
mix suits in sequences that already have
mixed cards. Later you can always un-mix
them when you have a few free spaces on
the board.

Dealing Is Death
Don’t just deal the next hand in the

hope that you will get some good cards.
It’s better to try and keep playing without
dealing. The longer you play and the more
options you try, the better your chances of
opening out covered cards. Dealing the
next hand is like the “Get out of jail free”
card in Monopoly—only to be used in
emergencies, or when there’s no
other choice.

Mixed Suits
Often, you find yourself with, say,

King through Nine of Hearts, then Eight
of Spades, and then Seven through Ace

of Hearts again. In such a case, keep an
eye out for the first opportunity where
an Eight of Hearts is available, and any
other Nine is free. Let’s say you have the
Eight of hearts open, quickly move the
Seven through Ace of Hearts on to the
Eight of Hearts, then the Eight of spades
on to any available Nine, and then move
the Eight through Ace of hearts back on
to the original pile to complete the
sequence. This holds true when any
sequence is broken up by one card from
a different suit.

Don’t Touch The King
A very common mistake all novice

Spider Solitaire players make is to move a
King to the first available empty space.
Unless you can get that whole sequence
(King to Ace) in three moves or less, you’re
asking for trouble. Empty spaces on the
board (created after all the covered cards
in that pile have been opened and moved)
are what will help you win the game. Any
card from Queen through Ace, when put
in an empty space, can be moved out
again, but a King in an empty space can
only be moved off the board—when the
entire sequence of King to Ace of that suit
is completed. So next time a King is on top
of a pile and a space opens out, don’t just
pop it into the empty slot hoping to be
able to build from there.

Think Ahead
Spider Solitaire, like any thinking

game, requires some planning. You should
always be thinking at least three moves
ahead for even a single suit (easy) game.
Good players think as much as 10 moves
ahead when playing with all four suits
(highest difficulty). You will have to learn
to visualise your moves before you make
them. So when you’re thinking of moving
a card, look at the board in your mind
and see what that move will mean for the
rest of the game—will you be able to
continue? Will moving this card really
help? Also, it’s most important to see all
your available moves before making any
move, even the very first one. Sometimes
games are lost just because the first move
was wrong. Also never be shy to use the
[Ctrl] + [Z] (undo) option that’s available,
but remember that it is only available till
the last hand was dealt.

1: If you have to mix suits, add to an already
mixed pile. 2: This helps you build better
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IE7, at first look, is decent. You’d
expect it to be perfect, what with its
having been released so late (two

years late, in our opinion). And it’s not.
The zoom feature has some problems—
certain zoom and/or text size levels
make some text disappear altogether;
favicons (the icons associated with Web
pages, which appear next to the site
name) sometimes don’t load, and so on.
But on the whole, it’s decent: there’s
tabbed browsing (finally), an easy way
to add feeds and organise Favorites, a
Quick Tab feature that shows you
thumbnails of open tabs in the full
window so you can switch to one or
close some, and more.

Why’s The File Menu There?
You might want to bring the File

and other menus back where they
“belong,” that is, at the top. (That’s one
funny decision on the developers’ part).
It’s a Registry edit. First back up the
Registry, then navigate to
HKEY_CURRENT_USER\Software\Micros
oft\Internet Explorer\Toolbar\
WebBrowser
Right-click in an empty area of the right
pane, then select New > DWORD. Give it
the name “ITBar7Position” (without the
quotes). Double-click the newly-created
value to give it a value of 1. Re-opening
IE7 should make the change visible.

Setting A Wallpaper
One issue with IE7 is that in some

cases, you might be trying to set an
image as a wallpaper, and the option
“Set as Background” might be greyed
out. If that’s the case, you’ll need to do
a Registry edit. First back up the
Registry, then navigate to
HKEY_CURRENT_USER\Software\Micro
soft\Windows\CurrentVersion\Policies

\ActiveDesktop
Locate the entry called
NoChangingWallpaper, and change
that DWORD value to 0.

Multiple Homepages
Instead of just one homepage, you

can have multiple homepages in IE7.
When you’re at a page that you want to
add to your homepage list, click the
down arrow next to the homepage
icon. You’ll be asked whether you want
to set the page as your only homepage
or add it to your “list of homepages”
(still sounds funny to us). It so happens
that you can also manage this from
Internet Options.

Adding Feeds And Engines
Adding a feed or search engine

couldn’t be easier. When IE7 detects that
a page has a feed on it, the feed button
will light up (get coloured). Just click the
down arrow next to it and it’s clear from
there on what to do. Now, press the
Favorites button at any time to see a list
of Favorites and Feeds as well as History.
Right-click a feed and select Properties:
you’ll be able to select how often to
update it, and other things.

INTERNET EXPLORER 7 To add a search engine, click the
down arrow next to the search field.
You’ll get a Microsoft page that gives
you directions on what to do to add
an engine!

A list of common tasks and
how to get them done quickly

To disable all add-ons, Run
“iexplore.exe -extoff”.
To turn on AutoComplete so that site
addresses will be automatically filled
in when you begin to type them, go to
Tools > Internet Options > Advanced >
Use inline AutoComplete.
To change how tabs work, go to Tools >
Internet Options > General tab. Under
Tabs, click Settings.
To display the Menu Bar permanently
at the top of the screen, go to Tools >
Menu Bar.
To delete cookies, passwords, form
data, history, and temporary Internet
files, go to Tools > Delete Browsing
History.
To find and install add-ons, go to Tools >
Manage Add-ons > Find More Add-ons.
To print only part of a page, select the
part, press [Ctrl] + [P], click Selection,
then click Print.

Internet Explorer 7 Keyboard Shortcuts
Open a link in a new tab in the background [Ctrl] + Click (or just middle-click)
Open a link in a new tab in the foreground [Ctrl] + [Shift] + Click
Open a new tab in the foreground [Ctrl] + [T]
Switch between tabs [Ctrl] + [Tab] (forward) OR [Ctrl] + 
[Shift] + [Tab] (backward)
Close current tab (closes current window when [Ctrl] + [W] OR [Ctrl] + [F4]
there are no open tabs)
Open a new tab in the foreground from the address bar [Alt] + [Enter]
Switch to the nth tab (n can be 1 to 8) [Ctrl] + [n] 
Switch to the last tab [Ctrl] + [9]
Close all other tabs [Ctrl] + [Alt] + [F4]
Open quick tab view [Ctrl] + [Q]
View list of open tabs [Ctrl] + [Shift] + [Q]
Increase zoom (+10%) [Ctrl] + [+]
Decrease zoom (-10%) [Ctrl] + [-]
Original zoom [Ctrl] + [0] OR [Ctrl] + [*]
Go to the Toolbar search box [Ctrl] + [E]
Bring down the search provider menu [Ctrl] + [Down Arrow]
Go to home page [Alt] + [Home]
Go backward a page [Alt] + [Left Arrow]
Go forward a page [Alt] + [Right Arrow]
Refresh the page and the cache [Ctrl] + [F5]
Stop loading page [Esc]
Open Favorites [Ctrl] + [I]
Open Favorites in pinned mode [Ctrl] + [Shift] + [I]
Organise Favorites [Ctrl] + [B]
Add current page to Favorites [Ctrl] + [D]
Open Feeds [Ctrl] + [J]
Open Feeds in pinned mode [Ctrl] + [Shift] + [J]
Open History [Ctrl] + [H]
Open History in pinned mode [Ctrl] + [Shift] + [H]
Select the Address Bar [Alt] + [D]
View list of previously-typed addresses [F4]
View list of search providers [Ctrl] + [Down Arrow]
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Firefox 2 has been eagerly awaited
by many, and it was released in
December. It’s got some nice

improvements over earlier versions,
and there’s no reason you won’t want
to install the latest version.

Attention has been paid to the
smallest of details: where in the old
versions you had “Open in Tabs” under
a bookmark with multiple tabs, you
now have “Open All in Tabs”! You’ll be
pleased to know that people are
coming up with updated extensions
rapidly, so you won’t be deprived
of yours very long—and many
already work.

Tab Close Buttons
Probably the first thing you’ll

notice when you open a new tab in
Firefox 2 is that each tab has a tab-
close button! This is nice, really, but
you might just be used to the old
version’s behaviour.
It turns out there are more than two
options. Open the about:config page,
go to browser.tabs.closeButtons. Set it
to one of the following.
0 shows a close button only on the
active tab.
1 makes close buttons visible on all
tabs—Firefox 2’s default behaviour.
2 makes it no close buttons at all!
You’ll have to use the right-click to
close a tab.
3 is the old default—a close button at
the end of the strip of tabs.

The Go Button Annoyance
The “Go” button is now

(irritatingly) merged with the location
bar. What does it do, anyway? All you
need to do to make it go away is to set
browser.urlbar.hideGoButton to True.

Tab Sizes
One irritant can be the vanishing

size of tabs when there are too many
open. Isn’t there a way to make them a

set size, and then have a tab scroll
button, you ask? There is, in Firefox 2.
(We’re not sure about earlier versions).
To specify the minimum size for a tab
modify browser.tabs.tabMinWidth. For
some reason, if you want to, you can
also specify the maximum size of a tab:
modify browser.tabs.tabClipWidth.

A Helpful Warning?
Firefox 2 warns you when

opening more than 15 tabs at a time.
This typically happens when you click

on “Open All in Tabs” in a bookmarks
folder. It says something about Firefox
slowing down. You can modify this at
browser.tabs.maxOpenBeforeWarn.
Just set it to the number of tabs at
which you’d “like” the warning, or
just type in “999” or something to
save yourselves a few picoseconds
of thought.

Closing A Tab
OK. This is a tiny niggle, but when

you have a fresh new browser, you
want everything just perfect, don’t
you? Consider this: when you close a
tab, Firefox 2 takes you back to the tab
“that opened it” (meaning the tab you
were in when you opened the new tab)
if you haven’t changed to another tab
in the meantime. (Open and close a
few tabs to get what we’re saying.) In
Firefox 1.5, you were always taken to
the immediately previous tab. To
restore that behaviour, set
browser.tabs.selectOwnerOnClose
to False.

SSL Support
Support for SSL version 2 is

deactivated by default in Firefox 2.
Only SSL 3 is supported. If you happen
to encounter an old Web site that
requires SSL 2, you’ll need to enable it.
This is pretty rare, but here’s the
about:config key anyway—set
security.enable_ssl2 to True.

Search Results
To make Firefox display search

results in a new tab, set
browser.search.openintab to True. The
key might not be present, in which
case you’ll have to add it yourself.

The Spell Checker
Spell checking is disabled by

default in single line text boxes. To
make it do the spell check (if you’re
that conscious about your spelling!),
set layout.spellcheckDefault to 2.

The Search Button
If you want to remove the Search

button, you’ll need to edit the
userChrome.css file. Add the
following lines:
.search-go-button-stack {display: none
!important; }
#searchbar { margin-right: 1em
!important; }
To find the userChrome.css file,
navigate to
{Drive}:\Documents and
Settings\your_user_name\Application
Data\Mozilla\Firefox\Profiles\random
_name.default\chrome
Here you’ll find “userChrome-
example.css”. Rename it to
userChrome.css when you’re done with
your changes.

Adding Feed Readers
Firefox 2 by default supports only

three Web feed readers: Bloglines,
Yahoo! and Google Reader. You can,
however, add as many providers as you
like, and use any of them as your
subscription manager. For this, you’ll
need to do a couple of about:config
tweaks, and add some preferences.

Under about:config, create a new
preference by right-clicking on any
preference and selecting New >
String.
Enter “browser.contentHandlers.
types .6.title” for the preference
name. Then enter the URL of
whichever service you want to use—
Newsgator, for example (www.news-
gator.com) for the value.
As you add more Web feed readers,
you will need to change the “6” to the
next number. 6 happens to be the
first available.
Create a new preference and enter
“browser.contentHandlers.types.6.ty
pe” for the preference name. Enter
“application/vnd.mozilla.maybe.fee
d” for the value.
Create yet another preference name
and enter “browser.con-
tentHandlers.types.6. uri” for the
preference name, and “http://
www.newsgator.com/subscribe.php?
url=%s” for the preference value.
You’re done—just restart Firefox.

FIREFOX 2

With one setting, make all tabs the same width

Firefox 2 gives you a warning when you try to
open many tabs at once. You don’t need it!
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Flash drives, uncommon just a year
ago, now find a place in any worker’s
pocket. If you’re in the market for
one, here’s what you should be buying

Vishal Kansagra

T
hey’re called “pen drives,” “thumb
drives,” “data vaults,” and “Flash drives”—
of which the last is the technically correct
name. Small and more rugged than any

other popular media, they’re particularly useful
for people who keep transferring data between
different machines. You can even carry your
office with you thanks to the newer U3 drives,
which allow you to use any application without
installing it on a computer. What’s more, you can
install a Linux distro onto your Flash drive and
use it off the drive itself.

Most Flash drives offer password protection,
and for the paranoid, some even have biometric
scanners. You can also use one as a key to lock or
unlock your computer.

We classified the Flash drives based on their
capacity—512 MB, 1 GB, 2 GB, and 4 GB. While
there are drives ranging from 256 MB to 16 GB
available in the market, the price difference
between 256 MB and 512 MB is negligible, so look
for nothing less than 512 MB. 

512 MB Drives
We received ten 512 MB drives—two from SanDisk
and one each from A-DATA, iball, intex, Kingston,
Odyssey, TECH-COM, Transcend and Zion. They
don’t have particularly fancy features, but are
useful for those who want to carry documents
and pictures around with them.

Dinky Data

Photographs Jiten Gandhi



Features
Though at the bottom of the drive pyramid,
some of these drives came with decent
features—the SanDisk Cruzer Micro 512 MB,
for example, was the only drive in this cate-
gory to support U3. Its
cousin, the Cruzer
Profile 512 MB, comes
with a biometric scan-
ner so your critical
data is protected.
While most drives come
with a software CD that
allows you to set a password
or set partition sizes using a
rudimentary interface, the Tran-
scend drive comes with a good soft-
ware package and decent interface that
includes features like secure zip, PC lock, data
backup, auto login, and e-mail sync. The
SanDisk Cruzer Mini comes with the U3
versions of Avast!, Skype (with one month of
free voice mail), SignupShield Passwords, and
its own PC synchronisation software—standard
features on all their drives. The Intex 512 MB
also doubles up as an SD card.

Build Quality And Bundle
With its chewing-gum-like looks, Kingston’s
DataTraveler Mini MB was the cutest of the lot.
A-DATA’s Oriental Elite has a beautiful design
and allows you to change faceplates (two are
provided with the drive). It also includes a USB
extension cable. The SanDisk Cruzer Profile 512
MB has rugged build quality and small rubber
strips at the bottom to protect it from scratches.
The Cruzer Micro’s retracting USB connector is
good for people who tend to lose their drive’s
cap, but is also a veritable dust-trap. 

Performance
Since these drives will mostly be used to carry
documents and presentations, data transfer
speed is critical. The A-DATA Oriental Elite 512
MB was the fastest of the lot and took little
more than 11 seconds to
transfer 50 MB of files,
which included docu-
ments, spreadsheets,
pictures, MP3s, and

executables. The TECH-COM 512 MB took a
decent 27.6 seconds. Thoguh it took just 30
seconds for the A-DATA Oriental Elite to trans-
fer a sequential file to its full capacity. The
Zion followed closely with a time of 50.3
seconds. The SanDisk Cruzer Micro took a
somewhat sluggish 76 seconds.

In Sum
The A-DATA Oriental Elite takes Gold not only
for its speed, but also thanks to a decent pack-
age bundle. Both the Cruzer Micro and the
Profile from SanDisk put up a decent perform-
ance and have a good bundle. The Silver-
winning Cruzer Profile, with its biometric
scanner, is highly recommended for those
who deal with sensitive data. Special mention
goes to the Zion drive—though it lost out on
features, it’s quite fast and costs around 30
per cent less than most other Flash drives in
this category.

1 GB DRIVES
This category witnessed a total of 22 drives
fighting for top spot—five from PQI, three each
from SanDisk, Transcend and UMAX, two from
Corsair, and one each from Gigabyte, iball,
Lexar, Odyssey,  Transcend and Zion. These
drives let you do more than just carry your
documents around—you can even pack a DivX
movie along with your other data. They tend to
be slower than their 512 MB counterparts,
however, as there is a trade-off between speed
and capacity.
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Our test bed used an Intel Core 2 Duo Extreme E6800 on an ECS PX1
Extreme Motherboard with 1 GB of Kingston HyperX DDR2 RAM. The hard

drive was clean-formatted before loading Windows XP, and all the latest
drivers for the motherboard and USB ports were loaded. To maintain a
standard environment, we installed only the required benchmarking utilities
and the files we used in our tests.

Test Methodology
All the storage devices we tested were evaluated on the basis of their scores
in three primary areas, namely Features, Performance, and Price. To help in
our calculations, we assigned a relevant weightage (refer table for the
breakup) to these parameters.

The parameters included are:
Features
We looked at the various inbuilt characteristics such as U3 or password
protection. We also observed the build quality, with primary importance
given to the sturdiness of the product. We gave extra points for any security
features such as biometric protection, and also for any useful software in
the package.

Performance 
To gauge performance, we conducted two types of tests—synthetic and real-
world. For the synthetic tests, we used the HD Tach 3 benchmarking suite to
assess theoretical read and write speeds, as well as the average access time.
Due to the varying storage capacities of the models, we also carried out an
additional test, where the thumb drive was filled to capacity with both
sequential (a single large file) as well as assorted data. We observed the
time taken for each transfer, and then calculated the actual data transfer
rate in terms of megabytes transferred per second.

How We Tested

JA N U A RY  2 0 0 7

SanDisk Cruzer Profile 512 MB
As secure as it gets

JA N U A RY  2 0 0 7

A-DATA Oriental Elite
Blazing fast and looks 
good too!
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the lot—it bounced back safely every time we
tossed it around. The PQI CoolDrives—true to
their names—look cool and have decent 
build quality. The SanDisk Cruzer Titanium
has very good build quality, and retains 
the retracting USB connector found on 
the SanDisk Cruzer Mini. Most drives came
with a lanyard cord and some with a USB
extension cable—real handy when your PC is
placed under the table—but the Transcend
JetFlash 130 was different, with two different
coloured caps.

Performance
Since these drives have larger capacities, they
can easily accommodate a single DivX movie
(roughly 700 MB). The Transcend JetFlash 150
took just a minute to transfer a 700 MB video
file. The Zion was at its heels, and took 64.8
seconds for the same task. These drives took
less than a third of the category average of 192
seconds. The full-capacity assorted file test
took 82.9 seconds to complete on the Tran-
scend JetFlash 150m and a close 91.7 on the
Zion. The Corsair Flash Voyager took a little
more than two minutes to complete the task.
Considering the average time of 274 seconds,
these scores are really impressive. If you 
are looking for sheer performance, the Tran-
scend JetFlash 150 and the Zion are the drives
for you.

In Sum
The Transcend JetFlash 150 gets Gold for its
blazing speed and feature-rich bundle. The
Corsair Flash Voyager claims the Silver for
decent performance, rugged build quality,
and a good software bundle. Once again, Zion
just misses the Silver for lack of accessories
and software. 

2 GB DRIVES
Nine drives turned up in this category: SanDisk
sent in three, and Corsair, iball, Lexar, TECH-
COM, Transcend, and Zion sent in one each. This
category is for those who use pen drives to trans-
fer large amounts of data such as MP3s, movie
clips, and games. Speeds fall again because of
increased storage space.

Features
There’s nothing different about the drives’
bundled software—it was similar to what
came with the 1 GB drives. Since these drives
are a bit expensive, some more value-added
software wouldn’t have disappointed.

Build Quality And Bundle
The Corsair Flash Voyager comes up tops again
with its superior build quality. The SanDisk
Cruzer Titan is built well, is quite sturdy, but its
metallic lustre may fall prey to dust and rough
use. Its retracting USB connector can act as a
dust trap in dusty environments.

Performance
The Zion led the way, taking 89.7 seconds to
transfer a 700 MB video file. This is a little more
than the fastest 1 GB drive. The SanDisk Cruzer

Features
The Corsair Readout 1 GB has an external
display that shows you the drive label and the
free space available—no more plugging it in
to check! The display does not require any
external power, and stays on for a good one
year.

The PQI CoolDrive U339S, SanDisk Cruzer
Micro and Cruzer Titanium are U3 drives (see
box U3). While all of them have PC synchronisa-
tion features, PQI’s software lets you select the
sync direction—from PC to drive or from drive
to PC. The Lexar JumpDrive FireFly comes loaded
with Google software for Windows—including
Google Toolbar for Internet Explorer, Google
Desktop, and Picasa. 

Build Quality And Bundle
The Corsair Flash Voyager, with its rubber and
water-resistant exterior, was the toughest of

U3 is a new standard formed by leading Flash drive manufacturers to
provide customers with the ability to carry their favourite software and

applications along on their drives. If you need to use a particular software
on a PC where you don’t have Administrator rights, this feature can come in
quite handy. The U3 interface lets you manage your data, install and
uninstall software, and search for new U3 software over the internet.

Though U3 has its uses, it can be irritating for some: the U3 menu pops
up every time you plug in the drive. As of now, the feature only works with
Windows XP, so people using other operating systems won’t be able to take
advantage of it. 

U3

Corsair Flash Voyager 1 GB
Built like a mini-truck!

JA N U A RY  2 0 0 7

JA N U A RY  2 0 0 7

Transcend JetFlash 150 1 GB
Fast and fully-loaded
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follows at 91.5 seconds. The Transcend JetFlash
V30 took a never-ending 529 seconds to transfer
the same amount of data!

The Zion handled the full-capacity assorted
file transfer in just four minutes. The closest
competitor was the Corsair Flash Voyager at
266.7 seconds. Lexar posted the lowest score of
764.7 seconds—almost 13 minutes—to transfer
2 GB of data. 

In Sum
Our Gold winner, the Corsair Flash Voyager, is
fast, has sturdy build quality, and offers a
good software bundle. To top it off, Corsair
offers a 10-year warranty and over-the-counter
replacement, no questions asked. Our Silver
winner is the Cruzer Titanium; the Zion lost

If a computer is too sluggish, you can increase the amount of RAM on it to
improve the performance. Increased system memory means that

applications need not access the hard drive too often. But RAM is expensive,
and your computer won’t support RAM beyond a point.

To take care of such a situation, Windows Vista will introduce a new
feature called ReadyBoost that will allow you to use a Flash drive as swap
drive. Vista uses the Flash drive as a cache while transferring the data from a
hard drive to the CPU in case the RAM is found insufficient. It uses an
optimised algorithm that reduces the number of read/write cycles, so your
drive won’t wear out easily. Windows Vista RC2 does show a marked
performance increase, and we expect this to get better by the time the final
version is released. 

ReadyBoost 

Corsair Flash Voyager 2 GB
Tough, and comes with a good
software bundle

SanDisk Cruzer Titanium 2 GB
Excellent build

JA N U A RY  2 0 0 7

JA N U A RY  2 0 0 7
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Small

Expensive

Cheap

Poor build quality

Fast; refreshing
design
Too small

Reasonable price

Slow

U3 software

Poor package bundle

Very fast

None in particular

Kingston

DataTraveler mini Fun

512 MB

476 MB

Password protection

✖

✔

✖

6

9

9.6

13.1

4.1

13.5

7

13

1.3

28.5

2

122

16

277

19.3

13.65

16.73

11.72

42.10

640

5

Odyssey

512 MB

512 MB

505 MB

Password protection

✖

✔

Lanyard

6

7

8.1

7.5

6.1

11.2

3

10

1.3

51.7

1.8

90

8.9

472

25

15.05

16.04

11.11

42.20

675

2

iball

512 MB

512 MB

480 MB

Password protection

Partition software

✔

Lanyard, protective

case

6

5

40.7

18.5

5

25

7

11.2

1.3

44.9

2

102.7

22.7

425.5

38.6

14.70

17.36

12.71

44.77

590

2

Intex

512 MB

512 MB

476 MB

✖

✖

✖

Protective case

4

4

1.1

20

3.2

20.6

10

22.3

2

209

2.3

146

9.8

279.3

38

2.10

16.51

5.00

23.61

1500

1

SanDisk

Cruzer Micro 512 MB

512 MB

483 MB

Password protection

U3

✔

Lanyard

7

8

1

12.8

6.6

13.1

1

9.2

1.5

31.5

1.7

76

9

301

23.7

21.00

20.00

6.85

47.85

1095

2

A-DATA

Oriental 512 MB

512 MB

499 MB

Password protection

✖

✔

Face plate, Lanyard,

USB cable

6

7

38.6

23.8

16.8

25

1

3.4

1.2

11.6

1.7

30

8.3

112

19.3

16.45

34.46

7.58

58.49

990

3

BRAND

MODEL

Features

Storage Capacity (Stated)

Storage Capacity (Actual)

Security

Software features

Visual indicators such as an LED etc.

Other accessories provided

Build quality (Scale of 10)

Sturdiness of the overall package 

Cap locking mechanism

Performance

HD-Tach 3

Random Access Time

Average read speed

Average write speed

Read burst Speed

CPU utilisation

File Transfer Test (seconds)

Write (Sequential)* 

Read (Sequential)* 

Write (Assorted)* 

Read (Assorted)* 

Write—max capacity (Sequential)

Read—max capacity (Sequential)

Write—max capacity (Assorted)

Read—max capacity (Assorted)

Final Scores

Features 1

Performance (out of 50)

Price 2

Grand Total (out of 100)

Price (Rs)

Warranty (years)

Scoreboard                             Flash Drives (512 MB)
JANUARY 2007

* For 512 MB drives - 50 MB
1 GB drives - 700 MB

1 512 MB drives - out of 15 
1 GB drives - out of 10
2 512 MB drives - out of 35 
1 GB drives - out of 40
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Biometric scanner

Heavy

Cheap

Slow

Good software bun-
dle
Slow

Fast

Poor package 
bundle

Looks different

Slow

Inexpensive

Poor build quality

External display

Looks gaudy

SanDisk

Cruzer Profile 512 MB

512 MB

483 MB

Biometric scanner

Syncing software

✔

Lanyard

8

9

0.6

18.2

5.8

21.9

1

9.6

1.4

61

1.7

83

7.9

613

18.2

23.45

22.66

5.58

51.69

1345

2

Corsair 

Flash Voyager 1 GB

1 GB

977 MB

Password protection

Corsair sync utility

✔

Lanyard, USB cable

8

7

30.3

18.6

9.3

20.2

1

96

21.3

100

28

130.9

40.4

134

18.6

26.80

18.57

4.67

50.03

1500

10

TECH-COM

512 MB

512 MB

460 MB

Password protection

✖

✔

Lanyard, USB cable

6

7

1.6

10.7

3.2

10.8

2

17

1.4

27.6

1.8

147

10.9

240

26.6

15.75

16.08

13.64

45.47

550

3

Zion

512 MB

512 MB

495 MB

✖

✖

✔

Lanyard, USB cable,

retention cap

8

6

38.6

23.8

16.8

25

8

5.8

1.1

28.9

1.5

50.3

8.7

256.2

10.2

9.80

30.33

10.00

50.13

750

3

Gigabyte

Flash Disk 1 GB

1 GB

961 MB

Password protection

✔

Lanyard

6

6

1.7

11.4

5.4

12.1

1

131.2

62.6

131.3

63.5

166.1

79.6

168.7

80.7

24.80

11.44

4.38

40.62

1600

1

Transcend 

JetFlash V30 512 MB

512 MB

491 MB

Password protection

PC lock, secure zip 

✔

Lanyard

6

5

5.7

15.5

4.2

16.4

8

16.8

1.5

206

1.9

134

8.7

720

31

19.60

15.48

8.33

43.41

900

Lifetime

Corsair

Flash Readout 1 GB

1 GB

997 MB

Password protection

PC Lock, secure zip

✔

Lanyard, USB cable

6

6

53.9

22.8

10.4

25

11

84.6

11.5

135.7

20.2

107.1

34.7

149.6

32

25.60

17.77

3.89

47.26

1800

10

iball

1 GB

1 GB

983 MB

Password protection

Partition software

✔

Lanyard, protective

case

6

5

8.6

14.9

4.6

17.5

5

186.1

29

220

43.9

241

60.9

274.2

56.8

23.20

10.69

9.33

43.22

750

2

Rubber body

None in particu-
lar

Flash Drives (1 GB)
JANUARY 2007JANUARY 2007
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Package bundle

None in particular

Reasonable price

Slow

U3 Software

Slow

Reasonable price

Slow

Reasonable price

Slow

Good software
bundle
Slow

PQI

Cool drive U339S 1 GB

1 GB

953 MB

Password protection

U3

✔

Lanyard, USB cable

6

7

0.5

11.5

6.2

11.7

4

124

33.3

131

40.3

162

84

165

60

26.00

11.71

5.19

42.90

1350

Lifetime

PQI

Travelling Disk U260 1

GB

1 GB

983 MB

Password protection

PC Lock, secure zip

✔

Lanyard

6

7

4.7

12.8

2.3

13.1

1

335

21.3

351

20.8

440

74.4

468

23.3

25.20

10.93

7.57

43.69

925

Lifetime

Odyssey

1 GB

1 GB

1000 MB

Password protection

✔

Lanyard

7

7

111.3

7.4

5.3

10.9

1

151.9

68.3

246.4

52.4

267.9

53.4

302.2

68.7

25.60

9.23

7.18

42.01

975

2

PQI

Cool drive U339 1 GB

1 GB

999 MB

Password protection

PC Lock, secure zip

✔

Lanyard, USB cable

6

6

68

10.8

7.5

11

6

106

67

109

42.5

136

54

142

62

25.60

11.10

5.60

42.30

1250

Lifetime

PQI

Travelling Disk U230

1 GB

995 MB

Password protection

PC Lock, secure zip

✔

Lanyard

6

6

0.8

11.1

2.1

11.2

4

424.3

61.8

441.8

38.9

565

64

576.7

63

24.80

7.85

7.57

40.22

925

Lifetime

Lexar

JumpDrive FireFly 1 GB

1 GB

965 MB

Password protection

Google software 

✔

✖

6

6

1.7

9.8

2.6

9.9

2

363.5

13.1

376.6

64.9

466.5

96.5

482.9

97.1

22.40

7.34

3.68

33.43

1900

5

BRAND

MODEL

Features

Storage Capacity (Stated)

Storage Capacity (Actual)

Security

Software features

Visual indicators such as an LED etc.

Other accessories provided

Build quality (Scale of 10)

Sturdiness of the overall package

Cap locking mechanism 

Performance

HD-Tach 3

Random Access Time

Average read speed

Average write speed

Read burst speed

CPU utilisation

File Transfer Test (seconds)

Write—700 MB (Sequential)

Read—700 MB (Sequential)

Write—700 MB (Assorted) 

Read—700 MB (Assorted) 

Write—max capacity (Sequential)

Read—max capacity (Sequential)

Write—max capacity (Assorted)

Read—max capacity (Assorted)

Final Scores

Features (out of 40)

Performance (out of 50)

Price (out of 10)

Grand Total (out of 100)

Price (Rs)

Warranty (years)

Scoreboard                             Flash Drives (1 GB)
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Small form factor

Fragile

U3 software

Slow

Looks Different

Poor package 
bundle

Rugged build

Poor package 
bundle

Good package
bundle
Slow

Good package
bundle
None in particular

Fast

Poor package 
bundle

PQI

Intelligent Stick 1 GB

1 GB

983 MB

Password protection

✔

Casing, stick slot

6

5

102.8

0.8

5.1

12.1

1

284.4

12.71

312.5

53.5

368.1

83.4

400.6

20.2

15.60

9.83

5.60

31.03

1250

Lifetime

TECH-COM

1 GB

1 GB

939 MB

Password protection

✖

✔

Lanyard, USB cable

6

6

6.3

9.9

2.9

10.4

1

249.1

31.9

251.4

72.1

321.6

94

322.8

92.9

25.60

8.43

9.33

43.37

750

3

SanDisk

Cruzer Micro 1 GB

1 GB

971 MB

Password protection

U3

✔

Lanyard

6

8

0.9

13.7

5.3

18.8

5

152.1

12.6

167

22.6

203.2

41.3

215.5

36.9

25.60

12.80

5.20

43.60

1345

2

SanDisk

Cruzer Titanium 1 GB

1 GB

976 MB

Password protection

U3

✔

Lanyard

8

6

0.9

13.3

8.7

18.8

1

96.7

12.28

105.6

34.3

153.2

69

167.4

67.3

25.60

14.75

4.13

44.47

1695

5

Transcend

JetFlash V30 1 GB

1 GB

967 MB

Password protection

PC lock, secure zip

✔

Lanyard

6

6

0.6

11.9

3.5

12.7

6

371.4

12.8

397

27.4

430.2

54.1

507

48.2

24.80

9.44

5.83

40.07

1200

Lifetime

SanDisk

Cruzer CrossFire 1 GB

1 GB

976 MB

Password protection

CSI3 demo

✔

Lanyard

6

7

0.7

16.2

5.4

20.2

5

145.5

21.3

155.1

38.3

193.2

50.7

201.7

49.65

25.20

13.25

5.20

43.65

1345

2

Transcend

JetFlash 150 1 GB

1 GB

979 MB

Password protection

PC lock, secure zip

✔

Lanyard

6

6

0.6

14.5

13.6

15.7

1

60

13.1

62

22.9

79.5

64

82.9

22.5

24.80

20.85

4.67

50.32

1500

Lifetime

Transcend

JetFlash 130 1 GB

1 GB

997 MB

Password protection

PC lock, secure zip

✔

Lanyard, two extra

caps

6

6

59.6

0.8

9.9

11

1

87.2

29.85

100.8

71

129.6

90.2

136.4

95.6

25.60

10.95

4.67

41.21

1500

Lifetime

Cheap

Slow

Flash Drives (1 GB)
JANUARY 2007
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Transparent 
casing
Slow

None

Slow

Fast

Poor Package 
bundle

Rubber body

Expensive

Cheap and fast

Poor build quality

Package bundle

Slow

Zion

1 GB

1 GB

991 MB

✖

✖

✔

Lanyard, USB cable,

retention cap

8

6

0.7

9.5

13.1

14.6

2

64.8

11.9

69.5

38.7

84

68.6

91.7

75.6

11.20

16.29

6.51

34.00

1075

3

Corsair

Flash Voyager 2 GB

2 GB

1.9 GB

Password protection

PC lock, bootable

✔

Lanyard, USB cable

6

8

29.8

17.9

10.5

20.2

1

91.6

11.7

97.5

34.7

231.1

105.4

266.7

100.7

27.45

34.30

1.67

63.41

3300

10

UMAX

APUS ELITE 1 GB

1 GB

983 MB

✖

✖

✔

✖

6

6

7.1

10.1

2.6

10.1

1

340.1

44.7

345.9

80.3

438.7

92.2

439.8

96.3

6.40

7.90

5.60

19.90

1250

2

UMAX

APUS 210 1 GB

1 GB

960 MB

✖

✖

✔

✖

6

5

53.2

21.3

4.4

27.6

5

134.5

38.53

160.4

59.8

287.6

84.3

292.3

86

6.00

12.91

5.38

24.30

1300

Lifetime

iball

2 GB

2 GB

1.91 GB

Password protection

Partition

✔

Lanyard, protective

case

6

5

8.6

23.3

5.7

30.9

3

95.1

25.7

142.5

24.2

298.4

63.9

353.8

83

26.10

29.97

4.04

60.11

1360

2

UMAX

APUS PRO 1 GB

1 GB

979 MB

Password

Secure zip, bootable

✔

Lanyard, USB cable

6

6

5.6

10.8

3.1

10.9

4

235.4

42

236.8

69

299

90.7

309.4

89.5

25.60

7.72

4.83

38.15

1450

Lifetime

BRAND

MODEL

Features

Storage Capacity (Stated)

Storage Capacity (Actual)

Security

Software features

Visual indicators such as an LED etc.

Other accessories provided

Build quality (Scale of 10)

Sturdiness of the overall package

Cap locking mechanism 

Performance

HD-Tach 3

Random access time

Average read speed

Average write speed

Read burst Speed

CPU utilisation

File Transfer Test (seconds)

Write - 700 MB (Sequential) 

Read—700 MB (Sequential)

Write—700 MB (Assorted) 

Read—700 MB (Assorted) 

Write—max capacity (Sequential)

Read—max capacity (Sequential)

Write—max capacity (Assorted)

Read—max capacity (Assorted)

Final Scores

Features 1

Performance (out of 50)

Price 2

Grand Total (out of 100)

Price (Rs)

Warranty (Years)

Scoreboard                             Flash Drives (1 GB)
JANUARY 2007

1 1 GB drives 40
2 GB drives 45

2 1 GB drives 10
2 GB drives 5
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Good software bun-
dle
Slow

Fast

Poor Package 
bundle

Fast

Poor package 
bundle

Looks Different

Poor package 
bundle

Fast

Poor package 
bundle

Good package 
bundle
Slow

Lexar

JumpDrive FireFly 2 GB

2 GB

1.88 GB

Password protection

Google software

✔

✖

6

6

1.7

9.8

2.7

9.9

2

358.9

14.3

377.9

62.3

738.3

103.9

764.7

108.2

22.95

18.75

1.58

43.29

3475

5

TECH-COM 

2 GB

2 GB

1.9 GB

Password protection

✖

✔

Lanyard, USB cable

6

6

8.7

9.4

3

10.4

1

192.6

21

260

54

653.1

184.3

708.5

196.7

26.55

17.02

4.23

47.80

1300

3

SanDisk

Cruzer Titanium 2 GB

2 GB

1.86 GB

Password protection

U3

✔

Lanyard

8

6

0.9

13.3

8.7

18.8

1

96.7

12.28

105.6

34.3

262

87.5

274.3

89.6

26.55

33.17

1.38

61.10

3995

5

SanDisk

Cruzer CrossFire 2 GB

2 GB

1.9 GB

Password protection

CSI3 demo

✔

Lanyard

6

7

0.6

14.7

8.8

19.4

1

100.3

13.3

98.3

36.4

244.4

115.9

264.1

109.6

26.10

32.55

2.04

60.69

2695

2

Zion

2 GB

2 GB

1.92 GB

✖

✖

✔

Lanyard, USB cable,

retention cap

8

6

8

11.3

8.5

11.7

4

89.7

14.1

94.3

64.8

238.6

171.3

240.8

171.7

12.60

26.10

3.14

41.84

1750

3

SanDisk

Cruzer Micro 2 GB

2 GB

1.86 GB

Password protection

U3

✔

Lanyard

6

6

0.9

13.2

8.5

18.8

1

91.5

12.4

98.6

36.9

264.5

80.6

292.3

109

25.65

32.60

2.04

60.29

2695

2

Transcend

JetFlash V30 2 GB

2 GB

1.88 GB

Password protection

PC look, bootable

✔

Lanyard

6

6

0.6

12.2

3.1

12.5

3

529

18.1

460

61

653.1

184.3

708.5

196.7

25.65

17.15

2.75

45.55

2000

Lifetime

Cheap

Slow

Flash Drives (2 GB)
JANUARY 2007
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Fast

Expensive

U3 software

Poor Package 
bundle

Inexpensive

Lack of software 
features

Good software bun-
dle
Slow

Rugged build qual-
ity
None in particular

TECH-COM 

4 GB

4 GB

3.75 GB

Password protection

✖

✔

Lanyard, USB cable

6

6

9

9.6

2.7

10.4

1

180.3

12.7

192.5

43.5

869.5

272

912.8

259.3

26.55

17.27

4.90

48.72

2550

3

Transcend

JetFlash V30 4 GB

4 GB

3.77 GB

Password protection

PC lock, bootable

✔

Lanyard

6

6

0.6

15

5.8

15

1

180.3

12.7

192.5

43.5

918.7

272

1013.6

259.3

25.65

20.99

3.13

49.77

4000

Lifetime

SanDisk

Cruzer Micro 4 GB

4 GB

3.8 GB

Password protection

U3

✔

Lanyard

6

6

0.9

13

8.5

18.8

4

91.6

12.5

102.2

36.1

232.7

109.3

272.4

110.8

25.65

30.98

2.93

59.56

4265

2

SanDisk

Cruzer Mini 4 GB

4 GB

3.8 GB

✖

✖

✔

Lanyard, two extra

caps

6

6

0.6

14

8.7

18.7

1

84.3

11.8

98.2

34.5

451.4

211

631.2

225.3

10.80

26.96

2.94

40.70

4256

2

Kingston

Data Traveler 4 GB

4 GB

3.75 GB

Password protection

PC lock, bootable

✔

✖

8

6

0.5

14.1

13.7

26.3

4

58.9

12.1

56.8

21.3

279.2

161.7

282

164.1

23.85

36.15

2.98

62.98

4200

5

BRAND

MODEL

Features

Storage Capacity (Stated)

Storage Capacity (Actual)

Security

Software features

Visual indicators such as an LED etc.

Other accessories provided

Build quality (Scale of 10)

Sturdiness of the overall package 

Cap locking mechanism 

Performance

HD-Tach 3

Random Access Time

Average read speed

Average write speed

Read burst speed

CPU utilisation

File Transfer Test (seconds)

Write—700 MB (Sequential) 

Read—700 MB (Sequential) 

Write—700 MB (Assorted) 

Read—700 MB (Assorted) 

Write—max capacity (Sequential)

Read—max capacity (Sequential)

Write—max capacity (Assorted)

Read—max capacity (Assorted)

Final Scores

Features (out of 45)

Performance (out of 50)

Price (out of 5)

Grand Total (out of 100)

Price (Rs)

Warranty (years)

Scoreboard                             Flash Drives (4 GB)
JANUARY 2007 JANUARY 2007



84 DIGIT JANUARY 2007

Digital Tools l Flash Drive Test

out because of its lacklustre bundle, but we
still recommend it to those who want a
decent, fast drive with a good storage capacity.

4 GB DRIVES
We received five drives under this category—two
from SanDisk and one each from Kingston,
TECH-COM, and Transcend. This category is for
those who want to carry a Flash drive instead of
a DVD. With its storage capacity coming quite
close to that of a DVD, these drives can very well
carry your HD movies. This category is not for
those on a budget though—if you don’t mind the
slower speeds and larger size, you’re much
better off with a portable hard drive; you’ll get
much more storage at a
lower price.

Phone Web SiteCompanyBrand

Contact Sheet

A-DATA
Corsair
Gigabyte
iball
Intex
Kingston
Lexar
Odyssey
PQI
SanDisk
TECH-COM
Transcend
UMAX
Zion

KMI Business India Ltd
Tirupati Enterprises
Gigabyte Technology India Ltd
Best IT World (India) P Ltd
Intex Technologies (I) Ltd
Kingston Technology Company, Inc.
Neoteric infomatique P ltd
Compuage Infocom Ltd 
Mediatech India Distribution P Ltd 
Rashi Peripherals P Ltd
TECHCOM INDIA
Mediaman Infotech P Ltd
Neoteric infomatique P Ltd
Abacus Peripherals P Ltd

022-30224715
033-22251192/93
022-30616666
022-30815032
1800-116789
1800-4254515 
022-39828600 
022-2384220 
022-26361111
022- 67090909
011-26428541/42
022-23828100
022-39828600 
022-40914609

www.adata.com.tw
www.tirupati.net
www.gigabyte.in
www.iball.co.in
www.intextechnologies.com
www.kingston.com/india 
www.neoteric.co.in
www.compuageindia.com
www.mediatechindia.com
www.rptechindia.com
www.techcomindia.com
www.mediamangroup.com
www.neoteric.co.in
www.abacusperipherals.com

Flash Drives

A Decision Maker
You need it for...
Occasional data transfer 
Transferring photos and
movie clips
Data backup and as a
bootable drive

We recommend
A-DATA Oriental 512 MB, Zion 512 MB
Corsair Flash Voyager, Transcend JetFlash
150 1 GB
SanDisk Cruzer Micro 2 GB, Kingston Data
Traveler 4 GB

Features
Due to their lower market share and a very niche
user segment, the feature set of this category is
mediocre. The SanDisk Cruzer Micro was the
only U3 drive, and came with the earlier-
mentioned software bundle. 

Build Quality And Bundle
The Kingston is the best-looking drive in this
category, with a nice matte finish that will make
scratches less visible. Most of us tend to misplace
Flash drive caps, and SanDisk has provided two
extra caps with the drive.

Performance
Typically, higher capacity drives don’t offer
much speed, but the Kingston took less than
a minute to transfer the 700 MB video—faster
than even the fastest 1 GB drive. The SanDisk
Cruzer Mini lagged a bit, taking 84.3 seconds.
The slowest of the lot were the TECH-COM and
Transcend JetFlash V30, taking almost three
minutes. The full-capacity assorted file saw
the SanDisk Cruzer Micro

taking just 272.4 seconds, with Kingston
following at 282 seconds. Transcend sat the
race out at a leisurely 17 minutes!

In Sum
Kingston takes Gold for its vastly superior
performance and build quality. The SanDisk
Cruzer Micro wins the Silver for the balance it
strikes between speed and software bundle. We
must note that there is not much difference in
the prices of these drives, but when it comes to
performance, things are different. 

vishal_kansagra@thinkdigit.com

With a whopping 8 GB of storage space, the
Transcend JetFlash 8 GB sounds really

good. The drive is quite fast: it took just 56.4
seconds to transfer a 700 MB video file. The
drive is a good bit bigger than the other drives (it
was the biggest we tested), but the build quality is
strictly average. When you look at the price tag, though, you
might start looking elsewhere—it costs an atrocious Rs 9,500. For
that kind of money, you could invest in an 80 GB external drive, or if you
don’t mind carrying some extra weight and cables, use a regular 400 GB
SATA drive with an external casing to build your own backup behemoth!

Transcend JetFlash 8 GB

JA N U A RY  2 0 0 7

JA N U A RY  2 0 0 7

SanDisk Cruzer Micro 4 GB
Fast, with a good software bundle

Kingston DataTraveler Secure 4 GB
Superior performance
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Arvind Subramanian

RAID is the abbreviation for
“Redundant Array Of
Independent Disks.” It

refers to the technology of stor-
ing data with a higher degree of
protection and/or performance
than regular storage.

There are many different
“levels” of RAID, and typical
examples are RAID 0, RAID 1,
RAID 1+0, RAID 0+1, RAID 3+0,
and many more. At each level,
RAID takes a different approach
to the storage of data.

RAID works on the concepts of
Data Mirroring, Data Striping, and
Parity Checks. That’s where the
levels come in: RAID 0 uses only
striping, RAID 1 uses only mirror-
ing, and further levels include
parity checks and/or a combina-
tion of these. You get many per-
mutations as a result, but RAID
always uses at least two hard disks
that work as a single unit.

The Basic Concepts
Data Mirroring
Simply put, mirroring means
making simultaneous writes of
the same block of data on multi-
ple disks. That’s where the
“Redundant” in “RAID” comes
from. It is expensive but far from
redundant in transaction- and
data-intensive applications such
as accounts, finance, and bank-
ing. In the case of a hard disk
crash, data can be restored from
a “mirrored” disk.

Data Striping
Here, a stream of data is divided
into blocks, and each block is
written to a different disk in the
array. The writing of the blocks
takes place concurrently after
the division, thus increasing the
speed of the write operation.
Concurrent reads, too, are faster:
if you need 10 KB of data, 5 KB
can come from each disk at the
same time, so theoretically, you get
double the data rate. This, how-
ever, is a broad generalisation.

Parity Checks
A “parity check code” is generated
during the write of every block of

data. This code helps the RAID
system recognise the data. During
a read of the same block, the
parity check code is again gener-
ated, and this is matched with the
parity check code generated
during the write. Now, the parity
code generated during the write
is stored on one of the disks in the
array, and this increases the relia-
bility of the data—and thus that of
the entire database in use.

What RAID Can Do
RAID levels 1, 0+1, 1+0, 5, 6, 5+0,
and 5+1 allow a single hard disk
to fail while keeping the data on
the system accessible to users.
Users in general would not realise
that a disk has failed, and would
continue to work normally. The
use of RAID allows the disk in
question to be changed, and the
data restored and updated, with-
out hampering work. Data from
the working disk can then be mir-
rored back on to a new disk.
Backups taken on tape or on a
separate hard drive are not
“online” or in real-time; there
will necessarily be a delay before
the system can be restored.

In RAID levels that use strip-
ing, at the byte (RAID 3) level,
each byte of the stream is stored
on a different disk; at the bit
(RAID 2) level, data is broken
down into bits and then stored on
different disks. This is very useful
in applications that deal with
large image files, as well as video
editing applications, which
demand a good amount of speed.

What RAID Cannot Do
RAID can help in the recovery
and restoration of data, but it
cannot protect it. It cannot, for
example, stop viruses or mali-
cious code from attacking data.
Any such attack will cause simul-
taneous and equal harm to all
the disks in the system.

RAID does not simplify disas-
ter recovery. Restoration from tape
backups is still much simpler
than recovery from a disk
attached to the array in question.

RAID also cannot provide a
performance boost to all running
applications. Increasing the data
transfer rate does little to help

desktop users,
since most files
that are accessed
are typically very
small. Disk striping
using RAID 0
increases the per-
formance of a
sequential read
/write operation—
such as one for a
single, large video
file—but does hardly
anything for a
random seek. For users
with high performance as a
goal, it is better to buy a faster and
bigger single disk with a higher
rpm and buffer than to run two
smaller drives under RAID 0.

Problem Areas
RAID systems are not easily inter-
changeable, unlike the case with
single disks. The RAID BIOS, which
controls the reads and writes of
the data to the disks in the array,
must be made available to the
operating system. Moreover, RAID
controllers make use of different
formats depending on the level
used. Even moving the controllers
to a new system might see a degra-
dation in performance.

Proprietary RAID
Different vendors have their own
adoptions of RAID:

DVRAID by ATTO technology:
This was developed for digital
audio and video applications,
which typically require a lot of
speed. RAID 0 provides speed but
not fault tolerance. ATTO used
the striped parity concept, where
a parity check code is generated,
and the code itself is striped and
stored across disks.

RAID S or Parity RAID by EMC
Corporation: A single disk is used
to store the parity check code, the
difference being that it is distrib-
uted across different volumes. 

MATRIX RAID—Intel ICH6R
RAID BIOS: Nothing new,
except for the fact that each disk
in the array acts as RAID 0 as
well as RAID 1.  

arvind_subramanian@thinkdigit.com

More than one hard disk need not just mean more partitions

Imaging Pradip Ingale

RAID
Digital Tools l Know More About
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Networking 101
I have two PCs—one a 2.4 GHz Intel and the
other a 2.8 GHz. I need to connect them to be

able to transfer data between them. How do I do this?
Ashish Singh

If you wish to connect two PCs to each other,
they both need to have network cards

installed. You’ll also need what is called a
crossover cable. Now, first make sure File and
Printer Sharing is enabled: open Network
Connections in the Control Panel, right-click on
Local Area Connection, and select Properties. In
the General tab, look for “File and Printer Sharing
for Microsoft Networks” and make sure the
checkbox next to it is selected. (If it isn’t in the
list, go to Install > Services > Add and choose this
service to add it.) Now return to the General tab,
select “Internet Protocol (TCP/IP)” and click on
Properties. Enter an IP address such as
“192.168.1.10” and a Subnet Mask of 255.255.255.0
for one computer, and the IP address
“192.168.1.11” and the same Subnet Mask for the
other. Now, for a particular folder that is to be
shared, right-click on it and click on “Sharing and
Security”. Enter the share name of the folder and
click OK. Connect the two computers using the
crossover cable. You should now be able to access
the contents of the shared folders on one
computer from the other.

First Things First
Ubuntu Linux dual-boots with XP on my
computer. By default, the computer boots into

Ubuntu. What do I need to do so that it boots into XP
by default?

Mohnish Negi

Ubuntu uses the Grub bootloader to manage
the boot sequence. This can be configured

from within Ubuntu. Boot into Ubuntu; you’ll

need to install a tool known as Startup Manager.
First install imagemagick:

sudo apt-get install imagemagick

Download the Startup Manager (SUM.tar.gz) from
www.ubuntuforums.org/showthread.php?t=295
524. Extract the file using

sudo tar xzvf SUM.tar.gz

You’ll now have a directory called SUM. Use

cd SUM
. /install.sh

Once the installation is done, go to System >
Administration > Start-Up Manager. This will
open the window that can be used to select vari-
ous boot options such as default boot entry, time-
out, resolution, and more. Select “Windows”
from here and click Close.

Here To Stay?
I installed Microsoft Office 2007 Professional
Pre-release Beta 2, which was distributed on

your DVD. I’ve had enough of it and wish to revert to
Office 2003, which was installed earlier. But I can
neither uninstall nor reinstall Office 2007. If I select
“Change”, I get the message:
“This product installation has been corrupted. Run
setup again from CD, DVD, or other original source.”

On choosing Remove, the setup screen shows
up for a second and then disappears without a
message. Please help.

Zahid Irani

This is a known issue with the installation of
MS Office 2007 Pro Pre-release Beta 2—a bug

with the installer which cannot correctly read
the Microsoft Windows Installer information
from an earlier Office installation in the Registry.
To fix the issue, download and install Windows
Installer Cleanup utility, msicuu2.exe, from
http://tinyurl.com/42ul9 (http://download.
microsoft.com/download/e/9/d/e9d80355-7ab4-

Your Questions, Our Answers

Select Windows in the Boot Options

Remove registry entries using Windows Installer Clean Up
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45b8-80e8-983a48d5e1bd/msicuu2.exe). This is a
350 KB file. Now go to Start > Programs >
Windows Install Clean Up. Select Microsoft
Office 2007 Professional Beta 2 from the list and
click the Remove button. Click OK and then Exit.
The program deletes only the Office-related
Registry entries. The Office 2007 files will remain
on the hard disk, so you will have to manually
delete them. You will now be able to install any
version of Office.

Scan, Select, Save
I inadvertently deleted an extended partition on
my Seagate 40 GB PATA drive. Can I recover the

lost data?
Arvind Kumar Sharma

As long as your hard drive is recognised by
the BIOS, and as long as it has not suffered

mechanical damage, you can attempt to
recover data from it using software such as the
free PC Inspector File Recovery. Download this
6 MB file from www.pcinspector.de/file_
recovery/UK/welcome.htm. Install and launch
the program. Click on Lost Drive on the left
and wait for PC Inspector to scan your hard
drives and determine the available partitions.
Select your drive in the Logical Drives tab and
click on Preview to verify the drive’s contents.
Click on the tick-mark to start the scan. After
the scan is complete, you will be able to view
the recoverable contents of the drive. You can
select all or any of the files to recover. Right-
click on them and select “Save to”. Choose a
drive or folder to save the recovered files to.

Mode Madness
My computer has become very slow, and
copying files from one drive to another has

become a frustrating affair. I checked the DMA
settings in the device manager and found that my
hard drive is operating in PIO mode, even though
the “DMA if available” option is selected.

Nav S

Every time Windows boots, it checks each
storage device to determine the highest

performance that it will offer. If it encounters any
problems, such as a faulty cable, it falls back to
the next lower speed available, which is from
DMA to PIO mode in your case. Replace your hard

drive’s data cable. Open the Device Manager and
under “IDE ATA/ATAPI Controllers”, delete your
hard drive controller. Restart Windows; your hard
drive should start functioning in DMA mode.

One K = One Thousand?
My 80 GB hard disk shows up as 76 GB in
Windows Explorer. Where is the remaining 4

GB of space? Have I been cheated? I’d also like to
ask you: while capturing from my Sony handycam
(mini DV) to the PC using the bundled Picture pack-
age software, it captures in parts; these segments
are of 10 minutes length. So when I capture a 60-
minute video, I get six segments.

Shashishil Kshatriya

Drive manufacturers specify drive capaci-
ties in “Giga Bytes.” (A Giga Byte is equal

to 1024 “Kilo Bytes” and a Kilo Byte is equal to
1024 Bytes.) But they measure the capacity
using 1000 as the multiplier. Specifying the
capacity in this way is a marketing gimmick—
it shows a larger number. So an “80 GB” hard
disk has a capacity if 80 x 1000 x 1000 ÷ 1024 ÷
1024, which is equal to 76.29 GB. This is the
capacity you see in Windows Explorer.

Most software capture the digital video
content from a DV camera by default in multi-
ple segments. This is known as Scene Detection,
where the software tries to recognise major
changes in scene. When it encounters such a
change, it stops capturing to the current file
and continues into the next file. This is to facil-
itate creating chapters on DVD. It increases file
manageability. You will need to explore the
options in your capture software to be able to
disable this option and capture the video as a
single file.

Amnesia
Is it possible to recover Excel passwords?

Prabhu Karthikeyan

There are many tools available to recover
passwords for Excel files. Some of these are

AOPR 3.11 from www.elcomsoft.com/aopr.html
(�49—Rs 3,000—for the Home Edition), Excel Key
from www.lostpassword.com/excel.htm ($45; Rs
2,000), and Excel Password from http://lastbit.
com/excel/ ($39; Rs 1,750).

Fantelligence!
I have an Intel Pentium 4 2.6 GHz on an Intel
915GAV motherboard. Whenever I run two or

three applications or when I run a game, the CPU
fan runs very fast and makes a lot of noise.

Sagar Ranjankar

This is normal. Your BIOS supports variable
fan-speed control. The fan spins slow when

the CPU is idle or under little load. It spins the
fastest when the CPU is stressed, such as when
running a game, editing video, or anything else
that is CPU-intensive. Automatic fan control
ensures better balance between cooling and the
noise generated by the fan.

PC Inspector File Recovery
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Host A Web Server On Your Home PC
Share your treasures with the world, its easy!

Jayesh Limaye

Many of us have at some point toyed
with the idea of hosting a Web site.

But be it the prohibitive Web hosting
costs of days long gone by, or how
complex we’ve imagined it to be, or just
plain laziness, few of us have actually
gotten down to doing it! The fact is, it
can be done for free, and it’s just about
as difficult as maintaining a blog. Here’s
a workshop on how to go about it.

Download And Run The
Software
Head to www.rejetto.com/hfs/

?f=dl and download Http File Server
(HFS). It is free and open source, and is a
standalone executable that requires no
installation.

On XP with SP2, when you run HFS,

you will be asked about whether or not
to allow hfs.exe to connect to the
Internet. Unblock HFS. Likewise, if you
have a third-party firewall installed,
configure it appropriately.

Configure The Port
By default, HFS uses port 80. If
your firewall is blocking port

80, set HFS to use some other port (such
as 8080 or 8245 and so on). To change
the port number, turn HFS off by click-
ing on the green “On” button at the
upper left corner. Change the port and
turn HFS back on.

Also, if you are behind a router or
firewall, you may, in some rare cases,
need to set up port forwarding. The
best way to go about this is to go to
www.portforward.com. There, choose
your router type, then choose the
program you want to set up port
forwarding for, which in our case is
HFS. In such a scenario, you cannot
proceed unless you know which router
you are using.

Test HFS
To test whether your settings
work, click the Menu in HFS and

choose “Self Test”. If the test completes
successfully, your settings are correct.
You should now be able to point your
Web browser to your IP address and see
HFS’ default Web page.

Register A Domain
For setting up a Web site, you
need to first assign it a domain

name. For this, you need a DNS service
running on your computer. You need to
get one from a site that offers such a
service. There are quite a few sites that
offer such services, and we’ve chosen No-
IP. This site offers a variety of free sub-
domain names that you can register for
your Web site.

Go to www.no-ip.com/newUser.php
to create a No-IP account. Log on to the
site with the account you created, and
click on the Services button. Click on
“Hosts / Redirects” on the left and then
on Add. In the page that opens, enter a
hostname of your choice and select from
amongst the free domains available.
Then choose the host type; “DNS Host”
(Option A) is usually the best option.

Your ISP might be blocking inbound
port 80; to get around this, choose “Port
80 Redirect”. When you use this and run
your Web server on an alternative port,
users will not need to type a port
number in the URL.

Click on “Create Host”. Your domain
will be available within five minutes of
registration. You can use and give out
this domain name instead of your IP
address.

If you would like to use a domain
name of your own, No-IP offers a custom
DNS service for a yearly fee.

Install the Dynamic DNS
Update Client
Skip this step if you have a

static IP. If you don’t, you will need a
client software to take care of your
changing IP address. Go to www.no-
ip.com/downloads.php?page=win to

download the No-
IP.com Dynamic
DNS Update
client software.
Install it and
provide your
login details. This
program will sit
in the system

tray and automatically update your No-
IP account when your external IP
address changes. 

Launch Your Web Site
You can now decide what page
will appear when someone

types in the name of your Web site. To
change the default page, open HFS and
click on “You are in Easy mode” to turn
on Expert mode. Right-click on the
little “house” icon in the Virtual File

System (VFS) and click on “Bind root to
real-folder”. When prompted, point to
the folder that contains the file you
wish to display by default on your site.
Click on “Default file mask…” and type
in the name of the file you’ve chosen
for this file, such as “index.html”. Press
[Ctrl] + [S] to save the VFS to any loca-
tion on your hard disk.

If it is only files you wish to share
with friends, you can just host the files
on the site—an index.html is not neces-
sary. Just drag and drop files into the
VFS window and save the VFS. These
files will be available for download
from the opening page.

To make HFS start with Windows,
choose Start/Exit > Run HFS when
Windows starts. Also make sure to
checkmark “Reload on startup VFS file
previously open”. You’re done!

The method of Web hosting we’ve
described is good enough if you wish to
share files with friends or to create
content for a few people to view. It is
not recommended for high-traffic situa-
tions, though.

jayesh_limaye@thinkdigit.com

Http File Server

Log in to No-IP

No-IP Dynamic DNS Update Client
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Dusty, Dirty, Defunct
My LG USB drive was working fine for the
past one year. Now, when I connect it to my

computer, it does show up as a removable disk in
Windows Explorer, but the computer hangs when
I click on the icon. Another problem is, when I use
the “Safely Remove Hardware” from the System
Tray, the notification message “Your USB storage
device can now be safely removed” message pops
up, but after a few seconds, the “Safely Remove
Hardware” icon disappears.

This only happens on my home PC—the drive
works fine on my office computer.

Kaushik Dey

This problem usually occurs if your USB
port has become dirty due to accumula-

tion of dust, or if it has become loose because
of wear and tear caused by plugging and
unplugging of the drive. Clean it using a paint-
brush and try to see if the problem goes away.
Try using a different free USB port, or adding
a port if you don’t have one. As far as your
second query is concerned, it is normal for 
the “Your USB storage device can now be 
safely removed” message to go away after a 
few seconds.

DirectZip?
I have an Intel Pentium 4, 2.66 GHz, 256 MB
RAM, and a 64 MB graphics card. Dungeon

Siege 2 Demo didn’t run on my PC—I got the
message “D3D initialization Failed.” I thought it
was because I didn’t have DirectX 9.0c, but when I
try installing it, setup runs and completes in just
one second. Why?

Sahil Sharma

You haven’t mentioned your graphics card
chipset, and your issue is linked to dated

graphics card drivers. Please update to the latest
drivers from your graphics chipset’s manufac-
turer’s Web site—www.nvidia.com or
www.ati.com, as the case may be. Also, run

DXDIAG and see if DirectDraw and Direct3D
acceleration is enabled. If it isn’t, enable it.

DirectX 9.0c setup completes very quickly
because you already have that version installed.

Forget It!
Any information entered in a Microsoft Word
2003 Wizard (such as the Resume Wizard)

gets stored in the Registry, so when you call up the
Wizard again, you can view the old information. We
have many users working at the same computer,
and the nature of our work is such that we do not
want such information to persist after a session is
done. What can I do?

Rohit Bhatt

The data is stored in
H K E Y _ C U R R E N T _ U S E R \ S o f t w a r e \

Microsoft\Office\11.0\Word\Wizards You can
clear all the Wizard information each time the
computer starts. Open Notepad and type in
these two lines: 

REGEDIT4
[-HKEY_CURRENT_USER\Software\Microsoft\
Office\11.0\Word\Wizards]

Save this file with the name “wizfix.reg”.
Include the quotes to ensure that Notepad
doesn’t save the file as a TXT file rather than
as a REG file.

Now click on Start > All Programs, and find
the Startup menu in the list. Right-click on it
and choose Open All Users. Windows Explorer
will open, displaying the shortcuts that define
the menu items under the Startup folder.
Right-click in an empty area and choose New >
Shortcut. Enter “REGEDIT -S
C:\Path\wizfix.reg” in the “Type the location
of the item” dialog box, and click Next (assum-
ing you saved the file to C:\Path). Give the item
a name of your choice, such as “Delete Wizard
data” and click Finish. The registry entries will
be removed every time you start up.

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

The Need For Speed
I use Windows Server 2003. My printer prints very slowly—at
a speed much lower than advertised. What could be the

problem?
Ritesh Patil

Printers always print at speeds lower than what the
manufacturers advertise. However, there are many

factors that affect the speed of a printer. Go to Start >
Settings > Printers and right-click the default printer.
Choose Properties > Advanced tab, and select the option
“Print directly to the printer” rather than “Spool print
documents so program finishes printing faster”. You can
also check the printer spool settings to see if that is the
cause of your problem: go to Start > Settings > Printers,
right-click on your printer, then choose Properties >
Details > Spool Settings. Change the spool data format
from RAW to EMF, or vice-versa. (The location of this
option, too, depends on the type of printer.) The other

most obvious determinant of print speed is
the printer settings. Choosing a lower print
resolution, for instance, or printing in black
and white rather than in colour, can increase
the speeds.

You could also try opting for the printer’s “high-speed” or
“fast” printing mode. Almost all printer drivers have such a
mode, optimised for day-to-day printing needs. If you need
more speed, consider setting the printer to print multiple
smaller pages per single sheet of paper. Consult the printer
user’s manual for detailed instructions about how to activate
the fast printing mode and adjust the pages-per-sheet setting. 

Another important factor in determining print speeds
is the health of the system. A system with lots of system
memory, a neatly-organised hard drive with at least 100 MB
of free space, and a powerful processor will be much more
efficient in feeding data to the printer than a system that
is lacking in these key areas. Install enough memory on
your computer to take care of your needs. Run Disk
Defragmenter periodically.

Question 

of the

Month
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Agent 001 Wants It On Paper
There’s nothing more challenging than choosing a printer today. With a variety of models, brands
and technologies, you’re going to need the help of our resident super sleuth to figure this one out!

Moving up the ladder, HP has the DeskJet
D4168 that retails at Rs 3,750, and Canon has its
Pixma iP3300 retailing at Rs 5,500. Epson has its
Stylus C58, C79, and C87 in this range, retailing
at Rs 3,250, Rs 4,150 and Rs 5,000 respectively.
Printers in this range are for people who print
around a hundred pages a week—typical office
desktop usage.

Moving on, the price of the “average” laser
printer has fallen to an affordable Rs 6,000.
Almost every vendor has a laser printer for mass
consumption. HP, Canon, Samsung, and Xerox
are the major players in the mass-market cate-
gory. HP’s LaserJet 1020 and LaserJet 1022 are
mono lasers available at attractive prices of
Rs 6,900 and Rs 9,700 respectively. Samsung, has
their ML-1610 at a low Rs 5,000. Samsung also
has the ML-2010 and ML-2570 , which are higher-
spec laser printers, featuring faster printing
speeds. Similar to entry-level inkjet printers,
these entry-level laser printers require cartridges
(laser cartridges) that often cost around Rs 3,000,
and can print around 2,500 pages. These lasers
are good for typical office desktop usage, but not
for a large team.

When colour laser printers were intro-
duced, they cost too much; however, in

recent months, they have seen a drastic
price drop. The HP Colour LaserJet
1600 can be had for Rs 15,000, and the
souped-up LaserJet 2600n that used to
cost Rs 40,000 can be bought for Rs
19,000. Samsung recently introduced
the CLP-300, an entry-level colour
laser. It retails at Rs 14,500. 

While talking to a HP dealer, I
came across the new HP Officejet
K550 Pro. This is a business-class
inkjet, and is supposed to deliver
better performance than a laser, or at
least on par. The demo the dealer gave
me proved its capability—good speeds,

high-capacity cartridges, and
superb print quality. The attrac-
tive pricing of just Rs 8,999
sold me, and I coughed it up
immediately—but why not a
laser? Well, with an inkjet I
can print good quality colour
prints not possible even on a
colour laser. Bet you didn’t

know that!  

This is the first time I’m mentioning this,
but reading happens to be my favourite
hobby. I’ve collected more than 600 books

thus far! Nowadays, however, I’m most often
reading PDFs and e-books, and this was one of
the reasons I bought a Nokia N80.

However, I find reading on such devices is a
pain, especially for extended periods. How about
printing them out? My older HP DeskJet 640C
has been in operation for the last seven years,
and has now lost its ability to deliver crisp print-
outs. I just had to buy a new printer, and since
we haven’t done a good printer comparison for
almost a year now, the setting seemed perfect
for me to go about my business. 

In the good old days, selecting a printer was
a no-brainer: there were only a few models to
choose from, and each had a distinct advantage
over the other. But now? Too many models,
extremely focused categorisation, and the sig-
nificant onslaught of MFDs. Further, “should I
opt for an inkjet or a laser printer” is the ques-
tion one has to answer before buying.

Instead of narrating how I went about
buying a printer for myself, I’ve decided to touch
upon these issues.

Nearly everyone who buys a PC ends up
buying a printer, and this very demand
has ensured easy availability of
printers, which earlier were quite
expensive; in addition, very few
dealers were selling them. When it
comes to printers, India has been
a very pro-HP country, pretty
much like it is pro-NVIDIA in the
graphics card category. But you
also get good printers from
Canon, Lexmark, Epson, Xerox,
Samsung, and Brother. 

A home user can buy an inkjet
for as little as Rs 2,250; the Epson
C45, to be precise. In the same
league, you get HP’s 2360,
which costs about Rs 2,400, as
well as the Canon IP 1000, for
the same price. The Lexmark
Z645 also falls into this cat-
egory. Before you invest
in one of these entry-
level printers, make
sure to ask about car-
tridge prices; most
often, it would work
out to be the same or a
little less than what you
paid for the printer. These
printers are for those who print
like ten pages a week. 

Want more of Agent 001? Turn
over to read his answers to
your buying questions

Agent 001

DIGIT JANUARY 2007

Illustration Pravin Warhokar
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The Heart Of The Matter
I want to build a machine for casual gaming.
Please recommend a good AMD processor

(Socket AM2), a motherboard with decent onboard
graphics, and memory up to 512 MB DDR2. I have a
budget of around Rs 12,000.

Bipin Thite

For onboard graphics at a reasonable
price, an AMD platform based on NVIDIA’s

6150 chipset works out great. You can go with an
AMD Athlon64 X2 3600+ or 3800+ AM2 processor.
You will find these retailing at around the Rs
7,000 mark. For the motherboard, opt for an ASUS
M2NPV-MX or MSI K9NGM2; they both retail at
around Rs 4,500. For RAM, I’d suggest 512 MB of
Transcend, Corsair value, or Kingston. 

If you can stretch your budget to around
Rs 15,000, opt for an Intel Core 2 Duo E6300
processor (Rs 9,000), an ASRock 945G DVI, and
the memory I mentioned earlier. The latter con-
figuration will offer much better performance.
For any sort of serious gaming, upgrade to a
decent graphics card at a later stage.  

Supply And Demand
I own an Intel Pentium 4 2.66 GHz processor, ASUS
P5N32-SLI Leadtek 6800 GS cards, a Creative

SoundBlaster Audigy 4 sound card, and a Zebronics
500 Watts platinum SMPS. If I upgrade to an Intel Core
2 Duo E6600 processor and 8800 GTX card, which I
will do soon, will the SMPS be able to handle the load? 

Jassim

In the most probable case, yes, a 500-watt
SMPS is more than sufficient. We haven’t

tested the Zebronics Platinum, so I can’t com-
ment on its efficiency level. For the moment,
forget about the wattage—what’s important is
the efficiency level rated at some temperature. 

If your SMPS fails to cope with the load, you
can opt for Antec or Corsair power supplies. Con-
tact Tirupati enterprises at 033-22251192/93 for Cor-
sair and CyberSpace Abacus at 044-24362681for
Antec.

First Steps
I have taken to computer gaming and like games
such as Half Life 2, F.E.A.R., and NFS Carbon. I

want to buy a graphics card. My upper limit for this
purchase is Rs 7,000.

Soumitra Panda

You haven’t mentioned your configura-
tion, so I’ll assume you have a PCI-Express

compatible motherboard. For Rs 7,000, you can
expect a decent enough graphics card. Get a card
based on the NVIDIA 7600 chipset—you will be
able to get a 7600 GS at your budget. Try for a
7600 GT, though; if you’re lucky, you might be
able to get yourself a deal.  

How Good Is A Cam-Phone?
I am a hobby photographer and am looking to
buy a new digital camera. Should I buy a good

3MP camera phone or a better standalone camera?
My budget is Rs 22,000.

Aditya Narayan Ray

It depends on what you mean by
“hobby photographer.” How often do

you click snaps, what’s your typical shooting
environment, and what do you expect from a
photograph? Today’s camera phones have
evolved to a level where they can provide good
photographs, but quality takes a significant
hit under poor lighting conditions. Moreover,
additional but useful features such as image
stabilisation, faster response times, and better
flash performance haven’t yet made their way
to camera phones. 

A standalone camera is a much better tool
if you plan to adopt photography as a serious
hobby or career. If you want to be a casual
shutterbug, a convergent device such as a
camera phone will do. For a 3MP camera
phone, you can opt for the Nokia N73 or the
Sony Ericsson K790i. As for standalone cam-
eras, for Rs 22,000, you will get an excellent
one. Look for the Canon PowerShotA700, Sony
Cybershot W70, or in the pseudo-SLR range,
the Panasonic FZ30.

Defying Dust
I am planning to buy a laptop, possibly based on
the Celeron M platform. I have allocated a

budget of about Rs 32,000. I have a problem
though—I travel a lot, and the local environment is
dusty. Please recommend a laptop that can take a
punishing environment.  

Ranen Biswas  

Don’t bother too much about the dust—
unlike PCs, laptops don’t have open

crevices from where dust can enter and accu-
mulate. The best way to keep dust at bay is to
get the notebook serviced at regular intervals—
get the ventilation ports cleaned. You can
choose from HP, IBM, Gigabyte, or Zenith note-
books. I’d recommend the R40 series from IBM;
if they are still available, they should fit into
your budget.

Tuning In
I have a Toshiba A105 series laptop and want
to purchase a compatible TV-Tuner card for it.

Which one should I buy?
Suresh Desai

You have two options—USB TV-Tuners
and the Card Bus type. The former plug

into a USB 2.0 port and can be connected 
to regular PCs as well as laptops.  The Card 
Bus type of TV-Tuners go into the PCMCIA slot
and are specifically designed for laptops. Card
bus tuners are available from Pinnacle,
Compro, and AVER. There are different vari-
ants available—some have an FM tuner and/or
PVR functionalities, and the price will depend
on these features. USB TV-Tuners are relatively
bulky, and carrying them around might 
be inconvenient. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001
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You usually ask
friends who’ve been
there for directions
to someplace
interesting—right?
And different
friends give you
slightly different
versions...
For our company
trip, we decided to
DIY: look in the
maps and figure
how to get there.
We had a map of
Maharashtra, and
we also decided to
give
MapMyIndia.com a
shot. We just looked
at the regular
section, not the
“business services.”

We were highly sceptical about the site. India actually
having been mapped? We expected it to be one of
those crappy sites with tons of pop-ups and nowhere
to look. But... a pleasant surprise!

“Malshej Ghat” actually showed up, even though it’s
not a town. A simple “directions” search from Panvel
to there brought up a detailed directions list—along
with the nearest town to the place, called Walhivale.
We’d never have known this from the paper map.

The directions were a little confusing though: “At
Kalyan-Dombivli, turn right—go 1.34 km.” The
next one, perplexingly: “At Kalyan-Dombivli,
continue...”. “Turn right” and “continue” to do so?

We’d gotten the general drift, though—and we had
the exact distance, too. Zoom into the map as
much as you want to, and find tiny towns and
villages... a great help when you’re driving.

We’ll have to ask for directions anyway, but we
knew each place along the way, so no getting lost
beyond a few kilometres!

Tracking down a vacation spot on the map Hooray for MapMyIndia!

2
3
4
5

MapMyIndia.com is terrific. It shows up specific
addresses too, in many parts of the country. The

detail in the maps is incredible.
However, we won’t say the tech way is the “winner,”

because you just can’t be sure. The difference between this
and using a paper map is essentially that you get more town
names along the way, as well as an idea about distance.

India simply cannot be mapped the way developed
countries are, and MapMyIndia.com will unfortunately

never be what Yahoo! Maps is to the US.
A search for “Belapur”—right next-door to our

office— took us to the interiors of Maharashtra. Our
roads aren’t known for being neatly organised into
streets and avenues… your mileage, therefore, will
vary. Can’t blame the site in the least. And then there’s
all the thing about no-one knowing what a road is
called… is Brigade Road in Bengaluru still Brigade
Road, by the way?

OLD
WAY

TECH
WAY

Fun: 4.5/10 (What did you expect?) Fun: 7/10 (A novel experience!)

And 
The

Winner
Is...

Ram Mohan Rao (ram_mohan@thinkdigit.com)

Figuring out the exact distance is impossible—we just
used a ruler for the distance as the crow flies, then
compensated for the turns.

Looking at the map is all well and good, but where
exactly do we turn? It was all we could do to note
down the towns along the way, and we’ll have to ask
for directions at each.

Finding Maps

Naturally, the problem is, it’s not a town—it’s a ghat;
an area. But there it was—in tiny print—the entire
green stretch. We still had no clue where the nearest
town was, though.

Malshej Ghat is a hill station close to Mumbai, one
of the lesser-known ones. (More and more people
are finding out, and it’s getting overpopulated by
junk tourists, though.) At first, we didn’t notice it
on the map at all.

The map showed us the roadway as well as the
railways—so we could choose. Not much of a value-
add—the railways—because we’d decided to go by
road anyway.

1



E-mail clients aren’t all Outlook! There’s a whole bunch of them out there—
and it’s time we did a round-up of the lot

Jayesh Limaye

D
espite Instant Messaging, SMS, and other
new forms of communication, the de
facto way of keeping in touch is still e-
mail. It was the killer app of the Inter-

net, and its importance has not diminished one
bit. In fact, it’s the lifeline of many businesses.

The simplest way of checking and sending
mail from anywhere is by using Web-based
e-mail. In this case, you need to be online and
log on to the Web site of your e-mail provider—
such as Gmail, Rediffmail, and so on. However,
there are times when you can connect to the
Internet only once in a while; in such situations,
Web-based e-mail solutions cannot be relied
upon. Another scenario: you have a company e-
mail account, and you’re connected to the Inter-
net all the time. Why should you log on to a Web
site each time you want to check your mail? It’s
preferable to just let the mail come into your
Inbox as and when it is received. Here is where
e-mail clients come in.

When you send an e-mail, it goes to the e-mail
server and is stored there. An e-mail client
retrieves the mail from the server to the

computer. Not only does an e-mail client let you
view your e-mails when you’re offline, it also lets
you compose mails without having to be
connected. Mails composed offline can be sent
across once you connect to the internet. This way,
if you’re on dial-up, or on any other access
scheme that makes you pay by the minute, you’re
better off using an e-mail client than Web mail.

Still, Web mail services offer the convenience
of letting you check your mail from anywhere.
Many e-mail service providers have revamped
their interfaces to mimic that of e-mail clients.

Some of us use both—an e-mail client at work
for our office e-mails, if, for example, we aren’t
allowed to check personal e-mail during work
hours—and Web-based mail at home. Ultimately,
each method has its pros and cons, and this test
is for those who do use an e-mail client—which
will be Outlook or Outlook Express in most cases!
We wish to remind you that there are alternatives.

We will take a look at twelve of the most popu-
lar e-mail clients. These are RimArts Inc.’s Becky!
Internet Mail, Qualcomm’s Eudora, IncrediMail
Xe, MemeCode’s i.Scribe, Mulberry, Opera Mail
Client, Microsoft Outlook 2003, Microsoft Outlook
Express 6.0, Pegasus, Sylpheed, RITLABS S.R.L.’s The
Bat! Home Edition, and Mozilla Thunderbird. Im
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The Postmen

Protocol support
POP3: Post Office Protocol version 3 is an application-layer Internet
standard protocol that lets you retrieve e-mail from a remote mail
server over the Internet. Many e-mail service providers provide a
free POP3 service, while some such as Yahoo! provide it for a fee.
IMAP: This was earlier known variously as Internet Mail Access
Protocol, Interactive Mail Access Protocol, and Interim Mail
Access Protocol. This is an application-layer Internet protocol
that allows a local client to access e-mail on a remote server. It is
also known as IMAP4. Almost all modern e-mail clients and
servers support it.
NNTP: Network News Transfer Protocol is an Internet application
protocol primarily used for reading and posting Usenet articles, as
well as to transfer news among news servers.
News Feeds: This is a family of Web feed formats used to publish
frequently-updated digital content such as blogs, news feeds, and
podcasts. It is again divided into formats such as ATOM and RSS
(Rich Site Summary); the latter again has versions 0.91, 1.0, and 2.0.

Security features
SSL encryption: Secure Sockets Layer is a cryptographic protocol
that provides secure communications on the Internet for things
such as e-mail, Web browsing, Internet faxing, and other data
communications and transfers.
Preview before download: Some e-mail clients support reading
mail off the POP3 server directly without downloading it to the
PC. This provides you with security against mallicious e-mail. The
image-blocking feature also has the same advantages.
Junk filtering: Spam can be irritating and also means a waste of
time. Inbuilt Junk/Spam filters are therefore a big plus.

Appearance
Formatted mails: HTML-formatted messages have much better
visual appeal than plain-text messages.

Customisable Interface And Keybindings: The interface and
keybindings (combinations of keystrokes) should be customisable
to suit individual needs.
Mail Notification: Mail notifiers alert you when you receive a new
mail so you don’t need to keep checking for new mails.
Ease Of Use: We looked at the ease with which a new mail
account could be created, whether the interface is user-friendly,
and so on, and collectively rated this on a scale of five.

PIM features
Personal Information Manager features such as Calendar, Notes,
Tasks, Scheduler, Memo, etc. were noted. Though these aren’t that
important for the home user, they don’t hurt!

Other features
Split large attachments: Most e-mail service providers specify a
certain size limit for the attachments you can send. Anything
above this size is rejected. The option we’re talking about lets you
split attachments to a size below the specified threshold.
Import/Export Of Mail And Address Book: This is an important
feature—very useful when you’re migrating from one e-mail client
to another. An e-mail client should support importing from as
many popular clients as possible.
Multiple Profile Support: For more than one user to access a mail
client installation, the client should be able to handle a profile
unique to each user.
Changeable Mail Store Location: It is a good idea to change the
location of the e-mails stored locally on the hard drive to a safer-
than-default location (such as a drive other than the one where
the OS resides).
Plug-in Support: Plug-ins have the power to completely revamp
an e-mail client, so this is a very welcome feature.
Additional features: We looked for any additional features to the
above that the e-mail client offered.

What We Looked For

Becky! Internet Mail

Becky! Internet Mail 2.29 is a mere 2.3 MB down-
load, and starts up very quickly, probably due

to its no-frills interface.
Becky! Internet Mail does not have a

polished interface; attention seems to have been
paid only to functionality. There are no Wizards
or guides, and a newbie will feel lost. However,
the simple menus do everything one would
expect of an e-mail client.

While it supports HTML e-mail composing to
some extent, it can hook up to an external editor
such as Word to enhance your composition. This
is a configurable option. If you attempt to enter
ActiveX content into the mail, Becky! will warn
you about its potential dangers. You can even
directly edit mail in the viewer window, and this
can even be the HTML message you created
earlier using the external application.

The search as well as the mail rules are a pain
to understand, and not very customisable. Becky!
has a unique Reminder capability, using which

you can send yourself
an e-mail and specify
the date when you
wish to receive it. The
Mailing Lists Manager
helps you maintain
multiple mailing list
subscriptions. Becky!
also comes with a PGP
(Pretty Good Privacy)
plug-in preinstalled,
which lets you
encrypt messages
before sending them.

Becky! has a
feature called the
Remote Mailbox, which lets you decide whether
to delete or download a certain mail or mails
while they’re still on the server. All basic mail
functions such as copy, paste, delete, forward,
reply and drag-and-drop are supported when
using the Remote Mailbox feature. Becky! is,
however, priced at $40 (Rs 1,800), which seems
too much for just an e-mail client.

Digital Tools l E-Mail Client Test
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Becky’s Remote Mailbox lets you preview your mails



Eudora 7.1

Along with support for POP3 and IMAP,
Eudora has a special feature called ESP

(Eudora Sharing Protocol) that allows you to
create a group of users who can synchronise and
share a set of files via e-mail.

The e-mail composer supports plain-text as
well as richly-formatted text, and you can even
send emoticons if you use the paid version. Then
there is MoodWatch—an offensive-vocabulary
alert that warns you about profanity if you acci-
dentally type in some. Eudora has extensive
search options, and it also supports indexed
search for faster performance.

It’s SpamWatch Bayesian spam filter is
quite effective. Also featured is ScamWatch,
which warns you about deceptive URLs in
phishing e-mails, but you need to be a paid
user to use these.

Eudora’s PureVoice
plug-in lets you send a
voice message as an
attachment, and this
can be opened by the
receiver using the
PureVoice plug-in. it also
gives you the option to
redirect your e-mail to a
different address.

This program is avail-
able in three versions:
Paid, Sponsored, and
Lite. The paid and the
sponsored versions have
the same features,
except that the sponsored version is adware. The
Lite version has fewer features. At the end of the
day, Eudora is a good e-mail client, but will be
somewhat tough to get used to. Eudora is set to
go open source in the first half of 2007.

IncrediMail Xe 

This is one of the best looking e-mail clients
we have seen, and it seems to be aimed at

the young. The download is just 450 KB, but this
is a deceiver—it is a Web installer, and over 10
MB is downloaded.

IncrediMail has support for POP3 as well as
IMAP, but support for news feeds has been left out.

The interface is similar to that of Outlook
Express (OE), only more colourful thanks to
Flash, which is what most likely contributes to
its slow load times.

When you open the e-mail composer, along
with it opens a Style Box that lets you choose
from loads of colourful backgrounds—including
some animated ones. You can even choose to add
3D effects and also emoticons. You can send
audio mail, where you record a message and
mail it with the text.

IncrediMail sits quietly in the System Tray,
and when new mail arrives, the Notifiers let you

know. These Notifiers
are animated charac-
ters—something simi-
lar to the search
assistants in XP.

IncrediMail’s spam
blocker automatically
determines ad-based
messages. The safety
concerns  are the same
as those in OE—maybe
even more, considering
the presence of Flash
content. IncrediMail,
too, has the ability to
read POP mail without
downloading it. This
way, you can delete
unwanted mail directly from the POP3 server.

With so much colour and animations, we
revise our earlier view: this isn’t really for
teens, but rather for kids being introduced to
the world of e-mail!
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“Finally, Microsoft is taking steps to do
away with the buggy-yet-popular

version of their e-mail client—Outlook
Express. Windows Vista will feature a new
e-mail client—Windows Mail.” This rumour
has been around on the Internet for the
past few months. But the excitement is not
warranted: Microsoft has not built this e-
mail client from scratch—rather, this is
Outlook Express’s new avatar.

Let us first look at what new features
are offered in Windows Mail. An integrated
spell-checker is provided, so you don’t need
to install MS Office for this feature. It also
includes a new storage engine that is more
reliable and performs better than OE.

Windows Mail makes use of Internet
Explorer 7’s Phishing Filter, and also has a
Junk Mail filter—similar to Outlook. Other
than this, Windows Mail offers only a few
cosmetic enhancements over OE.

While it gains some features, it loses
quite a few. You can no longer access Web
mail accounts like Hotmail (and the soon-
to-be Windows Live Mail)—only POP3 and
IMAP mail accounts are supported. It also
does away with the Identities feature of OE,
but this is a feature that was often left
unused and hence won’t be missed much.

Vista comes with Windows Calendar
and Windows Contacts, and integrating
Windows Mail with these two would have

given it good PIM functionality, but it is
speculated that Microsoft didn’t do so to
protect Outlook from being threatened. 

Windows Mail

Old wine, new bottle

MoodWatch gaurds against profanity

Convey your emotions using the Emoticons 



i.Scribe 1.88

An open source cross-platform e-mail client,
more popular with OSes other than

Windows, i.Scribe is just 790 KB! It requires no
installation, and can be carried around on a
thumb drive. You can even take it to a Linux
computer and continue checking your mail. It
supports the POP3, IMAP, and LDAP protocols.

i.Scribe has a simple three-pane interface,
with the mail folders at the left, mails at the top
right, and message content at the bottom right.
You are guided by a wizard to create your
account on your first run. This version being
free, you are limited to creating only one
account, and once we did create one, we had a
hard time trying to delete it.

You can only compose messages in plain-text,
but you can view HTML messages. i.Scribe uses its
secure internal engine to render HTML, but can

also use Internet Explorer’s HTML
rendering engine.

i.Scribe does not provide a
sufficient number of options in
its mail search—you can only
provide one search term, and
search in only one field, such as
To, From, Subject, etc. Message
rules are also inflexible, and it
takes a while to understand how
to set up a certain rule.

The powerful Bayesian spam
filter can effectively discard spam
and allow only good e-mail to end
up in your Inbox and the duplicate message filter
looks for and deletes duplicate messages.

Small doesn’t mean less, because i.Scribe
even has PIM features such as a Calendar, which
lets you share your appointments with others.
You can also expand i.Scribe’s functionality using
the large number of community-created plugins.

Mulberry 4.0.6

Here’s a powerful mail client that supports
almost every platform. It supports all the

protocols expected of an e-mail client, but
Mulberry fails miserably when it comes to
simplicity of interface and ease of use. It took us
a considerable amount of time to figure how to
even configure a new mail account.

The e-mail composer supports messages
with plain-text, rich text, and HTML format-
ting. The text macros let you specify
commonly-used text, so that you can quickly
insert such text into your messages using
hotkeys. The Speak mail feature uses the

installed text-to-speech
engine in the OS to
read your e-mail to you.

The search engine is
simple yet powerful,
and you can also save
search criteria for
future use.

Mulberry has taken
care of security and
privacy. It supports
OpenPGP and S/MIME
message encryption in
addition to TSL/SSL.

From this version on, Mulberry also comes
with calendaring support. It’s free software—so
you can always give it a try!

Opera Mail Client

Opera Mail Client was the only e-mail client
we tested that was integrated with a browser

rather than being a separate piece of software.
While all the received e-mails are stored in the
Received folder, mails with attachments are also
categorised according to the attachment type—
such as Documents, Images, Music, Videos, and
Archives, for faster retrieval.

Integration within Opera does have its
advantages. It can accept all kinds of RSS as well
as Atom feeds, and these are well-sorted into
folders—one per feed. This is the only e-mail
client that supports all the required protocols—
POP3, IMAP, NNTP, and even Chat (IRC).

The Opera mail composer is still primitive,
and does not support HTML. The lack of HTML
and JavaScript support however means that
this mail client is well-protected from viruses.
Integration with the Opera browser also allows
you to create a new mail from just about
anywhere within a window in the browser—

just select text, right-click, and click on
“Send by mail.”

The search option lets you specify
very basic search criteria. Ditto for the
message rules. Opera creates folders
when you create a filter, and filtered
messages are copied to this folder. You
can create filters within filters to refine
the categorisation of your mail. The
spam filter is Bayesian, meaning it
keeps learning.

The wizards let you import mail easily.
E-mails can be imported from Eudora,
Opera, OE, Netscape, and Thunderbird. Unlike
previous versions, versions post-9.02 don’t crash
while importing Thunderbird mail.

You can take notes and send them as e-mails
if required. This is the only PIM feature to be seen
here. The e-mail storage location cannot be easily
changed, and you need to go into the advanced
configuration options to do that.

Opera Mail Client is a good client overall, but
you may probably use it only if you use the
Opera browser.
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i.Scribe’s Bayesian Filter keeps spam at bay

Mulberry even comes with PIM features

Mails are sorted according to filters
and attachment types



Microsoft Outlook 2003

Microsoft Outlook 2003 comes bundled with
Microsoft Office 2003, but is also available

as a standalone product. The interface consists of
a shortcuts panel where the different features
can be quickly accessed; the Folder List and a
third pane is where you can view the features
activated from the shortcuts panel. It can be a
bit confusing in the beginning, but a closer look
reveals that everything is in a proper, logical
order. Keep in mind that this is primarily a PIM
client, and the e-mail client is only a part of it.

Outlook supports the POP3 and IMAP proto-
cols, and you can also connect to HTTP e-mail
servers such as Hotmail. The real power of
Outlook is realised only after it connects to the
MS Exchange Server, but you won’t see this as a
home user.

You can compose great-looking HTML mails
thanks to its integration with Word as an e-mail

editor. The spell-checker is the
same that comes with MS Office,
so you can expect it to work very
well. You can add ActiveX
content to the mail using Word.
This opens the door of vulnera-
bility to viruses and worms, but
thankfully, Microsoft periodi-
cally issues security updates to
patch holes in Outlook—just
remember to update!

Outlook 2003 comes with a
good spam filter that efficiently
weeds out most spam. You can
even set the level of filtering. By default,
messages are sorted by date, and are arranged
into groups. You can also set messages to
display as threaded chains. Since this is a prod-
uct aimed primarily at the corporate user, it
comes with PIM features such as Calendar,
Notes, and Tasks. It costs $109 (Rs 4,900)—too
steep a price for a home user!

Outlook Express 6.0

Outlook Express 6.0 (OE) is part of Windows XP
and has a very simple and easy-to-use inter-

face. It is well integrated with the OS and also with
Internet Explorer. An e-mail setup wizard launches
on your first run, and guides you to set up your
account with no hassles. Due to its integration
with Windows, it performs with ease and speed. 

Along with the usual POP3 and IMAP, you can
also set up newsgroup accounts, or even LDAP
for that matter.

Though you can create HTML messages in OE,
there are certain limitations. While replying
with HTML formatting, you cannot insert lines
below the quoted message or within it because of
the irritating vertical line that appears to the left

of the quoted text. Plus, you
can only add simple back-
grounds to your e-mails.

It is easy to arrange mail in
different virtual folders, and
you can easily create rules that
automatically transport e-
mails to the required folders. 

Integration with MSN
Messenger lets you synchro-
nise contacts between the
two. You get all this at a
price: Outlook Express is one
of the least secure e-mail
clients, and is rather vulnerable to attacks by
worms and viruses. But then, do you find
computers around that are not protected by an
anti-virus these days?

Pegasus 4.4

Pegasus is one of the oldest e-mail clients
around, having first been launched in 1990.

The interface is far from polished—the function-
ality is there, but is in scattered form, and takes
time to get comfortable with. Thankfully, it
comes with an exhaustive help system.

All messages you send are stored in a folder
named “Copies to self”—realise that that’s the
correct way of addressing sent mail! The Main
Folder contains all the mails it receives, but
there is a New mail folder that contains unread
mails, so you don’t have to search for an old mail
you forgot to read. 

You can sort messages by thread, sender,
date, and more criteria. Public folders allow
multiple users to share access to the same
messages in Pegasus Mail.

Pegasus supports POP3 and SMTP, and can
also manage multiple accounts of each type.

Unfortunetly, it does not
support Atom or RSS
feeds.

HTML-formatted mails
can be composed in Pega-
sus. The Glossary lets you
store a list of abbreviations
and their long forms, so
that you can use and
expand them in mails at
the click of a button.

While Pegasus has an
extensive e-mail filtering system and is highly
configurable, it is likely that the general user
would be left confused because of the lack of
Wizards for this purpose. The Bayesian filter takes
care of spam, while the integrated phishing
protection alerts you about malicious Web sites.

You can review your mail on the POP3 server
and choose to directly delete it if you so wish.
Along with TSL / SSL, Pegasus can also work with
third-party e-mail encryption solutions.
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The three-pane interface of Outlook 2003

Outlook Express—it’s right there

The Sent Items folder is called Copies to self!



Sylpheed 2.2.10

Sylpheed is an open source, cross-platform e-
mail client that works with Windows as well

as Linux. It not only supports all major protocols
including RSS feeds, but also supports IPv6—the
next-generation Internet Protocol.

The user interface is somewhat similar to
that of Outlook Express, and is quite comfort-
able to work with. The usual Inbox, Sent, Draft,
etc. folder structure is strikingly similar.

The mail composer lets you create new
templates according to your needs. Messages can
be composed only as text, but you can view HTML
messages.  You can either use the inbuilt editor or

bind and use an external editor
for this purpose. Sylpheed’s
message editor cannot reflow
text: it can only wrap it. Sylpheed
takes care of your privacy issues
by means of GnuPG keys for
encrypted communication, in
addition to TSL/SSL support.

The search feature is quite
powerful, and allows you to
save the results as a search
folder. Spam is taken care of by
means of bogofilter and bsfil-
ter, which feature a learning
function that improves their
performance with use.

The Bat! Home Edition

The Bat! Home Edition 3.85.03 was the one e-
mail client that had a markedly different

menu system. Unlike the usual File, Edit, etc.
menus, here we have Messages, Specials,
Accounts, etc.—much more relevant for an e-mail
client. This may confuse the user at first, but it
actually makes navigation much easier and faster. 

Like most mail clients, The Bat! has support for
POP3 and IMAP protocols. It can even connect to an
MS Exchange Server using the MAPI protocol. The
Message Dispatcher tool shows you the most
important message headers, and lets you delete
messages directly from the server. In some cases,
the sender and subject might not be enough for
you to decide whether you want to keep the
message, so The Bat! can automatically download
a few body lines together with the headers.

This version, unlike the previous versions, is
capable of sending as well as receiving messages
in the HTML format. The e-mail composer is also
feature-rich; in fact, it is the only e-mail client
we have seen that supports aligning even in
plain-text mode. The spell-checker can even
correct words based on phonetics!

You can set rules and search
with seemingly endless options
that yield highly refined results.
A point to note is that though
we have a large number of
options, they are neatly named
and thus not confusing. This
multithreaded e-mail client can
send as well as receive at the
same time!

Mail Chat lets you chat with
other The Bat! users by means of
e-mail, so you remain protected
from the potential threats posed
by IMs. A flashing icon informs
you about Mail Chat replies.

The Bat! is very secure
against viruses and worms. It supports various
PGP standards such as OpenPGP to encrypt your
messages. You can also password-protect indi-
vidual mailboxes if you wish.

With features such as Scheduler and Memo,
The Bat! competes head-to-head with Outlook,
and is good even for corporates and can also
work as a server on your home network. Synchro-
nisation and backups are also easily achievable.
It costs $24.50 (Rs 1,100), which is just right.

Mozilla Thunderbird 1.5

Thunderbird is an open source, free e-mail
client from the Mozilla Foundation. The

interface is pretty simple and straightforward,
and allows you to arrange mails into different
virtual folders. E-mails can be sorted according to
importance, time of reception, and even accord-
ing to attachment. It has a themes-based inter-
face, which means that the looks can be changed
by applying themes. 

POP3 and IMAP are the supported mail proto-
cols. In addition, it also supports NNTP, which lets
you subscribe to Newsgroups. Like Firefox, it
supports feeds from RSS 0.91 and Atom to keep you
updated, and can be viewed as regular e-mails. 

The search feature does not have too many
parameters, but they seem to be adequate for a

home user. Message filters (rules)
also do not have too many options,
but a home user may be better off
with the limited set of options.

This is a basic e-mail client like
OE, while being less vulnerable to
viruses because of the lack of
ActiveX support. Pair this with the
included Bayesian spam filter, and
you have a very safe e-mail client.

We must also mention that
Thunderbird supports a variety of
plug-ins or extensions developed by the open
source community. These extensions bring in
new functionality and can enhance the client.
Some extensions like the Adblock Plus filter
block ads and increase system security, while
others such as United States English Dictionary,
add to the vocabulary of the e-mail composer.
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Sylpheed comes with a simple interface

Extensive search options let you pinpoint 
your mail

Extensions are the meat of Thunderbird



Scoreboard                             Email Client

Small and portable, 
Windows-Linux 
operability
Single account 
can be created

Good Bayesian spam
filters
Difficult interface

Lively, easy interface
Vulnerable

Good search and 
message filters
Hard-to-learn 
interface

POP3 mail preview
Expensive

Incredimail Xe

✔

✔

✖

✖

✖

✔

✔

✔

✔

✔

✔

3.5

3.5

✔

✔

✔

✔

✔

Outlook, OE, Eudora,

Exchange

✔

✖

✔

✖

✖

✔

✔

✔

✔

✖

✔

4

✖

Emoticons, Colourful

backgrounds

Free

www.incredimail.com

Mulberry

✔

✔

✔

✔

✖

✔

✖

✔

✖

✔

✔

4

4

✔

✖

✔

✔

✔

Eudora, Netscape, OE,

Pine, Quickmail

✔

✖

✖

✖

✔

✔

✔

✔

✖

✖

✖

2.5

Calendar

Speak Message

Free

www.mulberrymail.com

Eudora

✔

✔

✖

✔

✖

✔

✖

✔

✔

✔

✔

4

4

✔

✖

✔

✔

✔

Outlook, OE, Netscape

✔

✖

✖

✖

✔

✔

✔

✔

✖

✖

✖

3

✖

Emoticons, Voice

Messaging

$19.95 (Rs 900)

www.eudora.com

i.Scribe

✔

✔

✖

✔

✖

✔

✔

✔

✔

✖

✖

2.5

3.5

✖

✖

Plug-in

✔

✔

Eudora, Outlook, OE,

Netscape, Thunderbird

✖

✖

✔

✖

✔

✖

✔

✔

✖

✖

✖

2.5

Calender

Has option to remove

duplicate mails

Free

www.memecode.com

Becky! Internet Mail 

✔

✔

✖

✔

✖

✔

✔

✔

✖

✔

✔

3

2.5

✔

✖

✔

✔

✔

NA (mbox files)

✔

✔

✔

✖

✔

✔

✔

✔

✔

✖

✖

3

Reminder

PGP

$40 (Rs 1800)

www.rimarts.co.jp

Email Client

Mail Protocol Support

POP3 Support (✔ /✖ )

IMAP Support (✔ /✖ )

NNTP (Newsgroup Support) (✔ /✖ )

LDAP (✔ /✖ )

Feeds (RSS 0.91/1.0/2.0/ ATOM)

Security features

SSL Encryption (✔ /✖ )

Preview Before Download (✔ /✖ )

Image Blocking (✔ /✖ )

Junk Filtering (✔ /✖ )

Other Features

Message Grouping in Virtual

Folders (✔ /✖ )

Create Virtual Folders (✔ /✖ )

Search Options (Scale of 5)

Message Rules (Scale of 5)

Read Confirmation (✔ /✖ )

Can Split Large Attachments? (✔ /✖ )

Spellcheck (✔ /✖ /External)

Import and Export Address Books

(✔ /✖ )

Import and Export of Mails (✔ /✖ )

Importable Email Clients

Multiple Profile Support (✔ /✖ )

Supports Synchronization (✔ /✖ )

Mail Store Location Can be

Modified? (✔ /✖ )

Backup (✔ /✖ )

Plug-in Support (✔ /✖ )

Appearance

Send Formatted Messages (✔ /✖ )

View Formatted Messages (✔ /✖ )

Customizable Interface

Customizable Keybindings

Mail Notification (✔ /✖ )

Skinnable Interface (✔ /✖ )

Ease of Use of Interface (Scale of 5)

PIM Features (Calender, Notes, etc)

Additional Features

Price 

Website



Supports all 
protocols
Primitive mail 
composer

Ultimate in seamless 
integration and 
features
Very Expensive

Simple to use, 
bundles with XP
Vulnerable to threats

Unlimited plug-ins
Search could have 
been better

Almost every feature
you’ll ever need
None in particular

Simple interface, 
cross-platform 
operability
Bad mail composer

Opera Mail Client

✔

✔

✔

✖

✔

✔

✖

✔

✔

✔

✔

3.5

3

✖

✖

Plug-in

✔

✔

Eudora, Opera, OE,

Netscape, Thunderbird

✔

✖

✔

✖

✔

✖

✔

✔

✖

✖

✔

3.5

✖

✖

Free

www.opera.com

MS Outlook Express 6.0

✔

✔

✔

✔

✖

✔

✖

✔

✖

✔

✔

4

4

✔

✔

✖

✔

✔

Eudora, Outlook,

Exchange, MS Internet

Mail, Netscape

✔

✔

✔

✖

✔

✔

✔

✖

✖

✖

✖

4

✖

✖

Free

www.microsoft.com

Thunderbird

✔

✔

✔

✔

RSS 0.91, ATOM

✔

✖

✔

✔

✔

✔

3.5

4

✔

✖

✔

✔

✔

Eudora, Outlook, OE,

Netscape

✔

✖

✔

✖

✔

✔

✔

✔

✖

✖

✔

4

✖

✖

Free

www.mozilla.com

Pegasus

✔

✔

✖

✔

✖

✔

✔

✔

✔

✔

✔

3.5

3

✔

✖

✔

✖

✖

✖

✔

✖

✔

✔

✖

✔

✔

✔

✖

✖

✖

3

✖

Public folders

Free

www.pmail.com

Sylpheed

✔

✔

✔

✔

Via Plug-in

✔

✖

✔

✔

✖

✖

4

4

✔

✖

✔

✔

✔

NA (mbox files)

✔

✖

✖

✖

✔

✖

✔

✔

✔

✖

✖

4

✖

GnuPG

Free

sylpheed.sraoss.jp/en

The Bat! Home Edition

✔

✔

✔

✔

Via Plug-in

✔

✔

✔

✔

✔

✔

4.5

4.5

✔

✔

✔

✔

✔

Eudora, Pegasus,

Netscape, Outlook, OE

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

4

Scheduler, Memo

Mail Chat, OpenPGP.

Connects to MS

Exchange Server

$24.5 (Rs 1,100)

www.ritlabs.com

MS Outlook 2003

✔

✔

✖

✔

✖

✔

✖

✔

✔

✔

✔

4.5

4.5

✔

✔

✔

✔

✔

Eudora, Netscape, MS

Internet Mail, Outlook

Express

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✖

4

Calender, Tasks, Notes

Connects to MS

Exchange Server

$109 (Rs 4,900)

www.microsoft.com

POP3 mail preview
Confusing interface



Who Delivers?
Of the twelve e-mail clients we tested, we found
that many of them are good when catering to a
particular segment of users. We therefore
break away from the tradition of crowning a
Gold and Silver winner. Instead, we will men-
tion the noteworthy ones here—the ones we
think are worth a try.

Windows comes with Outlook Express 6.0
as the default e-mail client, and though it is
buggy and prone to worms and viruses, apply-
ing frequent bug-fixes and patches from the
Microsoft Web site and using a good anti-virus
will minimise the risks. Outlook Express is
very simple to use—no wonder there was a hue
and cry following rumours in August 2003
that Microsoft had decided to stop further
development of Outlook Express: within a
week, Microsoft pledged allegiance to its free
e-mail client. 

If you are always on the move, need to check
your e-mails and also carry them around, i.Scribe
is the e-mail client for you. Not only does it allow
you to password-protect your e-mail folders on a
portable drive, it also has advanced features that
let you preview your e-mails on the POP3 server
without downloading them. This is useful in a
scenario where you’ve run out of free space on
your drive, but still want to check new mails

without downloading them. In addition to this,
it runs on both Windows and Linux.

If you are a novice or if you are, well, young,
IncrediMail Xe with its colourful interface and
animated emoticons will surely appeal.

If you are willing to pay for better features,
The Bat! should be your choice because it has all
the features one might ask of an e-mail client.
Corporate users, too, will not be disappointed,
because it can connect seamlessly to Microsoft
Exchange Server. It even packs in PIM features
such as Scheduler and Memo, and at $25.50 (Rs
1100), the price is not too high.

We have to mention that when it comes to
pure performance and compatibility, nothing
comes even close to Outlook 2003. This PIM-plus-
e-mail client rips the competition apart because
of its excellent integration with Windows. It has
excellent drag-and-drop support, and integra-
tion with components of MS Office. When
coupled with MS Exchange Server, Outlook 2003
takes on a whole new avatar as a collaboration
tool, complete with the ability to assign tasks to
subordinates and delegating correspondence
while you take vacations. Corporate users who
have the money should definitely opt for it—
nothing works better with MS Exchange Server
than Outlook 2003. 

jayesh_limaye@thinkdigit.com

POP3 vs. IMAP
POP3 and IMAP are the predominant protocols of e-mail services. They are popular and hence are supported by most
clients. But there are certain advantages and disadvantages with both of them, and here we try to make a general differ-
entiation between the two.

POP3
You may encounter the following problems with POP3 access since e-
mail needs to be downloaded onto the PC before being displayed: You
are required to download all e-mail again when using another PC to
check your email. If you need to check e-mail at office as well as home
in this way, it can lead to confusion. Depending on the settings of your
e-mail client, the downloaded e-mail may be deleted from the server. 

During the “Check new mail” process, all messages as well as their
attachments will be downloaded to your computer.
While multiple mailboxes can be created on the PC to download the
mail, there is only one mailbox on the server that stores all the mail.
Incoming and outgoing messages are filtered and transferred only to
local mailboxes.

Outgoing mail is temporarily stored locally.

While you can delete the messages on the home PC very easily, clean-
ing up messages from the server requires you to download all mes-
sages with the mail client configured to delete mail after downloading.
If your hard drive crashes, you lose all your e-mails.

The client connects to the e-mail server for a short period of time, only
as long as it takes to download any new messages.
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IMAP
Since the email is kept on the server, it has the following benefits:
There is no need to download all e-mail when using other PC to
check your mail. Unread mail can be easily identified.

A complete message will be downloaded if and only if it is opened
for display to access its contents.
IMAP has the provision of letting you create multiple mailboxes on
the home PC as well as on the mail server.
Incoming and outgoing messages are filtered and transferred to
other mailboxes no matter where the mailboxes are located (on
the server or on the PC).
Outgoing mail is stored on a mailbox on the mail server and can
be accessed from another computer.
You can delete messages directly on the server, thus making it
more convenient to clean up your mailbox on the server.

Since the mail is stored on the server, you won’t lose your mail if
your hard drive crashes.
When using IMAP4, the client stays connected to the server as
long as the user interface is active and downloads message con-
tent on demand. In case of many or large messages, this can result
in much faster response times.
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Samir Makwana

An ERP software package helps organisa-
tions in effective and efficient manage-
ment of available resources such as

machines, material, manpower, inventory, etc. A
unified database serves the needs and require-
ments of various departments, leading to opti-
mised functioning. The aim of a business in
using an ERP (Enterprise Resource Planning) sys-
tem is to bring all its departments to a common
platform, such that the departments can easily
share information and communicate with 
each other.

To elaborate, in ERP, a single software pack-
age has modules customised to the needs of dif-
ferent departments—financial accounting, pro-
duction, distribution, marketing, inventory con-
trol, data warehousing, etc. ERP is, in sum, an
application for effective and efficient manage-
ment of the resources of an organisation.

Let’s say the human resources department
keeps a record of the
attendance, per-
formance on the
job, contribution,

and such for every employee. A software module
will keep these records and save it in a unified
database. When the employees are to be remu-
nerated, the finance department uses the same
database for calculating the employee’s salary
after the necessary costs, rates, and taxes have
been applied.

ERP systems have been used for ages, and
software packages provided by the vendors have
undergone several changes. Today, ERP is used by
large corporations as well as small-and-medium
businesses; almost every sector has some form of
ERP implemented. 

The Opportunities
Earlier, ERP was confined to the manufacturing
sectors. Its success led to a further demand for it
in industries such as automobiles, media, phar-
maceuticals, textiles, telecom, heavy machines,
and many more. 

“The growth of ERP as a business solution has
fuelled the adoption of upcoming technologies
and implementation of ERP packages in several

Enterprise in ERP
ERP systems are
expanding in just
about any
industry. Are you
ready to position
yourself as one of
the leaders in the
multi-faceted
expansion of
business models?

Tech Careers

How Technology Can Help Your Organisation
Business
Digital

Illustration Pradip Ingale

106Clutterless
Connectivity! 117 To Simpler

Times 122 Thin Clients
Experiences
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companies across various industries. This has
also spawned the growth of IT consultant firms
that specialise in helping organisations both in
India and abroad in implementing ERP solutions.
It also requires organisations where ERP has been
adopted to develop teams for ongoing mainte-
nance of the applications and providing support
to clients,” says Jason Gonsalves, Vice President,
IT and Corporate Planning, Kansai Nerolac
Paints, a leading paint manufacturing company.

The implementation of ERP passes through
a number of stages—analysis of the business
process, the drawing up of plans for the ERP,
installing and configuring the ERP package,
and, finally, support and management.

Thus, the demand for ERP professionals is,
naturally, in companies who have adopted or are
planning to adopt ERP applications. There are
several options for those who have specialised
knowledge in this field—through either educa-
tion or work experience. The increase in adoption
of ERP by various industry verticals has led to an
increase in demand for trained, skilled, and expe-
rienced ERP professionals. 

The Basic Requirements
Anyone aspiring to pursue a career in ERP sys-
tems should have at least a Bachelor’s degree
from either functional or technical academics.
The qualifications required vary according to the
role to be played. The roles in this field are broad-
ly divided into Functional and Technical, so the
basic requirements are as follows.

Functional: The qualification required is a
Bachelors or Masters degree, which is to be pur-
sued depending upon the function to specialise
in. Someone willing to specialise in finance must
have an academic background in finance: MBA
(Finance), Chartered Accountant, Cost
Accounting, Financial Analyst, etc.

Freshers are not likely to be selected directly
from campuses. It is advisable to pursue further
formal education in the respective functional
area (finance, materials management, produc-
tion management, etc.) and acquiring experience
of working in the domain of their interest. After
gaining sound knowledge of that particular func-
tion, they can pursue training by the ERP soft-
ware vendors, who have specific course modules
for professionals in a specific domain.

Technical: This deals purely with the devel-
opment of software. For that, a minimum of a
Bachelors or Masters degree from an engineering

background, specialising in computer science or
software engineering, is preferred. Students pur-
suing degrees in computer applications and IT
are also eligible. Candidates should possess
strong programming skills with a constant urge
for learning, as they may have to work on multi-
ple applications.

Courses in specific domains are offered by
ERP vendors such as Oracle and SAP. Education
and training can be acquired from ERP vendors’
authorised centres and authorised training part-
ners: the certifications they provide are accepted
by various industry verticals. These courses are
usually short-term, and a bit expensive.

The industry prefers to recruit professionals
who carry a vendor-specific degree. A number of
private training institutes have cropped up, and
impart training on ERP products. However,
“Unless authorised by the ERP product vendors, it
is not a wise to opt for an unauthorised institute.
There are many institutes that are not authorised
and use pirated software for training,” says
Nilanjan Chaudhuri, Vice President, Marketing,
PSI Data Systems, a software development, solu-
tions, and consulting service provider.

Skill Sets
Hands-on skills are looked upon as the basic
benchmark for the assessment of a suitable can-
didate. An ERP consultant should be dynamic
and able to adapt to constant change. One must
possess good soft skills, too.

Functional: In a company such as one that
provides consulting and solution services in ERP,
consultants have to interact with clients from
various industries. Understanding the client’s
needs, drawing up plans, and communicating
these to the implementation team are typical
duties. Soft skills such as being a patient and
attentive listener, good communication skills,
presentation skills, team-leading ability, and the
ability to persuade clients are important. Good
logical thinking is a must.  

Technical: Those on the technical side are
into programming and application development,
so hard skills are valued: problem solving skills,
good logical thinking and analysis, communica-
tion skills, and being a good team player.

The Importance Of Training
Every organisation has training programmes of
their own for fresh recruits, irrespective of work
experience and educational qualifications.

“Training programmes are important, as a
shortage of trained and experienced profession-
als is always faced. Training helps professionals
gain hands-on experience and more understand-
ing, which will help them in the execution of
their job. Though training freshly recruited staff
is cost intensive, it is looked upon as a long-term
investment in them,” says Chetan Pathak, Vice
President, Enterprise Solutions, Ramco Systems
(India) Ltd, a company that provides enterprise IT
solutions and services. 

“At Wipro, we have an internal Talent
Transformation Cell, where we train people
recruited to work with ERP systems on platforms
of vendors such as Oracle, SAP, MS Dynamics, etc.
After the training, they get certified on their

ERP consulting
and solutions are
people’s business,
where
interpersonal and
intrapersonal
skills are equally
important—
besides basic
qualifications and
certifications”

Satish Joshi
Chief Technology
Officer
Patni Computer
Systems Ltd

FUNCTIONAL
Trainee Consultant
Assistant Consultant
Associate Consultant
Consultant
Senior Consultant 
Lead Consultant 
Managing Consultant/Project Manager
Principal Consultant
VP, Consulting and Business Solutions
Senior VP, Consulting and Business
Solutions

TECHNICAL 
Trainee Software Engineer
Software Engineer
Senior Software Engineer
Associate Software Consultant
Software Consultant 
Senior Software Consultant 
Lead Software Consultant / Product
Manager 
Technical Advisor 
Senior Technical Advisor
Chief Technical Advisor / Officer

The Growth Path

Note: The designations above are indicative
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respective modules and are exposed to hands-on
projects—to learn the functional aspects of busi-
ness design and adopt best practices in the ERP
package,” says Krishna Kumar Tirumalai S, Head,
SAP Delivery, Wipro Infotech Ltd.

For in-depth and hands on expertise, compa-
nies also conduct training programs addressing
specific roles in ERP. “We have a career develop-
ment framework, through which specific train-
ing is delivered to the candidate depending on
the job experience the candidate has acquired
over the years and on his or her aspiration and
capability,” says Suman K Mazumder, Director,
Application Services Global Delivery, IBM India.

This training period varies depending upon
the role of the individual and the organisation.
On-the-job training is also common in many
organisations, and some are flexible enough to
allow and encourage employees to pursue educa-
tion related to their job function.

“ERP consultants need to keep themselves
updated with new applications and evolving
technologies. Quitting their official obligations
and pursuing full-time study is not a wise choice.
The concept of part-time module courses has
therefore evolved—to help them keep pace with
changing trends,” says Anand Ekambaram,
Director, Education Services, SAP India Ltd.

The Options
Careers for ERP professionals lie in product devel-
opment, implementation, maintenance, and con-
sulting. Within these, there are multiple options
available. Industry verticals often refer an ERP
professional as a consultant based on his or her
role and area of expertise in that organisation.
The ERP employment scenario offers career
options that can be classified primarily into
Functional, Technical, and Training.

The Functional Area: Career options here
need in-depth understanding along with experi-
ence of physical implementation in various func-
tions of the business process. “By relevant experi-
ence and sound knowledge of functions like
finance, human resources, materials manage-
ment, quality control, production planning,
manufacturing processes, etc., a person can excel
in an ERP career. Also, the full life-cycle experi-
ence of the implementation of the ERP package
in one or more functional modules is necessary,”
says B Chandrashekhar, Vice President and
Delivery Head (SAP, Oracle and Siebel),
Datamatics Limited, a company that provides off-
shore outsourcing software services.

The ERP functional consultant interacts with
the client organisation—he understands their
business processes, requirements, and problems.
He then analyses and builds the process flow of
the functions, and recommends a cost-effective
implementation of an ERP solution package.

The Technical Area: In ERP software compa-
nies, the individual can be involved in develop-
ment of various applications on different plat-
forms—an ERP package or specific modules with-
in a package. They work on ERP applications like
mySAP, Oracle 11i, PeopleSoft, and J D Edwards,
to name a few. These professionals—often
referred to as consultants—code the require-
ments of the business and integrate them to form

a plan for implementation of ERP in the clients’
business process models. In organisations that
provide consulting services, the technical profes-
sionals are also required for the implementation
team and maintenance. 

The Training Area: After relevant industry
experience and pursuing training through ven-
dor-specific courses, training can be a good
career option. Organisations looking to train
their freshly-recruited ERP staff always need
training professionals. Experience of working on
different platforms and knowledge of many
domains are important for a trainer.

Freelancing: Many ERP professionals provide
freelance consulting to client organisations. It is
mostly small or medium businesses who hire
freelance consultants for implementation or
maintenance for their ERP requirements. As a
freelancer, one can perform any role from the
bottom to the top level, depending, of course,
upon the years of experience and specialisation.

The Growth Path
Since ERP systems are implemented across differ-
ent industry verticals, different designations are
awarded to individuals in the ERP stream. See
box The Growth Path.

One cannot become, say, a principal consult-
ant in a short time-span. It takes years of experi-
ence in domains such as telecom, automotives,
textiles, chemicals, etc. We can roughly say that
the average time taken to climb each step of the
designation ladder from the bottom is at least
two years. To climb up to the position of Principal
Consultant takes at least eight to 12 years with
industry experience in particular domain.

It is difficult to determine the approximate
salary range. The remuneration structure differs
widely amongst companies, based on their size
and policies. However, one can expect Rs 30,000
per month to Rs 45,000 and higher at the lower
levels, that is, when advancing from Trainee
Consultant / Trainee Software Engineer to
Assistant Consultant / Software Engineer. 

From Associate Consultant/Senior Software
Engineer to Senior Consultant / Senior Software
Consultant, one expect between Rs 45,000 and
65,000. From Lead Consultant / Lead Software
Consultant to Principal Consultant / Senior
Technical Advisor, between Rs 65,000 and 80,000
can be expected. As for the top-most designations
in both the functional and technical areas, 
Rs 85,000 per month and above is a norm.
However, these figures are indicative.

Concluding Remarks
A lot of Indian companies have come out with
highly customisable ERP package suites specifi-
cally for small and medium enterprises in vari-
ous domains. These have a product life-cycle, and
need to be constantly upgraded to keep pace with
the technology and business requirements.
Opportunities in such organisations are very
healthy, both in India and abroad.

A self-assessment of one’s strengths and areas
of interest must be clearly conducted before opt-
ing for this field as a career. Once that’s done, the
world awaits you! 

samir_makwana@thinkdigit.com

Since ERP solves a
business problem
with technology,
it is important to
have a good
understanding of
either technology
or domain, along
with an
appreciation of
the other”

Murali Subramanian
Vice President –
Applications
Development, 
Oracle India Pvt. Ltd
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Michael Browne

H
ouseholds and offices
in the US and Europe
crested the wireless
wave a couple of years

ago. The wave has struck our
shores more recently. While we
cannot deny the fact that
cables are still very much the
preferred means for data
communications today, Wi-Fi,
both as a technology and as a
means to communicate has
made strong inroads in our
comparatively emerging market. 

To the home user, Wi-Fi a.k.a.

Wireless Fidelity represents
convenience in its simplest
sense. Freedom from sitting in
front of your PC and surfing,
when you could be in bed, chat-
ting with your significant other
and your friends online simul-
taneously! The biggest advan-
tage of Wi-Fi is, of course,
freedom from ugly, restricting
wires. Your kids could be surfing
the Net for school projects while
you browse on your laptop,
lounging in your lawn chair. 

The first challenge you’ll
face before going cable-free will
be to decide what sort of wire-
less device to buy. Wi-Fi ADSL
Routers offer all the functional-

ity of a regular wireless router in
addition to having ADSL
modems inbuilt. Regular Wi-Fi
Routers offer multiple connec-
tors, and some even offer USB

connectivity. An Access Point is
quite simply meant to provide a
wireless network without rout-
ing functions. What type of Wi-
Fi device you require depends on
your need as always. Do you just
want to enable Net browsing on
your laptop or Wi-Fi enabled
PDA? Do you need to transfer
data from laptop to desktop
without cable hassles? You may
need an Access Point (AP) in such
cases. Do you plan to setup a
small SoHo network, combining
two or three PCs with a couple 
of laptops wirelessly? In such 
a case, you should invest in a 
Wi-Fi router. 

Whatever your need, there’s

always a solution to it. This is
where we come in! Just so that
you can make an informed deci-
sion, we’ve torture-tested 14 Wi-
Fi devices.

Imaging Pradip Ingale
Photograph Amrut Patki

CONNECTIVITY!
LUTTERLESS

Going cable-free is the in thing. We’ve
tested 14 devices designed to de-wire
your life!
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Amongst the wireless routers we received, just two were ADSL-ready: the Netgear DG834G and the
ASUS WL-600G were the only two routers with ADSL modems inbuilt. Such routers are your first
choice if your Internet Service Provider (ISP) provides you with a telephone line based broadband

connection. Most telecom-based companies such as MTNL and Airtel will provide you with ADSL connec-
tivity (RJ11-based). When getting such a connection, you are generally given the option of either purchas-
ing your own modem or buying one from the ISP. 

Now if you have a laptop or any wireless devices that you might want to share this Internet connec-
tion with, it’s probably your best bet to invest in a Wi-Fi ADSL router. As you’ll see from our tests, Wi-Fi
ADSL routers offer extra features without compromising on performance. To top it off, they’re not as
expensive as you’d perceived them to be!

The stunning WL-600G would grace any work-
space it occupies, meriting at least a second

glance! Build quality’s excellent, and this was the
only router with a convenient power on/off switch. 

The WL-600G is a feature-rich offering, with two
USB ports, and the ability to set up a print server. Its
firmware interface has a few more settings avail-
able for tweaking, as compared to the other ASUS
devices we tested.

The scores this one brought up weren’t the

highest we got, but what blew us away were the
signal strength figures, espe-

cially in Zones 2 and 3.
At 54 per cent in
Zone 2, it’s a whop-
ping 8 per cent
stronger than its

closest rival, the
Senao ECB3220.

Even in Zone 3, the WL-
600G hammers everything around

with a signal strength of 49 per cent!
This one has a lot of features, but the high price

tag of Rs 8,500 will not please everyone.
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WI-FI ADSL ROUTERS

We received seven such devices. The difference between these and their ADSL counterparts is they
don’t have ADSL modems inbuilt. They cannot therefore utilise an RJ11 WAN connection. Most

routers will have an RJ45 interface for WAN connections.

WI-FI ROUTERS

ASUS WL-600G
Features, performance, and looks collide…

The pearl-white coloured Netgear DG834G is a
sleek beauty. The activity indicators are also

well-done, and clearly legible even under well-lit
conditions.

We set this one up in a jiffy, thanks to the
great firmware interface. Netgear also helpfully
provides very detailed help for each option, and
each item is very well explained. In fact, the help
is so detailed, you could use it as a ready reference
for what each option means.

The DG834G breezed through most of our

tests, clocking the fastest time in
our Zone 2 multiple file transfer,
averaging a blazing 1.09 MBps.
This router will be very suitable
for a SoHo user who wants to
transfer a lot of data wirelessly.
It’s equally at ease browsing band-
width-hogging Web pages.

At Rs 4,230, the DG834G keeps
your wallet happy… very happy,
considering the features and the
fact that it’s blazingly fast.

Netgear DG834G
Sleek and fast

The “small wonder” in this
test, it’s small enough to be

stuffed inside your cargo
trouser pockets, yet powerful
enough to ensure a near-seam-
less unwired experience.

The activity LEDs are, surpris-
ingly, mounted behind the device
and on top. We’d have preferred them in front, or
at least where they can be viewed easily even if the
device is kept above the user’s line of sight. 

ASUS’ software definitely isn’t the best laid-out

that we tested, and neither is the main menu very
intuitive.

Due to its tiny footprint, we’d recommend it to
the hotspot browser on the move. Its speed of 1.29

MBps was unmatched in the Zone 1 test. This
makes it suitable for setting up a home or
SoHo wireless office where its potent data
throughput capabilities will be put to good

use. It excelled in the video streaming test as
well, meaning you needn’t sit in front of your PC’s
monitor if you own one of these.

At Rs 4,400, the WL-530G offers excellent value
for money. If you’re looking for the fastest Wi-Fi
router out there, grab the WL-530G—it’s our Best
Buy Gold winner!

ASUS WL-530G
Tiny but mighty!

JA N U A RY  2 0 0 7
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The AG108 exemplifies build quality. It’s a great
looker, and that grey-and-silver body will look

smart on your desk, and equally so atop your bed-
room armoire! It sported the biggest (physically)
antenna we’ve seen on a Wi-Fi router. It was also
the only router we received with 802.11a compli-
ance. This means the AG108 can simultaneously
create a 5 GHz (802.11a) and a 2.4 GHz network
(802.11b/g). It even utilises a technique Buffalo calls
“Channel Bonding” to increase throughput by club-
bing the available bandwidth (of both the 5 and 2.4
GHz networks) together.

The device sports an AOSS button (Air station

One-touch Secure System). Very simply, this button
automatically assigns WPA keys to all clients on
the wireless network, once you’ve installed the
software on each of them. You’ll also have to click
the Profiles tab. Incidentally, the AG108 has a

good firmware interface, and is easy
to navigate even for first time

users.
The AG108 performed

decently in all the tests, save
one—our video streaming

test—where, for some reason, we
got some framing.

The Air Station AG108 is a good product with a lot
of add-on features, but there other products available
that outperform it on all fronts.

Buffalo WHR-HP-AG108 “Air Station”
Great show with the go!

With four RJ45 (LAN) ports in addition to two
USB ports, connectivity is never going to be a

bottleneck with the NP-27G. It has an inbuilt print
server, making it ideal for the SoHo segment.

The NP27G incorporates the Atheros XR
(eXtended Range) technology, which improves cov-
erage area of a Wi-Fi network, eliminating dead
spots. Atheros XR also supports a stronger signal
than what 802.11 specifications imply, and sup-
ports additional data transfer rates.

The software interface on the NP27G firmware
was the best we’ve seen this time round. It’s very

intuitive, and each option is proper-
ly placed under a relevant sub-

category.
Configuring the

NP27G was very easy
via the interface, and
even a newbie should-

n’t have too many problems
during the setup. 

Though the NP27G’s transfer rates weren’t the
slowest in our tests, it was very close to the bottom.
Surprisingly, it fared decently in the movie stream-
ing test: although the video was jerky at times, it
wasn’t as bad as we’d expected. The NP27G loses
out on performance but scores on features. It is rea-
sonably priced at Rs 5,500.

Compex NetPassage 27G
Ultraconnectivity!

With three LAN ports and four USB ports, the
NP 28G is primarily aimed at the SoHo seg-

ment. Home users will also benefit, especially if you
want to hook up a printer or even a Web camera
(courtesy the extra USB ports). Atheros’ XR makes
another appearance here. The firmware is identical
to that of the excellent NP-27G.

The NP 28G is slightly slower than the NP27G,
but only by a hairsbreadth! They perform similar-
ly when the AP is in the client’s vicinity. Once the

distance increases—and sig-
nal attenuation occurs—we
see the NP 27G creeping
ahead. 

This shows that the NP
28G is less suitable for heavy
bandwidth inter-room usage.
The streaming test also did not
complet to our satisfaction, and
there was noticeable
framing.

Overall, a good feature set at an outrageous
price—Rs 8,500—especially considering its less-than-
ideal performance.

Compex NetPassage 28G
Feature-laden—but light on performance!

The WAP 0010 is a funky looker with a sober grey
body, getting a slash of silver in the form of its

logo embossed topside. With three antennas and
MIMO support, we had high hopes for this product
in our test.

Coming to the firmware, there’s no username
field; you need to type in a password in the field
titled “login”. We found all the settings under
appropriate heads, and most of the deeper settings
were transparent, allowing us to tweak them to our

heart’s content.
Unfortunately, no

amount of tweaking
helped it perform well! To
compare it to the prover-
bial tortoise would be
unfair, as there were slow-
er competitors in the test.
Needless to say, if you’re
looking at bandwidth-hun-
gry data transfers and
movie streaming, give the
WAP-0010 a wide berth.

Level One WAP-0010
A decent performer
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The WRT300N is a stylish, futuristic-looking
router that supports the yet-to-be-announced

802.11n standard (Pre-n as of now). Its dark grey,
black and smoky blue body will turn eyes, as will
the radar-looking antenna booster. 

The WRT300N brims over with features that
can be accessed from its intuitive firmware menu.
The WRT300N also supports MIMO, which helps
maximise signal coverage while reducing occur-
rences of dead spots within its effective range.

We expected a lot from this
model, it being the only Pre-n device
that made it to this test. As you’ll see
in our table, it brought up some solid
scores, but nothing worth cheering
about. It was well and truly beaten by
some of the other routers—in particu-
lar the ASUS WL-530G and the
Netgear DG834G.

The WRT300N remains a good
choice for the home segment because
of its plethora of features and the fact
that it’s future-proof.

Linksys WRT300N
Feature-rich, future-proof

The WRT54G is a simple, no-nonsense looking
router that sports twin antennas. The firmware is

as intuitive as that on the WRT300N. The minus point
is immediately evident—there’s no logout button;
you simply have to close your browser window after
saving settings (in case you’ve changed any). We
weren’t able to check from the interface whether our
two laptops were connected. For that, we had to filter
the MAC address list to show the clients connected. A
couple of things missing in the interface; not of great

use to home users, but a SoHo
would miss them. Incidentally,
the WRT54G loses out on
Wireless Bridging as a feature.

While it outpaces the
WRT300N in the Zone 1 tests, it
lags behind in Zone 2. This shows
its signal quality is slightly inferi-
or, because signal strength of the
models in Zone 2 was identical. Where
this one scores is in pricing; it costs just
Rs 3,634, and you’ll get why the Digit Best Buy Silver
award goes to the WRT54G.

Linksys WRT54G
Performance you don’t pay a wad for!

Testing Wireless devices involves gauging performance on mainly
two fronts—transfer rates (speed) and effective range. 
Our Wi-Fi test was done simulating all possible real-world

conditions, for which we created the test “zones” we’ve described
below. Please note that distances aren’t important for
benchmarking any sort of Wi-Fi network; it’s the obstructions
between the Access Point (AP) and the signal recipient that
ultimately matters. Metallic objects, wooden cabinets, concrete
walls, and general furniture all cause what is called attenuation of
wireless signals. The signal strength is reduced, which causes loss of
data integrity and therefore slows down data throughput. With this
in mind, we designed each of these zones to actually take each of
these wireless devices to their performance limits.

Zone 1: The laptop was placed within 15 feet of the AP.
There was a wooden partition between the AP and the
client, though they were essentially in the same room.
SIgnal attenuation was at a minimum.

Zone 2: We placed the laptop within 25 feet of the
router. This time we ensured there were a good deal of
signal-obstructing objects. There was a concrete wall
(with inbuilt cupboards) in between the Wi-Fi devices to
further scramble reception. This was in addition to a
couple of wooden partitions.

Zone 3: Our test laptop was placed approximately 30
feet away from the router. Here we actually moved
the laptop to a higher floor. We also ensured the laptop wasn’t
exactly above the router placed a level below (this would be too
easy). This was the most strenuous test for the routers, as
multiple obstructions create ample cause for attenuation and
hence signal loss.

We created test files to be copied from the PC to the laptop
wirelessly. In each Zone we used two different files. One was a

single RAR archive, while the other was a set of small files of
various types to simulate every possible data transfer scenario. The
file sizes were kept the same in the same Zone, but sizes across
Zones varied—100 MB for Zone 1, 50 MB for Zone 2, and 25 MB for
Zone 3. The speeds were recorded in Megabytes per second (MBps).
Please note that most manufacturers quote figures in Megabits per
second (Mbps). Keep in mind that 1 byte equals 8 bits.

Next we streamed an HD video file encoded at 1280 x 720
(720p). This clip was on our test PC’s hard disk, and was streamed
to first one, and then two, laptops. We awarded points based on the
entire viewing experience. In case any jerking of frames was really
noticeable, points were deducted accordingly. A score in excess of

7.5/10 means the device is capable of providing a good movie-
watching experience.

Finally, we used Wireless Mon version 2.0 as a benchmarking
tool to measure signal strength in each of the Zones.

In our signal strength at 20 metres test, we ensured there were
two concrete walls between the AP and the test laptop. Wireless
Mon was our benchmark of choice here as well.

How We Tested

Processor
Motherboard
Memory

Graphics card

HDD

Wi-Fi Solution

PC
AMD x2 4800+
AMD x2 4800+
512 MB x 2 Corsair
XMS DDR 400
XFX Geforce
7900GTX
Hitachi T7K 250
SATA 2.0
NA

Laptop 1
Pentium M 1.73 GHz
Intel 915GMS
512 MB DDR2 533

Intel Integrated
915GM
Toshiba 80 GB
4200 rpm
Intel Integrated

Laptop 2
Pentium M 1.2 GHz
Intel 915GMS
512 MB DDR2 533

Intel Integrated
915GM
Fujitsu 60 GB 4200
rpm
Intel Integrated

Test Rig Specifications

JA N U A RY  2 0 0 7
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Very fast, well- 
priced
None in particu-
lar

Excellent value 
for money
None in particu-
lar

Lots of features
Lacking in per-
formance

Good signal 
strength
Low on perform-
ance

Good bundle and 
features
Low on perform-
ance, high on price

Fast and feature-
rich
Expensive

ASUS
WL-600G

ADSL Router
b/g
✔

✖ /✔ /✔

1
✔

4
2

✔

✔

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✔ /✔

✔

✔

8.0
6.0
7.5

63.00
0.83
0.66

54.00
0.88
0.63

49.00
0.45
0.39
35.00
8.50

25.97
37.92
6.18
70.06
8,500
2

Netgear
DG834G

ADSL Router
b/g
✔

✖ /✔ /✖

1
✔

4
0

✔

✔

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✖

✖ /✔

✔

✔

7.0
8.0
7.5

64.00
0.58
0.53

44.00
1.21
1.09

31.00
0.65
0.54
25.00
8.50

23.66
39.85
12.41
75.92
4,230
2

ASUS
WL-530G

Router
b/g
✖

✔ /✖ /✖

1
✔

4
0

✔

✔

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✔ /✔

✔

✔

7.5
6.0
7.5

66.00
1.29
1.07

42.00
1.22
0.87

30.00
0.60
0.50
30.00
8.00

23.99
43.58
11.93
79.50
4,400
2

Buffalo
WHR-HP-AG108

Router
a/b/g
✖

✔ /✖ /✖

1
✔

4
0

✔

✖

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✖ /✔

✔

✔

6.5
8.0
8.0

54.00
0.49
0.40

42.00
0.47
0.39

31.00
0.37
0.34
24.00
6.50

22.47
27.25
7.00
56.72
7,500
2

Compex
NetPassage 27G

Router
b/g/Super g
✖

✔ /✖ /✔

1
✔

4
2

✔

✔

✔

✔

✔

✔ (Kit provided)
✖

NAT & SPI
✔

✔

✔

✔

✔

✖ /✔

✖ /✔

✔

✔

6.5
8.5
7.5

63.00
0.36
0.31

41.00
0.13
0.11

33.00
0.19
0.16
26.00
7.50

23.84
22.70
9.55
56.08
5,500
3

Compex
NetPassage 28G

Router
b/g/Super g
✖

✔ /✖ /✔

2
✔

4
4

✔

✔

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✖ /✔

✖ /✔

✔

✔

6.5
8.5
7.5

61.00
0.37
0.31

42.00
0.11
0.10

31.00
0.17
0.15
24.00
7.00

23.78
21.51
6.18
51.46
8,500
3

BRAND
MODEL
Features
Type Of Device (AP/Router/ADSL Router)
Protocols Supported (802.11 a/b/g/Pre n)
ADSL Modem Inbuilt (Y/N)
Type Of WAN Port (Ethernet/ADSL/USB) 
Number Of Antenna(s)
Wireless Bridging (Y/N)
Number Of RJ45 (LAN) Ports
Number Of USB Ports
Device Features
Power Indicator (Y/N)
Internet Connectivity LED (Y/N)
Individual LAN Port LED (Y/N)
Activity Indication (Blinking) (Y/N)
Factory-Defaults Reset Button
Wall-Mountable (Y/N)
Power Over Ethernet (Y/N)
Security
Firewall (Types Supported)
LAN I/P Based Site Blocking (Y/N)
Encryption (Y/N)
Wireless Isolation (Y/N)
Port Mapping (Forwarding)
Deep Packet Inspection
Firmware Interface Features
Basic Setup Wizard (CD/Browser)
Online/Offline Firmware Upgrade (Y/N)
Settings Backup To HDD
Load From HDD
Ease of Installation / Use
Bundle (So10)
Software Interface (So10)
Device Settings (So10)
Performance
Zone 1 (100 MB File)
Signal Strength in Zone 1*
Single File (MBps)
Multiple Files (MBps)
Zone 2 (50 MB File)
Signal Strength in Zone 2*
Single File (MBps)
Multiple Files (MBps)
Zone 3 (25 MB File)
Signal Strength in Zone 3*
Single File (MBps)
Multiple Files (MBps)
Signal Strength at 20 metres (%)*
Video Streaming HD 720p WMV (Out of 10)
Final Scores
Features (Out of 30)
Performance (Out of 55)
Price Index (Out of 15)
Grand Total (Out of 100)
Price (Rs)
Warranty (years)

Scoreboard                        ADSL Routers Routers
JANUARY 2007

*From Wireless Mon 2.0



111DIGIT JANUARY 2007

Decent performance,
good warranty
Low on features

Very feature-rich, 
Pre n support
Expensive

Fast transfer 
speeds
None in particular

Decent features
Very poor 
performance

Great 
performance
None in particular

Great signal 
coverage and 
performance
Quite expensive

Good bundle
Low on perform-
ance

Level One
WAP-0010

Router
b/g
✖

✖ /✖ /✖

3
✔

4
0

✔

✔

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✖ /✔

✖ /✔

✔

✔

7.5
7.0
7.0

61.00
0.51
0.45

54.00
0.52
0.43

25.00
0.25
0.18
21
7.50

22.08
26.08
9.18
57.34
4,900
5

Linksys
WRT300N

Router
b/g/Pre n
✖

✔ /✖ /✖

2
✔

4
0

✔

✔

✔

✔

✔

✖

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✖ /✔

✔

✔

7.5
8.5
8.0

54.00
0.47
0.42

42.00
0.61
0.44

32.00
0.28
0.22
34.00
8.00

24.00
28.85
5.25
58.10
9,995
3

Linksys
WRT54G

Router
b/g
✖

✔ /✖ /✖

2
✖

4
0

✔

✔

✔

✔

✔

✔

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✖ /✔

✔

✔

7.5
8.5
8.0

53.00
0.55
0.47

42.00
0.45
0.36

31.00
0.28
0.24
31.00
7.50

24.30
27.62
14.45
66.36
3,634
3

ASUS
WL-320G

AP
b/g
✖

✔ /✖ /✖

1
✔

1
0

✔

✔

✔

✔

✔

✔

✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✔ /✔

✔

✔

6.0
6.0
6.0

58.00
0.41
0.25

38.00
0.12
0.10

31.00
0.12
0.11
31.00
6.50

23.06
21.22
5.06
49.33
8,900
2

Compex
WP54G 1a

AP
b/g
✖

✔ /✖ /✖

1
✔

2
0

✔

✔

✔

✔

✔

✖

✔

NAT & SPI
✔

✔

✔

✔

✔

✖ /✔

✖ /✔

✔

✔

6.5
8.0
7.0

62.00
0.34
0.28

44.00
0.15
0.10

29.00
0.10
0.08
26.00
6.00

22.74
19.87
7.56
50.18
5,950
3

D-Link
DWL-2100 AP

AP
b/g
✖

✔ /✖ /✖

1
✔

2
0

✔

✖

✔

✔

✔

✔ (Kit provided)
✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✖ /✔

✔

✔

7.5
7.0
6.5

59.00
0.39
0.27

42.00
0.16
0.12

30.00
0.12
0.11
26.00
6.50

21.98
20.79
11.28
54.05
3,990
1

Linksys
WAT54G

AP
b/g
✖

✖ /✖ /✖

2
✔

1
0

✔

✔

✔

✔

✔

✔ (Kit provided)
✖

NAT & SPI
✔

✔

✔

✔

✔

✔ /✔

✖ /✔

✔

✔

7.0
8.0
7.0

54.00
0.66
0.53

40.00
0.67
0.56

38.00
0.31
0.26
23.00
8.00

22.88
29.68
11.79
64.35
3,816
3

Senao
ECB 3220

AP
b/g
✖

✔ /✖ /✖

1
✔

1
0

✔

✔

✔

✔

✔

✖

✔

NAT & SPI
✔

✔

✔

✔

✔

✔ /✖

✖ /✔

✔

✔

7.5
6.0
7.0

64.00
0.74
0.63

46.00
0.72
0.53

34.00
0.35
0.30
30.00
7.50

21.74
32.77
5.43
59.94
8,280
2

PoE support
Very poor per-
formance

Access Points
JANUARY 2007 JANUARY 2007JANUARY 2007
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Five Access Points (APs) competed in our test. An AP is the simplest way to set up a Wi-Fi network at
home. It’s convenient to connect a single laptop to a PC. SoHos should look elsewhere, because APs typ-

ically have just a single RJ45 connect.

ACCESS POINTS

The ASUS WL-320G is wall-mountable; since it
doesn’t have rubber foot pegs it will move eas-

ily if kept on a surface. It’s well built, though, and
the activity LEDs are well-placed and clearly legi-
ble.

ASUS has incorporated a high-speed mode on this
model—Afterburner. The client device also needs to
support it, in which case performance is boosted.
Fancy titles aside, the WL-320G was a very mediocre

performer, and that’s putting it mildly. It was the
slowest in our Zone 1 multiple file transfer test,
clocking in the vicinity of 400 seconds.

Not surprisingly, the lower data throughput
on the WL-320G led to some

jerks during our movie
streaming test.
Although it wasn’t
downright unwatch-

able, we wouldn’t sug-
gest the WL-320G for this specific

purpose, especially at the steep price of Rs 8,900.

ASUS WL-320G
Cool looker, light performer

The third in the Compex trio to be received was
a simple AP—no routing capabilities here. 
The WP54G supports PoE (Power over

Ethernet). Although PoE implementations differ
greatly between manufacturers, the basic principle
remains the same (see box Wi-Fi Demystified). 

The WP54G lagged behind in quite a few tests,
especially in Zone 3, where it was thrashed by the
competition. In fact, data transfer was interrupted

once, due to a loss in signal
integrity.

Video stream-
ing, as we’d expect-
ed, was abysmal—
jerking, and lots of
interruptions. We

don’t recommend the
WP54G as an AP, despite the

inclusion of PoE—simply because
of its inadequate performance. Its price tag of Rs
5,950 won’t garner any accolades either.

Compex WP54G
An AP not worth accessing!

Wi-Fi Demystified
Wi-Fi: An acronym for Wireless Fidelity,
Wi-Fi quite simply denotes “Wireless
Networks” that conform to IEEE
(International Electrical and Electronics
Engineers) standards. The Wireless
standard accepted by the IEEE is 802.11.
The most common Wi-FI standards
within 802.11 are 802.11a, 802.11b,
802.11g, 802.11 Super g, and 802.11
Pre n.
Gateway: A gateway is responsible for
proper data flow and distribution within
a network and externally to other
networks. The gateway machine is also
called the host computer or network
router.
SSID: Service Set Identifier or simply
“Network Name” is the name (typically
alphanumeric) by which a Wireless
Local Area Network (WLAN) identifies
itself. To communicate with any devices
on a wireless network, all wireless
devices must use the same SSID. The
SSID can be kept private, in which case
a user who doesn’t know the SSID
cannot gain access to that network. 
WEP: Acronym for Wired Equivalent
Privacy. This was the earliest security

method adopted by the 802.11
standard, providing 64- and 128-bit
keys (hexadecimal coded) to protect
wireless devices from unwanted
intrusion.
WPA/WPA2: An acronym for Wireless
Protected Access, which is a more
secure method of protecting data
transmission than WEP. WPA 2 is a
newer protocol. It’s also known as
802.11i.
DHCP: Acronym for Dynamic Host
Configuration Protocol. It’s a
communications protocol that
automatically assigns IP addresses to
clients logging on to a TCP/IP network.
MAC Address: An acronym for Media
Access Control Address. It’s a unique
identifier for an individual node on a
Wi-Fi network. It is represented as a
string of six pairs of hex characters, for
example, FF.EE.FF.FF.00.FF
NAT: An acronym for Network Address
Translation, it’s basically a firewall
feature. NAT is available on most
routers today, both wired and
otherwise. NAT enables individual IPs of
clients on a network LAN to remain

invisible beyond the LAN, and any
external communication occurs through
the gateway machine. Packets of data
recieved by the gateway machine are
then routed to the clients that
requested them. In case the packet
received doesn’t correspond with a
request sent by a machine on a
network, it is rejected.
Port Mapping: Port Mapping or Port
Address Translation is the process of
translating and routing packets arriving
at a particular IP address or port to
another IP address. Port Mapping
bypasses NAT.
Deep Packet Inspection: Deep Packet
Inspection (DPI) is a form of packet
filtering that inspects the data portion
of data packets as opposed to just
checking the header portion. DPI is
basically an evolved form of SPI
(Stateful Packet Inspection).
PoE (Power over Ethernet): This
describes the ability to transmit power
as well as data to devices over an
Ethernet cable. PoE is extremely useful
in cases where the AP is placed in an
area with no power point. 
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The DWL-2100AP is well-built, sturdy, but light.
It’s also wall-mountable; a complete kit is pro-

vided. D-Link’s firmware interface is good, but
not as well laid-out as on the Compex prod-
ucts. The manual that accompanies
this device is more informative
than that that came with the
other brands.

We were disappointed to see the
scores on the DWL-2100AP. At 0.12
MBps it’s a whopping 500 per cent slow-
er than the ASUS WL-530G when it comes
to transferring files across relatively larger
distances!

Although it was faster than the Compex
trio while transferring single large files, it
lagged behind while transferring a bunch
of smaller files. The movie streaming test
also saw this AP trail behind what is accept-

able for watching seamless video. 
It’s not suitable for file

transfers or movie streaming
if you intend to set up your

server and client on dif-
ferent floors, or if the dis-
tance between AP and
client is anything over

15 feet. At a price of Rs 3,990,
you’d be better off buying the blazing-

ly fast WL-530G, which throws in routing
capabilities as well.

D-Link DWL-2100AP
Slowcoach to Wi-Fi town…

The WAT54G is the AP equivalent of the
WRT54G. Instead of just dropping out a few

features (which it does), the WAT54G adds one:
bridging capabilities. Besides the lack of the four
RJ45 connects at the rear, the two devices look
identical!

The firmware interface is identical to that of
the WRT54G, aside from the lack of routing func-
tions.

The WAT54G smoked the competition in our
data transfer tests—its 0.66 and 0.53 MBps in Zone 1
(single and multiple file respectively) are faster
than those of either of its brethren. Curiously, the
WAT54G was actually  faster in Zone 2—0.67 and

0.56 MBps, as compared to
Zone 1. We ran our tests
again just to be sure; while
the results weren’t identi-
cal (wireless transfers

rarely are), they were
consistent.

T h e
WAT54G is a
great access
point, very
deserving of

a c c o l a d e s .
We recognize this

and reward Linksys on a
great product with our Digit

Best Buy Gold  award.

Linksys WAT54G
The best access point out there!

A Decision Maker
You Want
Wireless connectivity to your laptop from your desktop PC
To set up a small home network, between two PCs and your laptop or Wi-Fi enabled PDA
To stream movies from your PC’s hard drive to your laptop(s) wirelessly
To set up a small office network wirelessly, complete with a network printer
An ADSL modem and a wireless router for a broadband connection, perferably wire-
less-enabled

You Need
An Access Point (AP)
A Wireless Router
A Wireless Router/ AP
A Wireless Router
A Wireless ADSL
Router

We Recommend
Linksys WAT54G
ASUS WL-530G, Linksys WRT54G
ASUS WL-530G, Senao ECB-3220
ASUS WL-600G, Compex NP27G
Netgear DG834G, ASUS WL-
600G

Our Test Zones 1, 2 and 3 Demystified

JA N U A RY  2 0 0 7
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Tips For A Better Signal

1. Interference
2.4 GHz is the frequency used by most
Wi-Fi devices. Unfortunately, this
frequency is rather common: it’s used
by a few household devices, namely
cordless phones and microwaves. Any
Bluetooth device will also interfere with
Wi-Fi signals, as will a cordless mouse.

2. Attenuation
Here are some common signal-
scramblers. Every household will have
most of these.
Plasterboard wall: 3dB
Glass wall with metal frame: 6dB
Wooden partition: 4dB
Office window: 3dB
Metal door: 6dB
Metal door in brick wall: 12.4dB
Now you know what happened to that
signal! We’re assuming average
thickness here. The thicker you go, the
lower your signal strength becomes.
You cannot avoid attenuation from
most of these materials, but knowing
what material absorbs what may help
you better position the router/AP. 

3. Up, up and away
Heights are good, especially for
wireless devices. Your router could
even be mounted on top of a cupboard
(just ensure it’s away from walls if
possible). Creating a little cradle mount
dangling from your ceiling would be
better. For a PCI wireless card, the
metal cabinet and components will
cause attenuation. No way to avoid this,
but keeping your cabinet on a table (as
opposed to on the floor) will help
reception. PCMCIA cards in laptops will
have the most problems with signals,
and it’s better to use the integrated Wi-
Fi solution, as the antenna will
probably extend into the screen area. 

4. Higher gain does not necessarily
mean a better signal
Higher gain means the signal is
concentrated more in a particular
direction. Note that the power supplied
remains unchanged, just that the same
amount of energy (beam) is focused in
a much tighter area. Higher gain
antennas therefore provide more

focused signal beams. They’re better
for large open areas, and may be
less effective in case the site has a lot
of attenuation-creating walls,
furniture, etc.

5. Other attenuating culprits
Tinted windows will absorb a lot of your
wireless signal. Note that regular glass
windows will not. Even wire meshes and
metal grilles will absorb signals like
crazy. The degree of attenuation may
be as much as what a solid metal object
causes.

6. Polarity
By polarisation here, we mean the
relation between the physical
orientation of each antenna and the
electric field that is parallel to the
antenna. Omni-directional antennas
have vertical polarisations due to the
fact that they’re meant to stand
vertically. This is why most PCMCIA
cards don’t perform well in tandem
with them (remember they slot into
your laptop horizontally).

PhoneCompany E-mailBrand

Contact Sheet Wireless Devices

ASUS
Buffalo
Compex
D-Link
Level One
Linksys
Netgear
Senao

ASUSTek Comp Inc.
Advent Infotech Pvt. Ltd
Rashi Peripherals India Pvt Ltd
D-Link India Ltd
Minds India Pvt Ltd
Ingram Micro India pvt. Ltd
Rashi Peripherals India Pvt Ltd
Rashi Peripherals India Pvt Ltd

022-40058923
011-41436751
022-67090909
022-26526696
011-26312095
9323112279
022-67090909
022-67090909

mamta_bhatia@asus.com
buffalo@adventelectronics.com
navinderc@rptechindia.com
sales@dlink.co.in
foziayasin@gmail.com
sunil.z@ingrammicro.co.in
navinderc@rptechindia.com
navinderc@rptechindia.com

Senao’s ECB 3220 is positioned
as a wireless bridge while also

functioning as an AP. In fact, in
keeping with its primary func-
tion (bridge), the ECB 3220 had
the best signal in Zone 2, and
just missed top spot in Zone 3.
It’s wall mountable. 

Although Senao’s firmware
is reasonably laid out, it lacks
detailed help on some settings.
The basics are covered well

though, but we had a
few problems set-

ting it up.

The ECB 3220s a steady per-
former. It didn’t lose reception
at all throughout the tests, even
while moving between Zones—
except while moving up the
staircase to Zone 3.

You should know that all the
devices in this test, with the
exception of the ASUS Wl-600G,
lost reception while the laptop
was being moved between
zones. This tells us that the ECB
3220 has a very strong signal.

Carrying a price tag of Rs
8,280, the ECB 3220 is as expen-
sive as an AP. However, because
of its powerful signal, office
users will find it useful as a
bridge between two wireless net-
works. We’re awarding it our
Best Buy Silver award.

Senao ECB 3220
A Bridge for all occasions

New Horizons
Throughout these tests, we hope
one thing’s become crystal clear…
wireless devices, though offering
freedom from wires, cannot sus-
tain anywhere near the high data
transmission rates that good old
Ethernet can. However, Wi-Fi as a
technology has matured suffi-
ciently to allow us to surf the Net
and stream audio and video sans
the discomfort. And we’re talking
discomfort from iffy connections,
sporadic transmission problems,
loss of signal, etc. 54 Mbps may
seem light years away from the
actual transfer rates these devices
offer when really stressed. 

The silver lining on the wire-
less cloud promises to be the
802.11n standard. As of now,
details about the exact specifica-
tions are sketchy (there’s no for-
mal draft as of today). What we do
know is the intensity of signal
will be much stronger than the
current “g” standard. Also prom-
ised is nearly ten times the band-
width—both the maximum theo-
retical and the typical (see table
Wi-Fi Standards). If 802.11n realises
this, we fully expect to see Wi-Fi
penetration soar in our country
as more and more people take the
wireless plunge. 

michael_browne@thinkdigit.com
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If you’ve ever heard of PivotTables, you either
swear by them or they’ve successfully baffled
you into not going near them. For a feature

that does what it does, the PivotTable is probably
Excel’s best-kept secret—this despite the fact that
it’s the easiest way to generate reports of your
data without knowing even a line of VB code. You
don’t even need to know what VB stands for to
create one! (Visual Basic, incidentally)

We’ll be using Office 2007 for this article—
most of the features carry over from Office 2003,
but the new ribbon on Office 2007 exposes a lot
more features that you can use with PivotTables,
so you might find something new even if you’ve
been using them for a while. 

Life Before The Pivot 
Imagine this rather innocuous table that looks
at the sales of five products in three cities, by
three salesmen. We’ll be using this as a refer-
ence, but the principles will apply to any data
that fits the “pivot-able” bill (we’ll come to that
in a bit).

Gauging a salesperson’s performance in
Mumbai, for example, is quite simple. You first
need to apply a data filter and select Mumbai
under City, then select each salesperson one by
one from the respective column. Select the Units
Sold column, and Excel gives you a total at the
bottom right of your screen. Repeat for each
salesperson, then repeat for each city. Ten rows
of data, no code, fifty-odd mouse-clicks. In the
real world, people need to deal with hundreds,
even thousands of rows of data, perhaps fifty
cities, a hundred salespeople and a whole lot
more than just five columns. They also need to
print out summary reports—something you can’t
achieve by the method above. Will they really
resort to such ridiculousness?

Of course not. They will use code to generate
their summaries—through judicious use of the
SUMIF() and COUNTIF() functions and through
macros meticulously crafted in long hours of
overtime, impressing all and sundry and gener-
ally feeling good about their expertise. And then
there are those who will use PivotTables—no
code, no million mouse-clicks, same result. 

Gearing Up
Before we get down to creating and using Pivot-
Tables, you need to know whether you’re going
to benefit from it in the first place. There are just
two basic requirements that your table needs to
meet—at least one of your columns should have
lots of repeated values (like City or Salespeople

in our sample case)
and numerical data.
The latter is the more
important of the two,
which is why PivotTa-
bles find themselves
used more for such
things as sales and
financial reports. 

Next, you need to
ensure that the table
is formatted properly:

1. Each column
should have a heading

2. There shouldn’t be
any blank rows between

the headings and the data
3. There shouldn’t be any blank rows or

columns within the data; if possible, try to avoid
blank cells as well

Once you’ve made sure of all this, your table
is now pivot-worthy, or pivot-able. 

Cut through all the madness to generate reports quick and easy with Excel’s PivotTables

To Simpler Times

Illustration Pradip Ingale

Digital Business l Smart SoHo

Your basic sales chart
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Your First PivotTable
The PivotTable button is the first under
the Insert tab; click on it and select
PivotTable (we’ll come to PivotCharts

later). Select your data table and click OK. You
can create the PivotTable in a different
worksheet to avoid clutter. You’ll notice the
option for External Data Sources—you can bring
your data from another Excel sheet, an Access
Database, or even an Oracle or MS SQL Server
Database, if you prefer.

You can drag and drop fields either within
the blue boundaries you see in the
PivotTables, or to the different areas in

the Field List. This is an example of one in each—
Salesperson under Row Label, Product under
Column, Units Sold under Values and City under
Report Filter. This gives us the number of units
sold by each salesperson broken up product-wise,
the total number of units sold for each product,
and the total sales for each salesperson in the
Grand Total row and column respectively. You can
now select a city from top row to get the same
report for each city.

Adding more fields to the Row Labels will
group data in the order that it appears—in the
above case, putting in Salesperson and City in that
order gives us a city-wise break-up of their sales
for each product. Change the order, and you have
a salesperson-wise break-up of units sold in each
city. You can even take City to Columns (this is
called pivoting, and hence the name PivotTable)
for a different view.

This is what a blank PivotTable looks like.
All your columns are now called fields and
are displayed on the right in the Field List.

Row and Column fields (Row and Column Labels in
the Field List) are the ones you’re going to
establish relationships between (Salespeople and
Products, for example) and Data fields (Values in
the Field List) are the numbers that you’re going
to compare—in this case, Units Sold. Page fields
(Report Filters in the Field List) are used to filter
reports for a particular value in that column—
City, for example.
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When you drag a numerical field to the
Values area, you’ll notice that it gives you
the sum of the values in that field by

default. Suppose you wanted to see the number of
orders for each salesperson. If you drag Order ID
to Values, you get the sum of the IDs, which you
clearly don’t want. This is where “Summarize Data
By” comes to the rescue. Right-click anywhere in
the Data area and select Summarize By > Count. 

You’ll notice that you can also summarise data
by average, maximum, minimum and so on.
Incidentally, if you’re using non-numeric data,
Excel automatically summarises it by count.

Use the Styles under the Design tab to
select a style for your PivotTable. Many
have separate shades for subtotal rows—

an added help when visualising your report. You
can also use this tab to tweak display settings like
whether or not to show subtotals and grand totals. 

The result is that no matter how much you
rearrange fields (we switched Salesperson and City
here), the conditional formatting rule still applies,
so you can go about tweaking your table without a
care in the world. 

For even more visual aid, you can use
Conditional Formatting in your table even
better in Excel 2007. For example, we

used the Data Bar formatting for one of the cells;
click on the icon that appears next to the cell, and
you can apply that formatting to all data that links
Salespeople and Products. 



120 DIGIT JANUARY 2007

Digital Business l Smart SoHo

Even More Visual
For a graphical representation of your
PivotTable, you can use PivotCharts—you can
either create both the PivotTable and Piv-
otChart from the Insert tab > PivotTable button,
or you can generate a PivotChart from an
existing PivotTable in the Options tab under
the PivotTable Tools. 

More often than not, you’ll find the 3D
charts more useful to represent data. Column
fields are now Legend fields (they’ll be repre-
sented in different colours), Row fields are now
Axis fields (they’ll be represented as the X and Y
axis), and Value fields remain the same (they’ll
be represented along the Z axis). Moving these
fields around will also cause your PivotTable to
rearrange itself. Getting PivotCharts to work
right can be tricky business, especially if you
have too many axis fields. 

Little Things
When you start dragging fields to create the Piv-
otTable, Excel updates your view in real time. If
you’re working with copious amounts of data,
this can become a real burden on your system,
especially if you’re experimenting with different
layouts. The best way to avoid this is to use the
little “Defer Layout Update” checkbox at the
bottom of the Field List, and click the Update
button only when you’re ready to see how your
new layout looks. 

When you update any data in the source
table, you need to manually refresh the Pivot-
Table for the change to get reflected, so it’s

better if you generate the PivotTable after
you’re done making changes to the source
table—forgetting to refresh the PivotTable can
lead to erroneous reports. The best way to avoid
this is to write a macro that refreshes the Piv-
otTable every time the source table is updated
. 

Endnote
The only trouble with PivotTables is that you
never really know whether it applies to your data,
which is probably why most people avoid it.

As you’ve seen, though, they’re very simple to
understand, and the best way to find out if it
applies to you is to try it—you might have your
answer in as little as half an hour! 

nimish_chandiramani@thinkdigit.com

The PivotChart is a graphical version of your PivotTable



Thin Clients For Small And Medium Businesses

Narang Medical Limited is a leading manufacturer and
exporter of medical supplies, surgical instruments, hospital
equipment, laboratory products, and diagnostics. Located in
New Delhi, the firm’s office has about 25 thin clients. 

“We have been using thin clients for the past
one year and I must say I am happy with
the way things have turned out. My

employees, too, seem quite satisfied because as far as
they are concerned, nothing has really changed except
for the better. They still use all the applications they
used to, and it’s faster, too. For the kind of applications
we use—Tally, MS Office, IE, and IIS, I think thin clients

are most appropriate. There have been no complaints of
different performance on different systems—all the
clients run at the same high speed. We have a server
with two dual-core processors, 4 GB of RAM, and RAID
0+1 protection.

“Look at what we have gained. The data is
centralised, so management has become easier.
Software updates take place only on the server. The
administrative staff no longer run about fixing a system
or an application every now and then. Virus protection
has also gotten a lot better. Moreover, we now have only
the server to back up. Due to better organisation,
maintenance costs have been brought down, and is
under better control.

“The workstations themselves are scaled down, and
so are far cheaper. No hard disk, no CD, no DVD on the
clients. Expensive peripherals like printers and scanners
have also been centralised, cutting down on costs. We
now have a UPS connected only to the server. I do not
need to buy expensive workstations for each additional
staff—I can use old, outdated systems as thin clients. The
old 10 Mbps hub is usable again. There has been a great
investment utilisation.

“Things have been pretty stable, except during the
installation and testing. It’s been smooth since. A setup
without thin clients is simply unthinkable for us. For
similar setups, I believe thin clients are the way to go.”

Hallmark Honda is a Honda dealer located in Navi Mumbai.
They have a setup of about 50 computers.

“We use Windows NT on the server and XP
Professional on the clients. We have an in-
house development team. Our primary

application is the Dealer Management System. We use
Access, VB, and SQL Server. Response time is very impor-
tant, as we are directly dealing with customers all the
time. I am not convinced that thin clients would give me
the same response time as my current setup. That’s the
whole idea of client/server technology—distribute com-
puting to enhance speed. 

“Our DMS system incorporates a lot of features like
generation of ad-hoc reports by the users themselves.
This can be practically possible only with a fat client
with enough computing power of its own, else you
would simply end up taxing the server, resulting in a
breakdown. I would like the server to remain what its
name suggests—a file server, and leave the actual com-
puting to the clients.

“A lot of our code has been specially written to work
on the client. Some of the code is even stored and can be
executed by only specific clients. Some of our worksta-
tions are dedicated to users of huge Excel sheets through-
out the day. We have quite a few users who have their
own Excel sheets at their workstations, which are updat-
ed to the server only at the end of the day. I shudder to
think of the state of the server with such user demands. I
guess we would be constantly reconfiguring and upgrad-
ing our server—probably every three months—with thin
client technology. It’s not for applications that deal with
a huge database.

“We would definitely not be using thin clients—on
the contrary, we are constantly looking to free our server
of as much work as possible.”

As told to Arvind Subramanian
(arvind_subramanian@thinkdigit.com)

A B Bhupesh 
Manager—IT
Hallmark Honda

“There has been a great
investment utilisation.
Expensive peripherals
like printers and
scanners have also been
centralised, cutting
down on costs”

“I would like the server to
remain what its name

suggests—a file server,
and leave the actual

computing to the clients”

Parveen Narang
Director
Narang Medical Ltd

Is it a feasible option—and for whom does it work best?

The data is centralised, so
management has become easier

It’s not for applications that
deal with a huge database
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Ram Mohan Rao

Seek and ye shall find… but there are fortu-
itous exceptions. Benoît Mandelbrot sought
nothing, but he found. We aren’t being

historically accurate here, but essen-
tially, Mandelbrot wrote some code
and there appeared on his screen
something very interesting. (This
was way back in 1976.) He
thought there was some-
thing wrong with the code,
so he double-checked. But
there it was, staring him in
the face—something like
the images on the next
two pages! (In black and
white, though.) He had
discovered fractals—
mathematical patterns of
unmatched beauty,

Technology Beyond Work
Leisure
Digital

complex, delirious delights to the eye, stuff that
makes you wonder what you’ve been smoking.

We hate history, so all we’ll say is that we’re
talking about structures arising from extremely
simple mathematical formulas. And what good

are they? Mostly, they’re trippy, fun, and
addictive. That’s why we’re writing

this—to encourage you to create your
own, then preferably print them

out on your T-Shirts. But in addi-
tion, they’re mathematically

significant and philosophi-
cally profound: fractals are
self-repeating. They carry
themselves within them.
Some say fractals describe
the structure of the
universe: where one thing
pervades all, where the
smallest reflects the large.
As Blake put it:

Art For The Asking
Fractals, demonstrating infinite complexity from infinite simplicity, showcase nature itself

148133 James T
Russell

Here We Go
Again…128 Epic

Adventures
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…Infinity in a grain of sand,
And eternity in a f lower.

Now you’re probably wondering what this
writer’s been smoking, so without much ado,
look on this month’s CD to find fractal
programs such as Fractal Forge (FF) and
Fractint. Neither of these require installation.
FF, as well as the DOS version of Fractint,
feature colour cycling—very, very trippy—while
the Windows version of Fractint doesn’t
support it in most cases. Fractint is the older,
most well-known fractal-generating program;
FF is newer, and the UI is more user-friendly
with more obvious options.

Creativity 101
Fractals are, generally speaking, so intricately
beautiful that it’s easy to think you’re being
creative when you generate a sufficiently
complex one!

The fact is, it’s nature doing it for you—it’s
numbers working their magic. Now what’s
hard is coming across something unique—like
a fractal island or river in uncharted territory—
which comes only with patience, hard work,
and all the other virtues.

Right. So when you fire up, say, Fractal
Forge, you get an interesting-looking structure.
This is called the Mandelbrot Set. It’s a fractal.
Zoom in, and the plot thickens. The pattern gets
increasingly complex. Zoom in even more, and
you’ll notice that “deep inside” is the same
shape you saw in the beginning—in fact, lots
and lots of them! Tiny little buggers, represen-
tative of the whole. Swirling round them are
rings, rivers, beaches, islands—all swathed in
passionate, psychedelic colour.

Taking Control
We’re not going into the mathematics here,
but there are a few things you need to know.
First read box How It Happens, then come back.
Good. Now, the basic Mandelbrot set is gener-
ated without any special functions; it’s just

squaring and adding. Twists happen when you
add functions such as the sine and the cosine
to the equation.

However, if you follow the rule of continu-
ally squaring and adding, you’re still in the
Mandelbrot “family” of fractals. There are many
more—explore the other sets in, for example,
Fractint, which are generated using different
formulas. Remember that the key attribute of a
fractal is that it is self-repeating.

Happening Places
Now that you’re hooked, you need to go out and
look for where the interesting patterns are.
Let’s use the standard Mandelbrot set.

Generally, you need to look at two kinds of
things, which are usually at the intersection of
two major dark areas:

124

Figure 1: An incredibly elaborate spiral (top left), when zoomed into (the
white circle), gives more of the same... there’s no getting to the centre!

Figure 3: The typical Mandelbrot Shooting Star (upper
left), which can be seen in many forms in the Mandelbrot
set, shoots into baby Mandelbrots like this one. Note
that this is typical of an “explosive” landscape

Figure 2: Hills, islands, rivers, and oceans—the Phoenix set
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Places where the energy seems to shoot
forth, and

At where the force field seems to dissipate.
If you’ve been observing your fractal

patterns carefully, then (and only then!) will the
above make sense!

When we talk about energy shooting forth,
it’s in areas like the top left in Figure 3, and
when we talk of the field dissipating, it’s the
circled part in Figure 4. Figure out for yourself
where more such areas lie.

The thing is infinitely zoomable, only limited
by computing horsepower! So when we say
“find out such areas,” don’t limit yourself to the
main fractal—zoom in to totally random areas,
zoom in even more, find more and more balls
and spirals and such, and try to find the
“energy” and the “dissipation”!

Note, though, that you’ll have to set high
values for the number of iterations as you zoom
in further, or you won’t get the real picture.

An aside: talking about computing horse-
power, back in 1995, on our 386 machines, the
screens that now get generated for you in a few
seconds would take hours, if not days!

Natural Fractals
We did say that fractals showcase nature. How…?
The fact is, nature abounds in fractal formations.
Take the Java applet at http://snipurl.com/fract1
(http://math.rice.edu/~lanius/frac/koch/koch.html
). There, the second iteration onwards, you’ll see
what looks like a snowflake. As you keep iterating,
you’ll find it getting more and more complex…
and it becomes self-similar. That is, everywhere
along the edges, it looks like the main shape itself.
There are only so many iterations you can do with

that particular applet, but you’ll get the idea.
Coastlines, too, are something like this. If

you were to measure a coastline with a mile-
long ruler, you’d get a certain length.

Make it a foot-long ruler, and you’ll see that
it’s longer than you thought. And so on. Ulti-
mately, you’ll find you just can’t measure a
coastline—it’s infinitely long!

That’s where the fractal part comes in—
coastlines are infinitely detailed.

Mountains, snowflakes, leaves… are all frac-
tals. Look at a leaf: it’s got a main line with
“branches.” These branches have similar
branches, and so on—and ultimately, if you
examined it under a microscope, you’d proba-
bly find the same pattern repeated infinitely.

The above is just a rough introduction, and
fractals in nature is an immensely interesting
subject.

Visit http://snipurl.com/fract2 (http://
kluge.in-chemnitz.de/documents/fractal/
node2.html), and http://snipurl.com/fract3
(www.miqel.com/fractals_math_patterns/visu
al-math-natural-fractals.html).

Getting Down To It
Now, it’s rather pointless telling you what
parameters to change and why and how. FF
features a comprehensive tutorial. We’ll tell
you this, though—that seemingly unrelated
parameters, when changed at the same time,
can lead to a drastically different picture.

Also, just try changing the real and imagi-
nary parts of the “perturbations” in FF a wee
bit and be amazed! In other words, just keep
playing around...

It’s a matter of discovery, and we can’t teach
you fractal art. Just explore as many regions of
the initial fractal as you can.

If you come across something truly
unique—such as interesting symmetries—do
remember to save them and send them in to us.

Welcome to psychedelia—the natural way! 
ram_mohan@thinkdigit.com

Figure 4: If you zoom into the areas of what looks like an unmentionable body part,
you'll find the landscape is vastly different. Softer, gentler curves. No shooting stars

Someone once said the sales of a book would drop by a factor of two for
each equation inserted. In that vein, we’ll explain how fractals work

without using a single equation! However, you’ll need to know about
imaginary numbers, otherwise you might as well skip this. OK, to ease up
a bit, think of the square root of -1. It cannot have a real square root, of
course, because no real number, when squared, will give a negative
number! The square root of -1 is therefore called “i”, standing for
“imaginary”; it’s a number that’s not on the line of real numbers.

Now, think of a number plane. “2 + 3i” represents the point which is 2
units from the origin on the X axis, and 3 units from the origin on the Y
axis. See how the concept of an imaginary number leads to a number
plane instead of just a number line?

And now, take that number and square it. You get (-5 + 12i), because i2
is -1. Square it again. You get (-119 - 120i)... and so on. If the number runs
away to infinity, it’s not “part of the fractal set,” and is painted white. If
the number does not go to infinity, and stays within limits, it’s part of the
set, and is painted black. Take (0,0): it’s obviously part of the set, because
no matter how much squaring you do, it’ll remain 0.

So how do you get colours? A point is marked with a certain colour
depending on how long it takes to move to infinity. Light colours are for
those that become huge fairly quickly; dark colours are for the ones that
take longer to become large. But how many times does one keep
squaring? Obviously, one sets a stop point: “we’ll iterate 200 times,” for
example. After the 200 iterations are done, a colour is assigned, based on
how far it has moved to infinity (or how close it has stayed to zero).

You’ll often see the word “Julia” in fractals. This is the “complement”
of the main set: there is a Julia set for each point in the plane. A point
within the main set will generate a Julia set with only one shape; one
outside the set will result in two shapes close to each other.

How It Happens
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The follow-up to NWN—the much-revered
“RPG Game of the Year 2002”—
Neverwinter Nights 2 (NWN 2) is finally

here. NWN went down in the annals of gaming
history as the first RPG ever to combine the
hardcore D&D rule set into such an involving
game. NWN 2 follows suit, with a brand-new
graphics engine, an even more epic storyline,
and subtle elements interwoven into the game-
play that add to the overall experience. 

Like the new playable classes. Besides
adding a race to the mix of elves, dwarves, and
barbarians, you now have a bunch of new pres-
tige classes, and a new base class The Warlock.
Character customisation is much more involving
than in NWN, and fans will spend a lot of time
building characters and customising them.

Without any spoilers, the story plays you as
a nondescript resident of a tiny village, West
Harbor. You’re tasked by your rather stern step-
father with retrieving a magical shard from
nearby. Upon successful return you discover the
town’s been attacked—naturally, the attackers
wanted the shard you just acquired. You are

then packed off by “dad” to the city of
Neverwinter. Needless to say, adventures
abound en route and later.

What’s really wonderful is the way the story
involves you, with storyline missions, sideline
missions, and some mini-game-like elements,
like playing Lord of your very own keep! That’s
all the tantalising storyline titbits you’ll get
from me…

NWN 2 earns a must-play tag even before
you consider its excellent visuals. Although not
the most splendid-looking RPG title, the
graphics are very much up there. Spell and
weapon effects are excellent, and so are charac-
ter model animations. The Aurora 2 engine real-
ly delivers!

NWN 2 isn’t really taxing graphically, except
at maximum detail and high resolutions, at which
even the 512 MB on my x1900xt didn’t help much.
There were just a couple of instances of framing,
though, during the countless late-night sessions
spent smiting evil and great cleaving! A must-try
for any gamer worth his sand.

michael_browne@thinkdigit.com

Epic Adventures

Rating:
9/10

Developer:
Atari

Publisher:
Obsidian

System Requirements:
Pentium IV 1.8 GHz or equivalent,

512 MB RAM, Direct X 9 compliant 128
MB graphics card,

Direct X 9 compliant sound card
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The best way to elicit tortured groans from any game
reviewer is to throw a World War II game at him. The
theme has spawned some of the most ridiculous

games we’ve played, but thankfully, IL-2 Sturmovik 1946
isn’t a product of that heartless factory.

The IL-2 flight simulator series has been around for five
years now, and this edition is effectively a round-up of the
game and its expansion packs through the years, plus three
new ones—PE-2, Sturmoviks over Manchuria and 46. The mis-
sions and campaigns give some long-overdue attention to the
Axis side of WWII as well, even letting you bomb Pearl Harbour!
All this adds up to a total of more than 300 different aircraft
(and you can fly around 200 of these), so expect to be kept busy
for a long time. 

Like all worthy flight sims, you can’t just jump into the game
without familiarising yourself with the long list of flight controls
and training missions. Gameplay is as beginner-friendly as these
games can get—you can tweak the level of realism you get, though
it’s fairly tough even at the easiest level. At its most realistic, IL-2 is
pure torture, and will only appeal to hardcore fans of the genre. One
nifty feature you’ll need when you’re starting out is the time-stretch-
ing feature, which lets you slow down the game to a quarter of its nor-
mal speed—excellent when you’re learning combat. Low-altitude dog-
fights are extremely challenging, and can be a thrill as you battle it out
while trying to keep your wings from hitting treetops. The variety of air-
craft at your disposal is mind-boggling, and each has its own perfectly-
crafted eccentricities. 

The game’s graphics look dated—they haven’t been updated much since
2001—but the developers’ attention to detail is marvellous. Textures degen-
erate according to the punishment they take (including getting blackened by
engine exhaust!), and each plane’s cockpit is a near-perfect replica of the real
thing, as explained in the 450-page aircraft guide that comes with the game.

IL-2 Sturmovik 1946 is an important milestone in the series, and because it
comes loaded with the entire set, you don’t need to buy any of the previous lot.
Invest in this game if you want something that lets you start out with flight sim-
ulators at a comparitively easy level, and adds realism to the gameplay as you get
better. If you’re a hardcore flight-sim fan, it’s a crime to miss this one. 

nimish_chandiramani@thinkdigit.com

Rating: 8/10
Developer: Maddox Games, Publisher: Ubisoft

Distributor: E-Xpress Interactive
Contact: sales@e-xpressindia.com

Price: To Be Announced
Minimum System Requirements: Pentium III 1 GHz, 512 MB RAM, 64MB Graphics Card

Digital Leisure l Game On
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Digital Leisure l Game On

S
id Meier’s Railroads! is a revival
of the old Railroad Tycoon
series that we’ve all known and
loved for so long. The objective
remains the same—build your

own railroad empire, connect a nation,
buy out your competition, and become
the king of the railways. You can make
your money by connecting cities so they
can exchange goods and passengers,
buying businesses in those cities, and
dabbling a bit in the stock market. 

We’ve reached a point where any
game with the Sid Meier name comes
with high expectations attached, and
Railroads! is no doubt one of the most
enjoyable games this reviewer has come
across in ages. Most importantly, the
game’s structure has been vastly over-
hauled. There is just enough microman-
agement—both in your finances and in

the actual building of the railroads—to
make you feel like you’re totally in con-
trol, but this never feels tedious. 

For a strategy/simulation game, I
found this surprisingly fast-paced. Your
opponents—the AI equivalents of greats
like J.P. Morgan and the Baron
Rothschild—work fast, and you’re going
to have to make some really quick deci-
sions—some of which might bite you
later—as you compete against them.  At
no point did I feel deprived of entertain-
ment through my hours of play. Online or
LAN play is even more entertaining, and
the game comes with some very interest-
ing and challenging maps to compete on.

Visually, graphics are meticulously
detailed—train models are like the real
things, stations have little people walk-
ing about, and you can even tell the dif-
ference in architecture when you’re

building your railroad in Eastern Europe
or America. All these treats come at a
price, though—it’s not as gentle on your
graphics card as you’d expect. There are
also a few aberrations here and there—
trains wantonly going through houses
and the like—but they’re all forgiven
when you look at the big picture.

That big picture is that Railroads!
has tremendous appeal for people of all
ages, shapes and sizes, and that appeal
isn’t going to go away soon. It’s one of
those few games that force you to use
your brains, so grab yourselves a copy
before your grey cells rot.

nimish_chandiramani@thinkdigit.com

Rating: 9/10
Developer: Firaxis Games

Publisher: THQ
Distributor: E-Xpress Interactive

Contact: sales@e-xpressindia.com
Price: Rs 1,299

Minimum System Requirements: Pentium 4 1.4 GHz or AMD
Athlon equivalent, 512 MB RAM, DirectX 9.0c 64 MB video card
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FirstEscape

Daniel Sadville, a CNET
reporter who is
famous for hyping

Second Life, the online virtual
world that’s the rage now,
was recently trying to
interview one of the virtual
millionaires when they were
attacked by giant flying
penises! All this happened in
the virtual world of Second
Life, of course, which
explains how it was possible
for them to be attacked by
the animated appendages.

The interview was being
conducted in CNET’s office
within the popular virtual
world, and Sadville was
trying to get virtual
millionaire Ailin Graef to
share her secrets of setting
up and successfully running
businesses in Second Life.
Then the attack happened—
animated flying penises flew
at the virtual CNET building
for about 15 minutes.
Obviously, the interview was
halted immediately, and

Graef refused to continue.
She then agreed to do so,
providing the location was
shifted to her own private
space. Didn’t help though,
because as soon as the
interview was restarted, the
obscene appendages
returned. In fact the hacker
seemed to have been
following Graef, because he
then managed to crash the
server on which Graef’s
space was hosted.

Perseverance paid off
though, and after restarting
the server, the interview
continued normally without
further incident. Looks like
it’s not just real-life anchors
and news reporters who
suffer from bloopers or
intrusions! If people
continue to take Second Life
as seriously as they are right
now, we’re going to need a
lot more security online—as
much as we have offline,
it seems.

However, what we must

wonder about is, how some
people can take a world like
Second Life more seriously
than their real lives? When
was the last time you saw
members of a terrorist
organisation attack with…
well… their… err… members?
Whatever the case, watch
this space for more
unbelievable nonsense from
the world of Second Life.
We shudder to think,
“What next?”

CHRISTMAS CHAOS

Seller
Beware?

December seemed to be
the month of e-
commerce boo-boos

for UK-based retailers. First it
was retail outlet
Woolworths’ online store
that was offering all sizes of
LCD TVs for just £150 (about

Last month’s winner is
Vaibhav Sharma, Gorakhpur (UP)
We’re invariably content with still desktops, but
Vaibhav Sharma’s Flash escapades have made us
think different. Sadly, we can’t show you how it
animates. He used:
1. Macromedia Flash 8 to design the background
and publish to HTML. There are navigation buttons
to view the next or previous wallpaper
2. ObjectDock,    3. CrystalXP
Congratulations!

They Prefer Their Apples Green...
Five months ago, Greenpeace said Apple was the least
“green” of the major tech companies, grading their use
of toxic chemicals in products. They’re now again giving
Apple the bad report card! Talk about reminders—and
about cutting some slack!

MAN-HACKS?

Virtual Newsroom Attacked By Flying Penises

My Desktop

Whatever 
Happened To…

Surely you remember the
time when the average PC

consisted of a monitor
perched atop the cabinet. The
design had been around for
ages, and nobody messed with
it—not until the coming of the
Tower, anyway. Since then, the
picture of the PC itself
changed, and the monitor-
tower-everything else setup
has become staple, but what
of our horizontal friends?

A horizontal cabinet
occupies a little more space
than your monitor, so it’s not a
space hog if you use it with
the monitor on top. Any
airflow considerations you’d
have to make would apply no
matter which way your
cabinet is oriented, so that
couldn’t have been a factor in
its fadeout. We aren’t saying
they’re totally history—you’ll
find them being peddled as
cabinets for Home Theatre
PCs, small form-factor PCs,
and other applications where
compactness and prettiness
matter more than core
functionality. But towers have
their advantages—they occupy
the same area irrespective of
height, so you can stack them
with more hardware.

The horizontal cabinet’s
fall from top spot could have
something to do with the fact
that monitors became bigger
before cabinets could get
stronger. Or that they raise
the monitor to a height that
qualifies as an ergonomic no-
no. Maybe they just weren’t
cool enough. Got any
theories? Write to us and put
in your own two cents (91
paise)!

Eternal Vacation
Someone out there recently got an automated response
after reporting a phishing attempt to HSBC. It contained
the line “I will be out of the office starting 05/10/2006
and will not return until 17/07/2050.” A 44-year
vacation? No wonder bank jobs are so much in demand!

Send in your Desktop with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy  DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest 
and win next month 

Street Smart
by Joseph L Jorden
Published by

Horizontal PC
Cabinets?
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Rs 13,250). So you could
actually go out and get
42-inch LCDs for a fraction
of their price if you were
buying it online.
Woolworths soon realized
the mistake, and the correct
prices returned all too
quickly. However, in that
time quite a few Christmas
shoppers had already placed
their orders. The retailer was
forced to issue formal
apologies to the frustrated
buyers, informing them of
the error and reversing their
payments—thereby not
honouring the sale.

In similar fashion, UK toy
retailer Hamleys sold out
almost their entire online
stock recently. The surge in
purchasing was due to a
glitch in their system.
Basically, Hamleys offer
discount vouchers, which
contain a code which you
can apply to avail of a
discount. Now some Web
programmer overlooked the
fact that buyers might

“accidentally” enter the
same discount code more
than once, thus multiplying
the discount offered. It
didn’t take long for the
glitch to be found though,
and people flocked to the
site to avail of as much as 60
per cent overall discounts.
There were stories going
around of buyers boasting of
saving thousands of pounds
while Christmas e-shopping!
Some of the online
spectators described the
events on the day as Vikings
visiting Hamleys, claiming
that the site had been
pillaged. Apparently, almost
everything popular was sold
out, or out of stock.

However, Hamleys’
troubles were just
beginning—they don’t
distinguish between online
and offline stocks, and have
one common warehouse for
both. This meant that
everything they had in stock
had been sold to online
buyers, and neither online

nor offline buyers would be
able to purchase or order
anything until they
replenished their
warehouse. Although the
site was fixed up pretty
quickly, Hamleys’ initial
knee-jerk reaction was to
state that they would
honour all sales. Saner heads
seemed to have prevailed in
the boardroom, however,
because they soon retracted
that statement, probably
after a few accountants
worked overtime to estimate
the losses!

The store later mailed
every buyer, telling them
that their money had been
returned, and offered them
a generous (yet sane)
discount of 25 per cent on
the next purchase. 

We, however, are left
wondering whether Web
programmers at the
companies are getting fired,
or whether some business
executive is being patted on
the back!

To elucidate, how can we
be sure that this was a
programming glitch, and
not a weird and aggressive
marketing tactic? It did get
them into the news, and had
thousands of buyers (read
actual people with money)
register and provide their
contact information! Does
this mean that we’re going
to see many more “glitches”
on e-commerce sites? Maybe
this will start a new trend,
where programmers who
make mistakes will be
sought after! What’s sad is
that none of the buyers
seem to have got their
“highly discounted”
products, and the retail
stores are laughing all the
way to the bank, with people
just giving in and accepting
the consolation discounts!

The CDs and DVDs we so
wantonly use and throw
today wouldn’t have even
been possible had it not

been for
the mind
of James T
Russell. He
started off
with his
inventions
at the age
of six,
when he

crafted himself a remote-
controlled battleship,
complete with a chamber
for his lunch. After his B.A.
in Physics, he worked as a
physicist with General
Electric, and was one of the
first people in the world to
use a colour TV and a
keyboard with a computer. 

Frustrated with the
way his vinyl records were
degenerating, he wanted to
work on a system where
audio could be read
without any physical
contact between the
moving parts. The best
way, he figured, would be
if he represented the
binary 0 and 1 as
intensities of light—dark
and bright respectively.
Furthermore, by squeezing
more dark and light areas
into the same space, he
saw that he could store
huge amounts of music on
a piece of film.

His work on optical
data storage began in the
Bettelle Memorial
Institute, where he worked
as a Senior Scientist, and
he constructed his first
prototype of a digital
optical recording system.
Data was recorded on a
photo-sensitive platter,
which became the first
CD-ROM. The idea evolved
through the 70s, but with
few takers at first.
Eventually, though, audio
companies realised the
obvious benefits, and the
rest is history.

People Who
Changed

Computing

James T Russell

The Discman!

“Spam Is Old
News” 

WIN!
Send in your entry and you could win an exciting gift just by sharing
an amusing picture with a tech angle to it. The picture should have
been shot by you, and should not have been published anywhere
earlier. E-mail your picture with the subject “DigiPick” and your
postal address oonn  oorr  bbeeffoorree  tthhee  2200tthh ooff  tthhiiss  mmoonntthh  to
digipick@thinkdigit.com. One prize-winning picture will be
published each month.

Participate and win next
month 
Pro C# 2005 and the .NET
2.0 Platform
by Andrew Troelsen
Distributed by
Dreamtech Press

Last month’s 
winner is
Ketan Gandhi
Alibag
Maharashtra 



Santa “Illegal
Immigrant”

Hazleton in Pennsylvania is a
town with a sense of

humour. They’ve banned Santa
from their town this Xmas
because he is an illegal immi-
grant. Naturally—has anyone
ever seen Santa presenting his
papers after his soot-ridden fall
down the chute?

As a matter of fact, he’s an
illegal immigrant everywhere,
because he is from The North
Pole—not a country, last we
checked.

Now, there’s a site called
www.nosantaforhazleton.com.
Here, the good denizens of
Hazleton have penned their
reasons for not allowing Santa
in: illegal immigration
increases crime and burdens
local service setups.

A joke? Naturally, and
you’re pretty daft if you haven’t
gathered. The Web is Wild, but
people aren’t stupid. The site is
up because the city council
made a move to prevent land-
lords from renting rooms to
illegal immigrants.

Cuff-Links

The Web is Wild, hence this
space. An Australian judge

has now ruled that just linking
to copyrighted material is ille-
gal. But that’s what Google
does all the time, every
picosecond of every day, right?
But someone saw something
wrong with Stephen Cooper’s
running a site called
pp3s4free.net: he provided a
search engine for MP3s. He’d
made a catalogue of the mate-
rial. Ah, now we get it! Google…
no Google Catalogue, at least
not in Oz!

Women Hackers Exist

Awoman recently sought
revenge on her cheating

boyfriend by hacking his
MySpace page. She changed
the welcome note on his page
to: “I’m a pathological liar. I
cheat regularly.” Then a
MasterCard-ad-style ending:
“Finding out your boyfriend is a
lying scumbag and changing
his MySpace page so everyone
can see… PRICELESS.” See?
Women can do such things!

Missing Mama?

AWeb site called “ask
mummy” in German is tai-

lor-made for men who cannot
look after themselves once
they leave home. Like here,
many German men live with
their parents until their late
twenties. If only you knew

German, you’d be able to get,
at www.frag-mutti.de, direc-
tions on how to use a washing
machine, fry an egg, etc. By the
way, this isn’t about fragging
your mom! (“Frag” means
“ask” in German.) Now trans-
late the site using Google’s
translator and get some really
cool tips on what to do with
your microwave…

QUAD CORES TO FLOP?

Intel Thinks
Quad-Core
Not For 2007

I
n December, a Chinese
site reportedly got hold of
some slides of a

confidential Intel
presentation, which was
supposedly meant for intra-
company circulation only.
The presentation is

reportedly about Intel’s
predictions about processor
sales for 2007. According to
the slide, displayed below,
Intel doesn’t expect their
quad-core processors to sell
much at all. 

As the slide represents,
Core 2 Duos will rule the
roost for Intel in 2007—like
we didn’t expect that!
What’s surprising is that
despite the newer quads
shifting to the 45-nanometer
fabrication process, which
we hope will make them a
little more affordable, their

projected sales are still
pitifully low, right up to end
of 2007.

We’ve heard of
conservative estimates, but
really, now! With both Intel
and AMD planning on
taking the multi-core
architecture beyond four
cores, it’s a little hard to
imagine they will not be
aggressively pushing their
own quads a lot more. 

KILLER SPEEDS INDEED

Lack Of
Broadband
In India
Killing
People?

Yes, you read that
correct. It’s an outside
possibility, if a study by

the UK-based Social Issues
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Gaming
More and more computer
users have started gaming.
However, for those of you left
behind, especially in terms of
all this first person shooter
(FPS) business, where you
need hardware that costs as
much as some cars, here are
some terms to help you make
people believe that you’ve
got game!

BFG: The full form is Big
F***ing Gun, and was made
popular by the game Quake
III Arena. This is the gun that
can help even a gaming
newbie frag an expert! 

Frag: In FPS-land, the term
“frag” is used to describe
the killing of an opponent.
Usually best used in multi-
player games with lots of
blood and gore.

Camping: Usually a gaming
technique used in multi-
player shooters, where you
hide (camp) in a place where
you think no one can find
you, and snipe at opponents.
Good gamers will generally
hate it when they find a
“camper,” and the offender is
usually fragged a lot.

[Weapon]-whore:  Such as
Rocket-whore, Rail-whore,
etc. This is a derogatory term
used to describe a person
who always tries to get and
use just one type of weapon.
Usually a weapon that the
“whore” has practised and is
good with.

Spawn:  The act of entering a
multi-player game where you
appear out of nowhere. Also
used as spawn-point, the
place you spawn; spawn-kill—
fragging a player as soon as
he spawns (usually considered
a mean thing to do), etc.

Usage:  The other day I was
Quake-ing on a local server
and this rail-whore just kept
looking for places to camp
and snipe. All I did was find
the BFG and then frag his
@$$. Got a couple of spawn-
kills in too! He quit soon after!

Wild Wild Web

Can’t figure out what’s on the
page? We couldn’t either—it’s all in
German!

The alleged Intel slide that was leaked on to the Net, and first reported
by Chinese site www.hkepc.com
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Research Centre (www.
sirc.org) is anything to go by.

Apparently, in a study of
2,500 Web surfers, a new
type of disease—now
dubbed Mouse Rage
Syndrome—was discovered.
The researchers tested to
see what type of online
experience could result in
heightened stress levels,
indicated by a faster heart-
beat, increased
perspiration, furious mouse
clicking, and in some cases,
the losing of control and
the screaming at monitors.

For Western users, such
experiences can be blamed
on badly-designed sites, or
those hosted on really slow
servers. The test started
with making users
experience what the
researchers thought was
“the perfect Web site”—
good layout, fast loading,
easy navigation, etc. Next,
they moved the users on to
slow loading sites with ugly
graphics and basically badly
designed sites. This was
when they noted changes
in body language, heart
rates and overall gauged
the users stress levels.
While some stayed calm,
most showed negative

effects to the heart as
well as the nervous and
immune systems.

Now, while we’re
waiting for the first “you
killed me / my relative / my
friend with bad site design”
lawsuit to be reported from
the West, we can all sit
back and curse our luck.

Most of us probably

have been suffering from
Mouse Rage Syndrome for
some time now, but it has
nothing to do with the sites
themselves—but rather the
pathetically slow speeds
that we have to make do
with here in India. We
know for a fact that
normally, lightning-fast
sites can take ages to open

on even our 128 / 256 Kbps
connections here in India,
but perhaps the saddest
part is that we can’t sue
just anyone, like Westerners
can! All we can do is tell
you about this latest
disease, ask you to calm
down and take a breath or
two. Don’t let your ISP kill
you… literally! 

Mark Cuban
http://snipurl.com/jan001
(http://www.blogmaverick.com/2006/12/12/googleno
mics-itunes-and-zune/)

Googlenomics , iTunes and Zune
… Would it be worth it to Google to pay $575 m and
up per year to completely turn Apple upside down ?
To completely pre-empt their ability to sell iPods ? To
potentially introduce a new hardware device, or
partner with someone who has one ? To sell
advertising around the music rather than the music
itself ? Is their a traditional Google arb here of 70c
per song vs 70c of advertising around the song ?
Could it sell that much advertising online to justify
giving the music away ?...

Alex Iskold
http://snipurl.com/jan002
(http://www.readwriteweb.com/archives/2006_web_te
chnology_trends.php)

2006 Web Technology Trends
…Undoubtedly 2006 has been the year of the social
network. MySpace, YouTube, Facebook have been the
three outstanding success stories—but also
impressive was Bebo (in the UK particularly) and
there was strong growth in existing web 2.0 networks

like Flickr and del.icio.us. The zenith of this social
networking craze was probably Google buying
YouTube for $1.65 B.

… RSS continues to inch towards the
mainstream—Yahoo integrated it into Y! Mail Beta,
Microsoft is utilizing it more (e.g. integrated into IE7),
Google came out with Google Base and the GData
format (which is based on the RSS variant, ATOM).
While 2006 can’t be seen as the breakthrough year
for RSS in the mainstream, we will probably see RSS
bloom in 2007 as a result of the groundwork done in
‘06 by the big Internet companies. Note that there
have been recent murmurs that Yahoo is scaling back
RSS, but I think this is a short-term trend only…

Dan Frakes
http://snipurl.com/jan005
(http://www.macworld.com/weblogs/editors/2006/12
/flop/index.php?lsrc=editorsblog)

The iPhone a flop? Let’s wait and see
Let’s assume, just for a moment, that Apple really is
planning on releasing an “iPhone,” a combination of a
mobile phone, portable media player, and, possibly, a
PDA. Will it be a big hit? Hugely successful? Who
knows. I personally think it’s unlikely such a product
would approach the popularity of the iPod. But I don’t
think it would do nearly as poorly as Kanellos predicts.

Google, Web 2.0, and
iPhone. Boring
because the same
topics keep popping
up again and again—
but some people’s
takes can be
interesting

No Smoking Please!

135

This month, we all decided to take up
smoking! Now now, before you chide

us for making tobacco companies richer,
take a look at the Digital Passion > Lead
Feature story... Yes, we were all inhaling
lots of sweet smelling incense smoke,
courtesy Fatbeing (Nimish), Raaabo, The
Browne and Vijay “PJ” Padaya.

At least the smokers in the team can
now stop cribbing about not being
allowed to smoke inside the office!

As of writing this, which is a week
after the “smoking,” most of us still get
the taste of incense in everything we
drink or eat.

Apart from that, we had a lot of
feigned-sicknesses—no doubt the
aftermath of a rather hectic
December issue. Deepak
was convinced that
most of us had
taken some part-

time acting classes.
There was more multi-player Quake III

Arena, much to Deepak’s dismay, with
Sanket and Agent001 joining in to put
Raaabo back in his place. The rest of us
still got fragged like hell, but it was so
worth it to see Raaabo lose miserably as
the two best Quakers in the office taught
him some humility.

Deepak had to take a trip into town
during rush hour—he had applied for a US
visa for business—and swallowed more
smoke in the traffic jams than we did
during our smoking experiment. He
claims it was worth it, though, because he
got a 10-year visa!

Rumour now has it that we will soon
be looking for a replacement

editor, unless he actually
comes back in January
after his business trip!
We’ll wait and see...



It’s All Good
Yesterday, I got my gift that was
due for over two months; I also
got the December issue of Digit.
Wow! It’s simply superb! You guys rock.
What an amazing mag! I could never
expect more!

How can you guys manage to give
away so many goodies at such a
nominal price? I have heard people
writing about the cost being too much,
but just calculate—and you can’t
imagine! How can you all put up such a
mind-blowing issue in just one month??
A 210-page magazine—I think it’s worth
500 bucks, if not more!

I liked Agent001 this time the best.
But one thing—I have my pre-board
exams going on. And your magazine
has kept me so busy these days—I think
I may just keep myself from giving the
exam or fail miserably! I just can’t take
my eyes off the magazine for a
moment—and the only remedy that I
see is to burn it (you know I can’t)!
Thanks for such a wonderful issue, and
last but not least—the new interface is
too cool! Fantastic visual appeal and
user-friendliness. 

Keep up the good work, guys.
Arkadyuti Mukherjee

Dear Arkadyuti,
We worked hard on the December issue, and
we’re glad to see—from letters like yours—
that our efforts have paid off. We also worked
very hard on the disc interface—thanks for
the compliments! Passionate appreciation is
most welcome!

— Executive Editor

Mr Disgruntled
Although I am not a subscriber of Digit,
I have gone through almost all your
issues, and for the last four months, I’ve
been a regular reader. I would like to
remind you that your magazine is very
high-priced. Rs 125 or 200 for a

common man like me is not a joke.
However, that wouldn’t have been a
problem if your magazine were
informative enough. But looking into it,
it’s obvious that you are not keen on
educating your readers through the
newer trends; you are only eager to
earn more revenue through advertising. 

Look into the December issue. Out
of 210 pages, well above 40 per cent—
exactly 84 pages—are full of
advertisements. I think your readers
are fools (including me, I accept) to pay
that much for only advertisements.
And what about the other pages?
Except three to four articles, like Agent
001, Q & A, Tips & Tricks, etc., the
others are about gadgets... through
which you earn heavily. 

Again, regarding your CDs… where’s
the useful stuff? What will we do with
shareware? I find nothing of value. If
I’m paying you, I should only get
freeware…

I thought I’d write an essay, but I’m
fed up. I know you will never publish
this letter.

Saji Paul
Dear Saji,
We appreciate constructive criticism, but we
cannot agree with all your points. For one
thing, ads are the lifeline of many a magazine.
You’ve mentioned that 84 out of 210 pages
are ads; and if you don’t look at the ads at all,
why not just think of it as a 126-page issue?
What about everything we’ve packed into
those 126 pages? As for many articles being
about gadgets, we write about stuff that
interests our readers—you obviously aren’t a
typical reader! And how do we “earn heavily”
by featuring gadgets?

Regarding the disc contents, first off, we
do provide lots of freeware. Secondly, you are
not paying for software when you buy an
issue—the shareware is there for you to try
out. We’re saving you download time and
possibly money (if you pay by the hour for
your connection). If you like the shareware,
buy it—what we’re doing is, we’re making it
available for your perusal. In any case, we’re
sorry to have disappointed you.

— Executive Editor

At Your Service—Always
I am a student of class VIII, and though I
do not have a Digit subscription, I
haven’t missed a single issue since last
year. You people are sure a doing an
awesome job. The December issue was
fantastic, and so was the Fast Track. The
Tips & Tricks, Beat That, Gender

Benders, and Digipick make the
magazine even better. I really wish you
could turn Digit into a weekly magazine.

Software like Corel Office, Google
Desktop, Autopatcher, and the Digit
Archive CD was reeaally great. One more
thing: I was really eager to try out Need
for Speed: Carbon. I found it in your
December issue, but the DVD was
corrupted. Could you help me?

Shameek Sarkar
Kolkata

Dear Shameek,
Our customer service helpdesk is always at
your service. Unless you’ve already done so,
just call or write in, and you’ll get a
replacement immediately!

— Executive Editor

The Many Faces Of Tech
Your lead article You’re Being Watched is
timely. The article throws light on the
psyche of voyeuristic minds, and the
interview aptly sums up the working of
voyeurs at large. The advent of round-the-
clock news channels added a whole new
ugly dimension to this episode. Not only
individuals but also the media has a share
in spreading this perverted attitude.

Going by the recent trends on
news channels—sting operations,
MMS scandals—it seems they have
buried the ethos. The private life of
citizens is being snuffed out by this
obtrusive attitude of the media. Private
life is publicised and sensationalised.
“Bug and make bucks,” that’s the
current mantra.

Hi-tech gadgets, faster processors,
larger bandwidths, gigabytes of
memory to digitize every bit of our
lives, uploading, downloading and
sharing content is now possible with a
single touch of a button.

Proud, yes, but I am worried at the
same time. Who knows—one day you
may end up on a big show (read reality
show at its worst) à la Jim Carrey in The
Truman Show.

My intention is not to paint a
grim picture—all I want to say is we
need technology to make this world a
better place to live in, but on the
other hand, it’s the collective
responsibility of individuals to see to it
that this happens. It’s not the
technology that is bad—it’s the mind
that perverts it.

A Happy New Year to Team Digit!
Dr I Sai Krishna

Hyderabad

144 DIGIT JANUARY 2007

December 2006



145DIGIT JANUARY 2007

There Is A Way!
In the December issue, Biswadeep Misra
had asked you about the code for
checking the total time on a Nokia
phone. There is indeed a code to check
the total talk-time. Type in
*#92702689# and scroll down, and in
the life timer selection, you will get the
total talk-time.

Sivi Nair

Yes, We’re Human!
First of all let me tell you—not that you
don’t know—Digit Rocks! I have been
reading it for quite some time now.

The reason I had to write this mail is, I
would like to draw your attention to the
question in Check Your TQ,  page 208,
December 2006, which asked what
company had come up with its own
version of Firefox. The correct answer was
given up as Microsoft.

It was a prank… I can’t believe even
you guys fell for that! Check out
www.msfirefox.com and
www.msfirefox.net!

Anyway, keep up the good work…
Prashant

Dear Prashant,
Thanks for writing in. We realised our error a
while ago—unfortunately, we created the TQ
page when we first spotted the “news.” We
soon came to know it was a joke, but we
couldn’t do anything about it. Of course, we’re
going to offer the standard excuse—we’re all
human! Hope you can pardon this boo-boo on
our part!

— Executive Editor

Digit Under The Scanner
I absolutely must thank you for your
marvellous gift in the form of the
December issue. The softcopy of 23
issues of Digit and the Fast Track
editions—it’s great. In fact, I had
started scanning all the Tips & Tricks
pages and other useful, informative
pages and keep it as a softcopy on my
hard disk! I went ahead, and thank
God… now everything is on disk!

Vinod Kumar V K

Coasters Galore
I have been a subscriber to Digit for the
last three years. I have the following
question to ask: What is the life of a
rewritable CD in terms of rewriting? I use
Moser Baer Protection+ rewritable 10x CDs
for writing data CDs. After rewriting for
about 15 times (at 10 x speed), these CDs

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building,
MIDC, TTC Industrial Estate, Nerul
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee  iinncclluuddee  yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the help desk at 
022-27629191/9200, fax 022-27629224, or 
send an e-mail to help@jasubhai.com

stop working! I use Nero Burning ROM.
What can be done to increase CD life?

P B Kakathkar
Dear Mr Kakathkar,
The life of rewriteable CDs is usually stated
as 1,000 cycles, though in reality, it usually
works out to about a hundred. We haven’t
tested the media you’ve mentioned, so we
can’t speak about it with authority. Still, 15
really is too low. Perhaps you’re getting
counterfeited media. Another thing is,
remember to keep rewriteable CDs as
scratch-free as possible—use a soft cloth to
clean them, cleaning in a straight line away
from the centre. Store them safely too!

—Executive Editor

Export Quality!
I live in Sri Lanka, and to my best
belief Digit is not available here right
now. Whenever one of our family
members goes to India, my first
request would be to purchase a copy of
your magazine.

I found your tips section especially
interesting in solving several problems.
The hardware comparisons are a
blazing hit! I’ve got a question. As a 17-
year-old, advanced-level college student
use my desktop PC for animation,
audio, and graphic design. A friend
recently advised me to upgrade my PC,
and I decided on a 3.0 GHz Pentium D
processor—and was advised an Intel
mainboard. Are Intel 945 boards a
good buy? I need support for 1 GB of
DDR2 + DDR dual-channel, onboard
VGA, and FireWire. How about
Gigabyte or MSI? I can spare 4 to 5K.

Why not include a collection of e-
books on topics like literature,
technology, fiction, and other
educational guides? Thanks in
advance… the magazine rocks! Keep
the good work!

Varanga de Silva
Colombo, Sri Lanka

Dear Varanga,
Thanks very much for your kind remarks.
Regarding e-books, well, you never know how
the magazine will evolve—keep looking!

As for the motherboard, our resident
expert Agent 001 is the right person to ask,
but while we’re at it, I might as well go
ahead! Looking at your requirements, Intel
G965 boards will fit the bill, but they’ll be a
bit expensive. Opt for any 945G chipset-
based board, in particular the GA-945GM-S2:
it was the Silver winner in the motherboard
shootout we carried in November ‘06 issue.

—Executive Editor

Ecstatic!
I am writing this letter
with overwhelming
ecstasy. I am a poor tea
estate worker, working in
one of the tea estates in
Munnar under the
management of Tata Tea
Limited.

My meagre wage scale has not
permitted me to purchase a computer
during the past 26 years of tenure of
employment, and I haven’t even
viewed any of the CDs obtained along
with Digit! I just merrily read the
magazine, and dreaming of the
contents of the CD since July 1998
was my passion!  

By God’s grace, I am the owner of
a junkyard machine, and have
experienced the treasure trove in
every CD/DVD. It is amazing, and I
take this opportunity to garland the
team behind every issue of Digit with
my tears of ecstasy! You all are really
deserving, dear boys!

Jagdish K

Girlfriend Material?
Digit… you are my best friend!

I am a regular reader and
subscriber to your magazine. Firstly,
congratulations to all of you for
completing five years successfully as
the best tech magazine.

If someone were to ask me to
choose between a beautiful girlfriend
or Digit, I’d reply—Digit! I just can’t
live without it. I am doing Computer
Science and Engineering, and you
people gives me lots of useful articles,
software, and tech information
through your magazine.

I would like to pray to God for you
people who make us successful. Wish
you all the best, and keep going the
same way!

Durgesh Kshirsagar

Dear Jagdish and Durgesh,
I’m touched. Touched to see that our
magazine reaches out not only to the minds
of our readers, but in some cases, their
hearts as well.

Jagdish, we’re all happy for you for
having finally procured a computer—and
we’re so glad we have been part of your
happy experience. But Durgesh, we must
advise you never to dump a girl in our favour!

Jokes apart, my thanks to both of you
for the heartfelt compliments—they keep
us going.

—Executive Editor

Letters 
of the
Month
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The Wii has been in the news
since its launch. Which of the

following is false?
a) Nintendo will offer sturdy straps

in replacement of broken ones
b) The console is also available

with an inbuilt hard drive
c) The Wii got a “sledgehammer”

treatment like the PS3 did
d) GameCube discs can be used on

the console

Time Magazine’s Person of
the Year for 2006 is…

a) Chad Hurley, co-creator of YouTube
b) “The iPod”
c) Tom Anderson, co-founder of

MySpace
d) “You”

What does MIME of e-mail
fame stand for?

a) Multiple Intranet Mail Exchange 
b) Multi Internal Mail Extensions
c) Multipurpose Internet Mail

Extensions
d) Multimedia Interactive Mail

Exchange

Alan Shugart, a pioneer of
the hard disk industry, died

recently. He founded:
a) Seagate
b) Western Digital 
c) Samsung
d) Hitachi GST

According to e-mail security
firm Postini, what percentage

of all e-mail was spam, in 
October 2006?
a) 15 per cent c) 55 per cent
b) 35 per cent d) 90 per cent

Which of the three below is
not involved in the

development of the Cell
processor? 
a) Sony
b) Toshiba
c) IBM
d) Intel

Recall from college… which
of the following is not a

physical network topology?
a) Tree c) Mesh
b) Bus d) Matrix

One Apple product was
named after Steve Jobs’

child. It was named…
a) Mac
b) Lisa
c) Pippin
d) Newton

Which of the following is not a
lossless graphic compression

format?
a) GIF c) JBIG2
b) PNG d) DjVU

“BOFH” stands for B***ard
Operator From Hell. Whom

does it refer to?
a) The CEO (of an IT company)
b) The incompetent phone operator

downstairs
c) The contemptuous system

administrator
d) A clueless user
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ACROSS
7. Small Java programme that runs on a web browser(6)
8. Collection of data items arranged for processing by a
programme (6)
9. Advanced Mobile Phone Service(abbr) (4)
10. ‘Myst’ sequel’—best selling puzzle and exploration
computer game from Broderbund (5)
11. A two-player black and white game with perfect
information (5)
13. Language ‘in dots’ for the blind (7)
16. Software package for mechanical engineering(7)
17. ‘Spider and worm’ type of programme roaming on
the net (5)
20. Indian global IT service provider ‘-------Computer
Systems’ in Mumbai SEEPZ (5)
21. Robert ------—invented the TCP/IP protocol (4)
22. A cellular operator named after a fruit (6)
23. To load a computer’s operating system (4,2)

DOWN
1. Trojan horse that can be used to send unsolicited e-mail
through the compromised computer (4,4)
2. Common Lisp Object System(abbr) (4)
3. To copy data from a CPU to memory (5)
4. A  computer programme that interacts with a particular
device or software (6)
5. ‘S’ in STM- a device that obtains images of atoms on the
surface of materials (8)
6. ----Site-not paid for (4)
12. Online------ selecting and buying merchandise via the
Internet (8)

14. ---- ---- optics- transmission of visible light signals over
optical fiber cable for great distances (4,4)
15. Codename for version 10.3 of the Apple Macintosh
OS X (7)
18. Block structured, procedual language intended for
application and embedded system development (5)
19. Serial-----—where a modem or printer is connected
on a PC (4)
21. Thousands of Lines Of Code(abbr) (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

Wii And You
Intel recently announced its

45-nanometer chips,
referred to as…

a) Penryn
b) Barcelona
c) Woodcrest
d) Jim

1

Nero Burning ROM
was named after

Roman Emperor Nero,
who is supposed to have been
playing his lyre while Rome
burned—though that’s
apocryphal. And the process is
called “burning”—so you get
the idea. Sheer genius or cheesy
copywriting?

Did You
Know?

Answers
5. a)Seagate
6. d)90 per cent
7. d)Intel
8. d)Matrix
9. b)Lisa
10.d)DjVU
11.c)The contemp-
tuous system
administrator

1. a)Penryn
2. b)The console is

also available
with an inbuilt
hard drive

3. d) “You”
4. c)Multipurpose

Internet Mail
Extensions

Crossword by Nitta Jaggi

Last Month’s Solution

December’s Winner:
Kumar Vijay
Ernakulam, Kerala.
Send in your entries to
TQ@thinkdigit.com on 
or before January 20. 
One lucky participant 
will win Mastering 
By Mark Minasi, Rhonda Layfield 
and Lisa Justice

Published by

Win!



People And Events That Grabbed The Headlines—For Better Or For Worse

Every time Yahoo! releases
its list of year’s most-
searched-for items, we talk

about it here. What’s worse,
every time the list is released,
it’s the same person on top. Even
the headline is the same: “Oops
she did it again.” So there you
go—you know who we’re
referring to without our having
to spell it out.

Here are the eight celebs
who made it to the top-ten list,
with the millions of pages that
mention them (in brackets).

#10: Lindsay Lohan (2.9):
The most influential person of
2006 based on US newspaper
column inches! Debate raged
over her substance abuse, and
her being a role model for
young women.

#9: Pamela Anderson (7.1):
We’ll bet it’s something to do
with the science of pneumatics.

#8: Chris Brown (1.3): For his
music. We haven’t listened to

any of it—and we’re hoping it’s
not horrible.

#7: Beyonce Knowles (1.2):
We aren’t too much into the
R&B scene, so we’re not sure
why she figures here.

#5: Paris Hilton (11.6): For
her on-camera antics, we
presume. Once a star...

#4: Jessica Simpson (6.5):
Seems to have released a few
interesting videos. Some people
call her ugly.

#3: Shakira (2.2): You know a
civilisation is on the decline
when the butt-shaking abilities
of a woman drive the world to
seek her out.

#1: You-know-who (9): You
know a civilisation is on the
decline when it’s nothing that
drives the world to seek
information about someone.

Footnote: type in “britney
google” into Google and go to the
first non-sponsored result. The
horror of it all will come forth.

Here We Go
Again…

Reporters from British
online tech tabloid The
Register caught Intel

executives in an unusual,
perhaps inebriated, mood
where they, in a manner not
befitting them, verbally
pooh-poohed the
competition. Intel “vowed to
overwhelm AMD” with a
regular “cadence” of product
releases that run on a “tick-
tock” fashion: Intel will slap
a new architecture upon the
market (the tock), then
follow up with a less
dramatic manufacturing
process, core, voltage, and
cache shifts
(the tick).

“From our perspective,
65nm is kind of old news,”

said Intel manufacturing
chief Tom Franz. Lofty
perspective, we’d say. But
you’ll have to hand it to Intel:
AMD happens to be truly
behind, looking to move to
45nm in 18 months. But the
Intel execs talked about the
18-month plan “as a figment
of AMD’s imagination.”

“They are so dreadfully
behind,” said Intel senior vice
president Pat Gelsinger. (Pure,
unadulterated scorn. Not
good.) And here’s where it
hotted up: Gelsinger went on,
“You’d have to be nuts” (to
think AMD will come close to
beating Intel to any
manufacturing milestones).

Salvo #3: “I was very
pleased to read that a number

of analysts have
downgraded AMD.”

To our surprise,
there hasn’t been a
peep from the other
side yet. Perhaps
AMD execs are more
graceful. (Or maybe
they just don’t want
to highlight the
beating.)

Speaking to an invited
party of bloggers and
Web developers at

Seattle headquarters, Mr
Gates of Bill fame happily
said, “DRM is not where it
should be,” as blogger Steve
Rubel reported it. “In (sic) the
end of the day incentive
systems (for artists) make a
difference.” And then came
the pronouncement: “But we
don’t have the right thing
here in terms of simplicity or
interoperability.”

Blogger Michael
Arrington said Gates’ short-

term advice for people
wanting to transfer songs
from one system to another
was to “buy a CD and rip it.”

Now Suw Charman, of the
Open Rights Group, said it was
a “bit rich of Bill Gates to make
his comments, given how
much DRM is stuffed into
Vista.” And we know how much
MS swears by DRM anyway...

But we told you so. We told
you last month Mr Gates had
become more amiable, more
matter-of-fact, and, in general,
more prone to telling things
the way they are. See?

We Told You So!

“You’d Have To Be Nuts”
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